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IBM MQ Scenarios

Each scenario walks you through a significant set of tasks, and helps you to configure a major product
feature. The scenarios include useful links to other content to help you to gain a better understanding of
the area in which you are interested.

The available IBM® MQ scenarios are described in the following subtopics. The IBM Product Connectivity
Scenarios and Patterns product documentation provides worked examples of using several IBM products
(for example, IBM MQ and WebSphere® Application Server ) connected together.
Related information:

IBM Product Connectivity Scenarios and Patterns information

Getting started with IBM MQ
This scenario explains how to get started with IBM MQ on a Windows platform. Use this scenario if you
have never used IBM MQ and want to get started quickly.

This scenario describes the basic steps for installing, configuring and verifying IBM MQ on Windows if
you do not already have it installed on your system. You can complete the steps of the scenario by using
either the graphical user interface or command-line interface.

This scenario was tested using IBM MQ Version 8.0.0, Fix Pack 2 on a Windows 7 Professional 64-bit (SP
1) operating system.

Planning the solution
Choose a method for installing IBM MQ on Windows. Use the graphical user interface and wizards that
take you through the installation and configuring process or use the command line to conduct a silent
installation.

Overview: The delivered logical topology
The delivered logical topology after completing the scenario.

The installed IBM MQ server instance allows for creation of IBM MQ objects: queues and queue
managers. You can use the IBM MQ Explorer to put and get messages from the local queue through the
queue manager. After this scenario is complete, the delivered topology will look like Figure 1.
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Basic concepts and key terms
Description of the basic concepts and key terms you must know about before using the Getting started
with IBM MQ scenario.

Basic concepts

IBM MQ enables applications to read and write messages to a queue. The application that reads the
message is independent of the application that writes the message. It is not a requirement to have the
two applications running at the same time. If no application is available to read the message it is queued
on the IBM MQ queue until an application reads it.

In this scenario you can choose to install and configure IBM MQ in one of the following ways:

“Installing and configuring using the graphical user interface” on page 3

During installation using the graphical user interface, you are guided through several screens and
wizards to help you apply the relevant options and settings:

Launchpad
Check software requirements, specify network information and start the IBM MQ
installation wizard.

IBM MQ installation wizard
Install the software and start the Prepare IBM MQ wizard.

Prepare IBM MQ wizard
Start the IBM MQ service and IBM MQ Explorer.

IBM MQ Explorer
Manage queues and queue managers, access Default Configuration wizard and the
Postcard application.

Default configuration wizard
Create IBM MQ objects and put and get messages to and from the queue, to test the
installation was successful.

Postcard application
Exchange messages between two users to verify the installation.

QM1

LQ1

Message Message

Figure 1. Put message on LQ1, get message from LQ1.
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“Installing and configuring using the command line interface” on page 9
The command line interface installation can be silent or interactive. The silent installation is fully
accessible and is the one covered in this scenario. During installation using the command line,
you are guided through several steps to help you apply relevant options and settings:
v Install IBM MQ
v Create and configure IBM MQ objects; queue managers and queues.
v Verify the installation by using amqsput to put and amqsget to get a message from the queue.

As well as using IBM MQ Explorer and command line to create IBM MQ objects, it is possible to do so
by using the programmable interface. This is not included in the current scenario.

Key terms

Here is a list of key terms about message queuing.

Term Description

Queue managers The queue manager is responsible for maintaining the
queues it owns, and for storing all the messages it
receives onto the appropriate queues.

Messages A message is a string of bytes that is meaningful to the
applications that use it. Messages are used to transfer
information from one application program to another.
The applications can be running on the same or on
different computers.

Local queues A local queue is a data structure used to store messages.
The queue can be a normal queue or a transmission
queue. A normal queue holds messages that are to be
read by an application that is reading the message
directly from the queue manager. A transmission queue
holds messages that are in transit to another queue
manager.

Implementing the solution
Implement the solution to the scenario. Install IBM MQ on Windows and create IBM MQ objects: queue
managers and queues. Use sample applications to verify your installation by putting and getting
messages to and from a queue.

Installing and configuring using the graphical user interface
Install IBM MQ on Windows by using the installation launchpad, and then use the Postcard application
to verify the installation. After verifying your installation, create a queue manager and a queue and then
try putting a message to the queue and getting a message from the queue.

This scenario was tested with IBM MQ Version 8.0.0.0 on a Windows 7 Professional 64-bit (SP 1)
operating system.
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Installing using the launchpad:

Install IBM MQ on Windows using the installation launchpad, and verify your installation by using the
Postcard application.

Before you begin

Before completing this task, complete the following checks:
v You must have local administrator authority when you are installing. Define this authority through the

Windows facilities.
v Ensure that the machine name does not contain any spaces.
v Ensure that you have sufficient disk space, up to 1005 MB, to fully install IBM MQ for Windows.
v Determine whether you need to define Windows domain user ID's for any IBM MQ users.

Before you install IBM MQ, check that your system meets the hardware and software requirements. For
the latest details of hardware and software requirements on all supported platforms, see System
Requirements for IBM MQ.

About this task

The launchpad and subsequent wizards take you through the installation process and help you review
the software requirements and IBM MQ settings. You are also taken through initial tasks for creating a
default queue manager, a local queue and can verify the installation by using the Postcard application.

This task assumes that you are installing IBM MQ for the first time on your machine, and that you will
be using the default locations. By default the location of the IBM MQ program files are C:\Program
Files\IBM\MQ, and the data and log file location is C:\ProgramData\IBM\MQ.

Note: If you are installing IBM MQ Version 9.0, and you have any previous installations of IBM MQ on
your machine, the location of the program and data files will be different from the default. For further
information, see Program and data directory locations. If you have already previously completed this
scenario, and want to repeat it with a single, fresh installation using the default locations, remove your
previous installation before starting the scenario again. To uninstall an existing instance of IBM MQ from
your machine, see “Uninstalling IBM MQ” on page 15.

The installation programs contain links to further information if you require it during the installation
process.

Procedure

1. Start the Launchpad, review, and if necessary, modify the software requirements and network
configuration.
a. Navigate to the IBM MQ software directory, and double-click the file Setup.exe to start the

Launchpad.
b. Select the Software Requirements tab to display the Software Requirements settings.
c. Check that the software requirements have been met and that the entry for the requirement

displays a green tick with the words OK. Make any indicated corrections.

Note:

For details of any requirement, click the check box to expand an information tab.
d. Select the Network Configuration tab to display the Network Configuration settings.
e. Select No.
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Note: This scenario assumes that you do not need to configure a domain user ID for IBM MQ. For
more information regarding configuring IBM MQ for Windows domain users, click More
information.

f. On the IBM MQ Installation tab of the Launchpad, select the installation language, and then click
Launch IBM MQ Installer to start the IBM MQ installation wizard.

You have completed setting up IBM MQ by meeting or specifying your installation requirements, and
have started the IBM MQ installation wizard.

2. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
a. In the Prepare IBM MQ wizard, read the License Agreement and click the I accept the terms in

the license agreement check box, and then click the next button.
b. Click Typical, and then click Next.
c. In the Ready to Install IBM MQ page, review the installation information and click the Install

button.

Note: Note the following details:
v Installation Name
v Top-level folder for Program Files
v Top level folder for Data Files

The following features are installed:
v IBM MQ Server
v IBM MQ: a graphical interface for administering and monitoring IBM MQ resources
v Java™ and .NET Messaging and Web Services
v IBM MQ Development Toolkit

The installation process begins. Depending on your system the installation process can take several
minutes.
At the end of the installation process, the IBM MQ Setup window displays the message
Installation Wizard Completed Successfully .

d. Click Finish.

You have successfully installed IBM MQ. The Prepare IBM MQ wizard starts automatically, displaying
the Welcome to the Prepare IBM MQ Wizard page.

3. Use the Prepare MQ wizard to start the IBM MQ service and start the Default Configuration wizard.

Note:

You cannot create the default configuration if you have already created other queue managers; you
must first delete the other queue managers then run the Default Configuration wizard. To delete a
queue manager, see Steps for deleting a queue manager
a. On the Welcome to the Prepare IBM MQ Wizard, select Next. The Prepare IBM MQ Wizard

displays the message Status: Checking IBM MQ Configuration and a progress bar. When the
process is complete the IBM MQ Network Configuration page is displayed.

b. On the IBM MQ Network Configuration page of the Prepare IBM MQ Wizard, select No.
c. Click Next. The Prepare IBM MQ Wizard displays a message Status: starting the IBM MQ

Service , and a progress bar. When the process is complete the wizard displays the Completing
the Prepare IBM MQ Wizard page.

d. Select Launch IBM MQ Explorer and choose whether to view the release notes, and then click the
Finish button. IBM MQ Explorer starts.

You have installed IBM MQ. You have also started the IBM MQ Explorer.
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4. Optional: If you want to use the IBM MQ Postcard application to verify your installation, create the
default configuration.
a. If the Content page is not already displayed, click Window > Show View > IBM MQ Explorer -

Content to display it.
b. Click Create the Default Configuration. The IBM MQ Default Configuration page is opened.
c. Click Set up Default Configuration. The Default Configuration Wizard is opened.
d. Click Next and Next again to move through the information pages.
e. On the Default Configuration page, clear both Allow remote administration of the queue

manager and Join the queue manager to the default cluster options, and then click Next. Take a
note of the queue manager name, as you will need this later, when using the Postcard application.

f. On the summary page, click Finish. The Default Configuration Wizard is closed, and a dialog box
displaying the message Setting up the default default configuration. appears. When this is
complete, focus is returned to the IBM MQ Default Configuration window, and the following
message is displayed: Default configuration is partially complete .

Note: The IBM MQ Default Configuration window might also display the message: Join the
default cluster by clicking "Join default cluster" to complete the default configuration
on this computer. This is only necessary if you want to join a cluster, which is not required for this
scenario.

g. Click Close.

The Default Configuration is now set up, and you are ready to verify your installation.
5. Optional: If you created a default configuration, verify your installation by using the Postcard

application that is supplied with IBM MQ. You can start two instances of the Postcard application and
exchange messages between them.
If you did not create a default configuration, you can still follow these steps to verify your
installation, but you must first configure a queue manager as described in the previous task of this
scenario.

Note: Running the Postcard application on a non-default configuration automatically creates a queue
called postcard on your queue manager. You can delete this queue after using the postcard
application.
a. If the Content page is not already displayed, click Window > Show View > IBM MQ Explorer -

Content to display it.
b. Click Launch Postcard to open the Postcard - Sign On window.
c. Enter a nickname for the first user, for example: Jim and click OK.
d. On the IBM MQ Postcard Network window select Continue on this computer only and click OK.

The Postcard application for 'jim' opens.
e. Move Jim's Postcards to one side of your screen, then start a second Postcard.
f. Click Launch Postcard to open the Postcard - Sign On window.
g. Enter a nickname for the second user, for example: Sue and click OK.
h. On the IBM MQ Postcard Network window select Continue on this computer only and click OK.

The Postcard application for 'sue' opens.
i. In the Postcard - 'jim' window enter sue in the To: textbox.
j. In the Postcard - 'jim' window enter the name of the queue manager you defined in step 4e, or

taken from the entry On: beneath the Message: textbox.
k. In the Postcard - 'jim' window enter a message, for example Hi Sue! in the Message: textbox
l. Click Send button to send the message to user Sue.
m. Observe the message received by user Sue, in the Postcard - 'sue' application window. To view the

received message double-click on the entry in the Postcards sent and received grid.
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Note: Click Help in this and other Postcard application windows to view further instructions
about running the Postcard application.

You have verified your IBM MQ installation by using the Postcard application.

Results

IBM MQ is installed and verified, and you are ready to configure objects such as queue managers and
queues.

What to do next

Follow the instructions in “Creating a queue manager called QM1.”
Related information:
Disc space requirements
Hardware and software requirements on Windows systems
Introduction to IBM MQ 
Installing an IBM MQ server on Windows
Verifying the installation using the Postcard application
Configuring an IBM MQ server

Creating a queue manager called QM1:

Create a queue manager, called QM1 by using the IBM MQ Explorer. Queue managers are the main
components in an IBM MQ messaging network.

Before you begin

You must have IBM MQ installed. If you do not, see “Installing using the launchpad” on page 4 for
information about how to do so.

About this task

In this example, all names are typed in uppercase and because IBM MQ names are case-sensitive, you
must type all names in uppercase too.

To create and start a queue manager by using the IBM MQ Explorer, complete the following steps.

Procedure

1. Start IBM MQ Explorer as an administrator.
2. In the Navigator view, right-click the Queue Managers folder, then click New > Queue Manager. The

Create Queue Manager wizard starts.
3. In the Queue Manager name field, type QM1.
4. Select the Make this the default queue manager check box.
5. In the Dead-letter queue field type SYSTEM.DEAD.LETTER.QUEUE. This is the name of the dead-letter

queue that is automatically created when you create the queue manager.
6. Leave the other fields empty and click Finish, or if that button is disabled, click Next. The Finish

button is disabled if the port number conflicts with an existing queue manager, for example the queue
manager that is created as part of the default configuration. You must continue through the wizard to
change the default port number.

7. If you clicked Next, continue to accept the defaults and click Next on each page until you get to the
final page of the wizard, when the Finish button becomes available. Change the specified port
number, for example to 1415, and click Finish.
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IBM MQ displays a Creating Queue Manager dialog window while the queue manager is created and
started.

What to do next

To create a queue, see “Creating a queue called LQ1.”
Related information:
Creating and managing queue managers on Multiplatforms

Creating a queue called LQ1:

Create a queue by using the IBM MQ Explorer. Queues are data structures that are used to store
messages and are IBM MQ queue manager objects.

About this task

In this task you can create IBM MQ objects using the IBM MQ Explorer.

To create and start a queue by using the IBM MQ Explorer, complete the following steps.

Procedure

1. In the Navigator view, expand the Queue Managers folder.
2. Expand queue manager QM1.
3. Right-click the Queues folder, then click New > Local Queue... The New Local Queue wizard starts.
4. In the Name field, type LQ1.
5. Click Finish.

The new queue LQ1, is displayed in the Content view. If the queue is not displayed in the Content
view, click on the Refresh button, at the top of the Content view.

What to do next

You are ready to put a message on to your queue. To put a message in a queue, see “Putting a message
to the queue LQ1.”

Putting a message to the queue LQ1:

Put a message on to the queue LQ1 by using the IBM MQ Explorer.

About this task

This task assumes that you have already created a queue manager called QM1 as described in “Creating
a queue manager called QM1” on page 12 and a queue called LQ1 as described in “Creating a queue
called LQ1.”

To put a message to the queue by using the IBM MQ Explorer, complete the following steps.

Procedure

1. In the Navigator view, expand the Queue Managers folder.
2. Expand queue manager QM1, which you created.
3. Click the Queues folder. The queue manager's queues are listed in the Content view.
4. In the Content view, right-click the local queue LQ1, then click Put Test Message... The Put test

message dialog opens.

8 IBM MQ: Scenarios



5. In the Message data field, type some text, for example Hello World, then click Put message. The
Message data field is cleared and the message is put on the queue.

6. Click Close. In the Content view, notice that the LQ1 Current queue depth value is now 1. If the
Current queue depth column is not visible, you might need to scroll to the right of the Content View.

What to do next

To get a message from the queue, see “Getting a message from the queue LQ1.”

Getting a message from the queue LQ1:

Get a message from the queue LQ1 by using the IBM MQ Explorer.

About this task

This task assumes that you have already put a message QM1 as described in “Putting a message to the
queue LQ1” on page 8.

To get a message from the queue by using the IBM MQ Explorer, complete the following steps.

Procedure

1. In the Navigator view, expand the Queue Managers folder, then expand QM1.
2. Click the Queues folder.
3. In the Content view, right-click the local queue LQ1, then click Browse Messages.... The Message

browser opens to show the list of the messages that are currently on QM1.
4. Double-click the last message to open the properties dialog.

On the Data page of the properties dialog, the Message data field displays the content of the message
in human-readable form.

What to do next

Follow the instructions in subsequent scenarios to explore further IBM MQ features.

To learn about writing queuing applications, connecting to and disconnecting from a queue manager,
publish/subscribe, and opening and closing objects, see Writing a procedural application for queuing.

Installing and configuring using the command line interface
Install IBM MQ on Windows by using the command line to perform a silent installation and set up the
environment variable. After verifying your installation, create a queue manager and a queue and then try
putting a message to the queue and getting a message from the queue.

About this task

This scenario was tested with IBM MQ Version 8.0.0.2 on a Windows 7 Professional 64-bit (SP 1)
operating system.
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Installing using a silent installation:

Install IBM MQ on Windows by using the command line to perform a silent installation and confirm that
the environment for your installation is set up correctly.

Before you begin

Before you start this task, complete the following checks:
v You must have local administrator authority when you are installing. Define this authority through the

Windows facilities.
v Ensure that the machine name does not contain any spaces.
v Ensure that you have sufficient disk space. You need up to 1005 MB to fully install IBM MQ Version

9.0 for Windows.
v Determine whether you need to define Windows domain user IDs for any IBM MQ users.

Before you install IBM MQ, check that your system meets the hardware and software requirements. For
the latest details of hardware and software requirements on all supported platforms, see System
Requirements for IBM MQ.

About this task

This scenario assumes that you are installing IBM MQ for the first time on your machine, and that you
are using the default locations. By default the location of the IBM MQ Version 9.0 program files are
C:\Program Files\IBM\MQ, and the data and log file location is C:\ProgramData\IBM\MQ.

Note: If you have any previous installations of IBM MQ on your machine the default locations of the
program and data files might change. For further information, see Program and data directory locations.
If you have already previously completed this scenario, and want to repeat it with a single, fresh
installation using the default locations, remove your previous installation before starting the scenario
again. To uninstall an existing instance of IBM MQ from your machine, see “Uninstalling IBM MQ” on
page 15.

IBM MQ on Windows uses the MSI technology to install software. For more information on installing
using the MSI technology, see Advanced installation using msiexec.

To install IBM MQ using the command line, you must specify the following parameters:
v /i "MQ_INSTALLATION_MEDIA\MSI\IBM MQ.msi" where MQ_INSTALLATION_MEDIA is the location of the

IBM MQ.msi file. This argument specifies the location of the .msi file.
v /l*v USER_LOGFILE_LOCATION\install.log where USER_LOGFILE_LOCATION is where you want the

installation logs to be written to.

Note: The folder where you want the install.log to be created must exist before you run the
command.

v /q this parameter must be used to perform the silent installation.
v USEINI="RESPONSE_FILE" where RESPONSE_FILE is the name and location of the response file to be

used by the silent installation. This scenario uses the sample Response.ini file, which is included in the
IBM MQ installation media.

v TRANSFORMS="TRANSFORM_FILE" where TRANSFORM_FILE is the name of the transform file to be
applied to the installation. This scenario uses the American English transform, 1033.mst.

v AGREETOLICENSE="YES" this parameter must be included, or the installation can not complete.
v ADDLOCAL="Server" this parameter lists which components to install.
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Procedure

1. Use the command line to conduct a silent installation.
a. To invoke the silent installation from an elevated command prompt, click the Start button on your

Windows taskbar and type cmd in search programs and files field. Right click the cmd.exe
program and select Run as administrator.

b. In the Windows command prompt, enter the following command:

Note: The command is presented on multiple lines here, but it must be typed out on one line.
msiexec /i "MQ_INSTALLATION_MEDIA\MSI\IBM MQ.msi"
/l*v c:\wmqinslogs\install.log
/q USEINI="MQ_INSTALLATION_MEDIA\Response.ini"
TRANSFORMS="1033.mst"
AGREETOLICENSE="yes"
ADDLOCAL="Server"

Where MQ_INSTALLATION_MEDIA is the path to your IBM MQ installation media.

Note: The folder where you want the install.log to be created must exist before you run the
command.

Note:
After you input the command, the command line will return the prompt.

c. To view the installations progress, open the log file that you specified. If the installation completed
successfully, you see the message Product: IBM MQ (Installation1) -- Installation operation
completed successfully. two paragraphs up from the bottom of the log file.

d. When the installation is complete, the service starts and the IBM MQ icon appears in the system
tray. You have installed IBM MQ, and you have started the IBM MQ service.

2. Set up environment variables for your installation by using the setmqenv command.
a. Enter the following command in the command line:

Note: If you used the default location, the path to your installation will be C:\Program
Files\IBM\MQ.
"MQ_INSTALLATION_PATH/bin/setmqenv" -s

where MQ_INSTALLATION_PATH refers to the location where IBM MQ is installed. Ensure you enclose
the path to setmqenv in the bin folder, in quotation marks, to prevent the prompt returning an
error.

b. Check that the environment is set up correctly by entering the following command:
dspmqver

If the command completes successfully, and the expected version number and installation name
are returned, the environment is correctly set up. For this scenario the message should include the
line:
Version: 9.0.0.0

and if you did not specify a non-default installation name, the line:
InstName: Installation1

You have successfully installed IBM MQ using a silent installation.

Results

You have conducted an IBM MQ silent installation and confirmed that your environment is set up
correctly.
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What to do next

v You can run the Prepare IBM MQ Wizard.
v Follow the instructions in “Creating a queue manager called QM1.”

If you encounter any issues during the installation, check the installation log, at the location that you
specified in the msiexec command, in this scenario the location of the log file is: c:\wmqinslogs\
install.log. Take any action that is specified in the log and rerun the installation again. You can also
check the parameters that you passed with the command, masking sure you are including all the
required parameters.
Related information:
Advanced installation using msiexec
Using transforms with msiexec
Installing IBM MQ - overview

Creating a queue manager called QM1:

Create a queue manager, called QM1 by using the command-line interface. Queue managers are the main
components in an IBM MQ messaging network.

Before you begin

You must have IBM MQ installed. If you do not, see “Installing using a silent installation” on page 10 for
information about how to do so.

About this task

In this example, all names are typed in uppercase and because IBM MQ names are case-sensitive, you
must type all names in uppercase too.

Procedure

1. Open a command prompt as an administrator.
2. Create a queue manager with the name QM1 by typing the following command:

crtmqm QM1

When the system creates the queue manager, the following output is displayed:
C:\>crtmqm QM1
IBM MQ queue manager created.
Creating or replacing default objects for QM1.
Default objects statistics : 61 created. 0 replaced. 0 failed.
Completing setup.
Setup completed.

The queue manager is created, and is stopped. You must start the queue manager before you can
administer it, and before you can read and write messages from its queues.

3. Start the queue manager by entering the following command:
strmqm QM1

When the queue manager successfully starts, the following output is displayed:
C:\>strmqm QM1
IBM MQ queue manager ’QM1’ starting.
5 log records accessed on queue manager ’QM1’ during the log replay phase.
Log replay for queue manager ’QM1’ complete.
Transaction manager state recovered for queue manager ’QM1’.
IBM MQ queue manager ’QM1’ started.

The queue manager is started.
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What to do next

To create a queue, see “Creating a queue called LQ1.”
Related information:
Creating and managing queue managers on Multiplatforms

Creating a queue called LQ1:

Create a queue by using the command-line interface. Queues are data structures that are used to store
messages and are IBM MQ queue manager objects.

About this task

There are three ways to create IBM MQ objects:
v Command-line.
v IBM MQ Explorer.
v Using a programmable interface.

In this task you can create IBM MQ objects using the command-line.

The command-line interface has a scripting language called IBM MQ Script Commands (MQSC). The
scripting tool, runmqsc, is used to run the script against a queue manager. To create and start a queue by
using the command-line interface, complete the following steps.

Procedure

1. Start the scripting tool by typing the following command:
runmqsc QM1

When the scripting tool starts, the following output is displayed:
C:\>runmqsc QM1
5724-H72 (C) Copyright IBM Corp. 1994, 2008. ALL RIGHTS RESERVED.
Starting MQSC for queue manager QM1.

The tool is ready to accept MQSC commands.
2. Create a local queue called LQ1 by typing the following MQSC command:

define qlocal(LQ1)

When the queue is created, the following output is displayed:
define qlocal(LQ1)
2 : define qlocal(LQ1)
AMQ8006: IBM MQ queue created.

3. Stop the scripting tool by typing the following MQSC command:
end

When the scripting tool ends, the following output is displayed:
One MQSC command read.
No commands have a syntax error.
All valid MQSC commands were processed.

C:\>
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What to do next

You are ready to put a message on to your queue. To put a message in a queue, see “Putting a message
to the queue LQ1.”

Putting a message to the queue LQ1:

Put a message on to the queue LQ1 by using the command-line interface.

About this task

IBM MQ comes with a sample application called amqsput. This application puts a message to a
predefined queue.

To put a message to the queue by using the command-line interface, complete the following steps.

Procedure

1. Use the amqsput sample application to put a message to queue LQ1, by typing the following command:
amqsput LQ1 QM1

When the sample application starts, the following output is displayed:
C:\>amqsput LQ1 QM1
Sample AMQSPUT0 start
target queue is LQ1

2. Type Hello World and press Enter. You placed a message that contains the text "Hello World" on the
queue LQ1 managed by the queue manager called QM1.

3. To end amqsput, press Enter. The following output is displayed:
C:\>amqsput LQ1 QM1
Sample AMQSPUT0 start
target queue is LQ1
Hello World

Sample AMQSPUT0 end

What to do next

To get a message from the queue, see “Getting a message from the queue LQ1.”

Getting a message from the queue LQ1:

Get a message from the queue LQ1 by using the command-line interface.

About this task

IBM MQ comes with a sample application called amqsget. This application reads messages from a queue.

To get a message from the queue by using the command-line interface, complete the following steps.

Procedure

Use the amqsget sample application to read a message on the queue LQ1, by typing the following
command:
amqsget LQ1 QM1

When the sample application starts, the following output is displayed:
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C:\>amqsget LQ1 QM1
Sample AMQSGET0 start
message <Hello World>
no more messages
Sample AMQSGET0 end

The amqsget application ends 30 seconds after reading the message.

What to do next

Follow the instructions in subsequent scenarios to explore further IBM MQ features.

To learn about writing queuing applications, connecting to and disconnecting from a queue manager,
publish/subscribe, and opening and closing objects, see Writing a procedural application for queuing.

Uninstalling IBM MQ
Stop, and then uninstall IBM MQ, including removing any queue managers and their objects. At the end
of this task, you are ready to reinstall IBM MQ.

About this task

This task describes the steps for uninstalling IBM MQ on the Windows 7 operating system by using the
installation media.

The Getting started scenario takes you through options for installing IBM MQ by using the launchpad or
command line. Although you can have more than one installation of IBM MQ, this scenario is based on a
new installation on a single server. Therefore, if you want to repeat the scenario, or try out a different
installation method, you must first uninstall the existing IBM MQ components, including any existing
queue managers and their objects, so that you can start again with a fresh installation.

You might also need to uninstall so that you can carry out a fresh installation for some of the other
scenarios in this section.

Procedure
1. Stop the IBM MQ service.

a. Right-click on the IBM MQ icon in the system tray, then click Stop IBM MQ to stop the IBM MQ
service. A dialog with the following message is displayed:
Shutting down IBM MQ installation "Installation1" terminates all running queue managers and
IBM MQ processes for that installation, except those under Microsoft Failover Cluster control.
Are you sure you want to continue?

b. Click Yes and then wait for the IBM MQ to stop.
c. When the IBM MQ stops, right-click the IBM MQ icon in the system tray, then click Exit

2. Begin the uninstalling process in one of the two following ways:
a. In Windows Explorer, navigate to the temporary folder with the installation image and double

click setup.exe.
b. Insert the IBM MQ for Windows Server DVD into the DVD drive. If autorun is enabled, the

installation process starts. Otherwise, double-click the Setup icon in the root folder of the DVD to
start the uninstalling process. The IBM MQ Installation Launchpad window opens.

3. Remove IBM MQ.
a. Click IBM MQ Installation.
b. Click Launch IBM MQ Installer and click Next until the IBM MQ Program Maintenance pane is

displayed with a welcome message. If this pane is not displayed, IBM MQ for Windows is not
currently installed.
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c. Click Maintain or upgrade an existing instance. Select Installation1 to remove it. Click Next and
in the Program Maintenance pane, click Remove, then Next. The Removing Server feature pane is
shown.

d. Select Remove: remove existing queue managers and their objects. Click Next. The Remove IBM
MQ pane is displayed, with a summary of the installation to be removed.

e. Click Remove to continue. If a message appears stating that locked files are found, ensure that no
IBM MQ programs are running; see Uninstalling IBM MQ on Windows systems. When IBM MQ is
uninstalled, a message indicates completion.

f. Click Finish.

You have successfully uninstalled IBM MQ.
Related information:
Uninstalling IBM MQ on Windows systems

What to do next
What to do next on completion of the Getting started with IBM MQ scenario.

There are additional topics for you to view in the IBM MQ product documentation. You might want to
look at the following sections:
v Administering IBM MQ

IBM MQ provides control commands that you can use. You use two of these commands in this
scenario: crtmqm and strmqm. This section also provides a good overview about message queuing.

v MQSC reference
In this scenario, you use the define qlocal(’LQ1’) command to define a local queue called LQ1 ; this
command is an MQSC command. IBM MQ system administrators use these commands to manage their
queue managers. This section introduces the commands and shows you how to use them, before
describing the commands in detail, in alphabetical order.

v Configuring a queue manager cluster
This section describes how to organize, use, and manage queue managers in virtual groups known as
clusters. Clustering ensures that each queue manager within a cluster knows about all the other queue
managers in the same cluster. Clustering also makes the management of complex queue manager
networks simpler.

The Product Connectivity Scenarios and Patterns product documentation provides information that leads
you through the key tasks required to connect WebSphere Application Server to IBM MQ in a variety of
scenarios. Each scenario contains the instructions for implementing a solution in a business context,
allowing you to learn as you go without needing to make use of other information resources.
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Other learning resources
IBM MQ provides role-based training paths to assist you by defining a path to acquiring skills for specific
IBM MQ product offerings.

Two training paths for IBM MQ are:

Application Developer
These users are responsible for creating the applications that use the queue manager. In this
scenario, they write the applications amqsput and amqsget.

System administrator
These users are responsible for creating the queue manager and it objects, they typically carry out
similar tasks to that you covered in this scenario.

For information about training paths, technical events and conferences, see the IBM Skills Gateway web
pages.

A certification program is available that demonstrates that you achieve a skill level in IBM MQ. For more
information, see the IBM Professional Certification Program web pages.

You can collaborate with other users, for example, for:
v E-mail based community of IBM MQ professionals, see https://listserv.meduniwien.ac.at/archives/

mqser-l.html.
v Discussion forums focusing on the IBM MQ family of products, see the MQSeries.net forums.
v Downloads, videos, code samples, and blogs for IBM Messaging products, see IBM Messaging

Developer Center.
v A developerWorks® blog by the developers of the various IBM messaging products, see MQdev Blog.
v IBM MQ tagged questions and answers on stackoverflow.com, see http://stackoverflow.com/

questions/tagged/websphere-mq.
Related information:
IBM MQ Version 9.0 PDF documentation

Point-to-point scenario
Connect two IBM MQ queue managers in a point-to-point topology to enable distributed queuing.

About this task

Create two queue managers and the appropriate queues and channels to create a one-way, point-to-point
messaging infrastructure. Create the queue managers on separate hosts to enable communication over a
network. As an extension to the scenario, add Transport Layer Security to the channel to enable secure
communication of data.
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Planning the solution
Point-to-point messaging is the simplest form of messaging in IBM MQ. In point-to-point messaging, the
sending application must know certain information about the receiving application before messages can
be sent. The sending application will require a way to address the remote queue. Use point-to-point
messaging to send a message to a remote queue manager with a sample application.

Overview: The delivered logical topology
The delivered logical topology after completing the scenario.

The point-to-point infrastructure allows one directional messaging between queue managers on different
host machines. Queue manager one, on host one sends messages to queue manager two, on host two.
After this scenario is complete, the delivered topology will look like Figure 1.

Basic concepts and key terms
Descriptions of the basic concepts and key terms you must know to complete the point to point scenario.

Basic concepts

IBM MQ enables applications to read and write messages to a queue. The application that reads the
message is independent of the application that writes the message. It is not a requirement to have the
two applications running at the same time. If no application is available to read the message it is queued
on the IBM MQ queue until an application reads it.

Key terms

Here is a list of key terms about message queuing.

Term Description

Queue managers The queue manager is responsible for maintaining the
queues it owns, and for storing all the messages it
receives onto the appropriate queues.

QM1

Queue QM2

Remote Queue QUEUE.ON.QM2

Channel TO.QM2

Msg1

QM2

Queue RECEIVEQUEUE

Channel TO.QM2

Msg1

Figure 2. QM1 sends a message to QM2
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Term Description

Messages A message is a string of bytes that is meaningful to the
applications that use it. Messages are used to transfer
information from one application program to another.
The applications can be running on the same or on
different computers.

Local queues A local queue is a data structure used to store messages.
The queue can be a normal queue or a transmission
queue. A normal queue holds messages that are to be
read by an application that is reading the message
directly from the queue manager. A transmission queue
holds messages that are in transit to another queue
manager.

Remote queues A remote queue is used to address a message to another
queue manager.

Channels Channels are use to send and receive messages between
queue managers.

Listeners Listeners are processes that accept network requests from
other queue managers, or client applications, and start
associated channels.

Implementing the solution
Implement the solution to the scenario. Create two IBM MQ queue managers on two separate hosts, the
source queue manager to send messages, and the target queue manager to receive messages.

Before you begin

The starting point for this scenario is an existing, verified IBM MQ installation. For instructions to install
IBM MQ, follow the steps in Installing an IBM MQ server on Windows.

About this task

Create two queue managers by using the command-line interface, define the required listeners, queues,
and channels. The delivered logical topology shows the functions added by implementing the solution.
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Creating the queue manager
Create an IBM MQ queue manager to send messages to the target queue manager.

Before you begin
v You must have IBM MQ installed. For more information about installing IBM MQ, see Installing and

uninstalling.

About this task

Create the IBM MQ queue manager by using the command-line interface.

Procedure
1. Create a queue manager with the name QM1. On the command-line, type:

crtmqm QM1

The following messages are displayed to confirm that the queue manager is created:
IBM MQ queue manager created.
Creating or replacing default objects for QM1.
Default objects statistics : 61 created. 0 replaced. 0 failed.
Completing setup.
Setup completed.

2. Start the queue manager. On the command-line, type:
strmqm QM1

The following messages are displayed to confirm that the queue manager is started:
IBM MQ queue manager ’QM1’ starting.
5 log records accessed on queue manager ’QM1’ during the log replay phase.
Log replay for queue manager ’QM1’ complete.
Transaction manager state recovered for queue manager ’QM1’.
IBM MQ queue manager ’QM1’ started.

Results

The IBM MQ queue manager QM1 is created and started.

QM1

Queue QM2

Remote Queue QUEUE.ON.QM2

Channel TO.QM2

Msg1

QM2

Queue RECEIVEQUEUE

Channel TO.QM2

Msg1
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What to do next

To create the queues to use with QM1, follow the instructions in “Creating the queues.”

Creating the queues
Create IBM MQ queues that are managed by the IBM MQ queue manager.

Before you begin

You must have an IBM MQ queue manager that is set up as described in “Creating the queue manager”
on page 20.

About this task

Start the MQSC interface to administer objects that are connected to the queue manager. Create a
transmission queue, and a remote queue definition. Exit the MQSC interface.

Procedure
1. On the command-line, type:

runmqsc QM1

After a confirmation message, the tool is ready to accept commands.
2. Create a transmission queue called QM2. It is good practice to give the transmission queue the same

name as the remote queue manager. In the MQSC interface, type:
DEFINE QLOCAL(QM2) DESCR(’Transmission queue to QM2’) USAGE(XMITQ)

The transmission queue is created.
3. Create a remote queue definition called QUEUE.ON.QM2. The remote queue definition must refer to the

name given to the local queue on the remote host. In the MQSC interface, type:
DEFINE QREMOTE(QUEUE.ON.QM2) DESCR(’Remote queue for QM2’) XMITQ(QM2) RNAME(RECEIVEQUEUE) RQMNAME(QM2)

The remote queue definition is created.
4. Type end to exit the MQSC interface.

What to do next

To create the sender channel that is used to connect to the target queue manager, follow the instructions
in “Creating the sender channel” on page 22.
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Creating the sender channel
Create the sender channel on the source queue manager, the channel is used to connect to the target
queue manager.

Before you begin

To create a channel that uses TLS, follow the instructions in “Creating the channels to use TLS” on page
28. This can be done afterward if you want to test the solution without TLS security.

About this task

Start the MQSC interface to administer objects that are connected to the queue manager and create the
sender channel. This channel is used to connect to the target queue manager called QM2.

Procedure
1. On the command-line, type:

runmqsc QM1

After a confirmation message, the tool is ready to accept commands.
2. Create the sender channel, called TO.QM2. In the MQSC interface, type:

DEFINE CHANNEL(TO.QM2) CHLTYPE(SDR) CONNAME(’ remoteHost ’) TRPTYPE(TCP) XMITQ(QM2)

Note: The variable remoteHost is the host name or IP address of the target queue manager.
The sender channel is created.

What to do next

To create the distributed queue manager topology, follow the instructions in “Creating the distributed
queue manager topology.”

Creating the distributed queue manager topology
Point-to-point messaging is the simplest form of messaging in IBM MQ. In point-to-point messaging, the
sending application must know certain information about the receiving application before messages can
be sent. The sending application will require a way to address the remote queue. Use point-to-point
messaging to send a message to a second queue manager with a sample application.

Before you begin

You must have set up the source queue manager as described in “Creating the queue manager” on page
20.

About this task

Create the target queue manager on a remote host. Use the sample applications to verify communication
between the source and target queue managers.
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Creating the queue manager:

Create an IBM MQ queue manager to receive messages from the remote queue manager.

Before you begin

You must have IBM MQ installed. For more information about installing IBM MQ, see Installing an IBM
MQ server on Windows.

About this task

Create the IBM MQ queue manager by using the command-line interface.

Procedure

1. Create a queue manager with the name QM2. On the command-line, type:
crtmqm QM2

The following messages are displayed:
IBM MQ queue manager created.
Creating or replacing default objects for QM2.
Default objects statistics : 61 created. 0 replaced. 0 failed.
Completing setup.
Setup completed.

2. Start the queue manager. On the command-line, type:
strmqm QM2

The following messages are displayed to confirm that the queue manager is started:
IBM MQ queue manager ’QM2’ starting.
5 log records accessed on queue manager ’QM2’ during the log replay phase.
Log replay for queue manager ’QM2’ complete.
Transaction manager state recovered for queue manager ’QM2’.
IBM MQ queue manager ’QM2’ started.

Results

The IBM MQ queue manager QM2 is created and started.

What to do next

To create the queue to use with QM2, follow the instructions in “Creating the queue.”

Creating the queue:

Create the local queue that is used to receive messages on the target queue manager, and the listener that
accepts the inbound channel connection.

About this task

After you have started the runmqsc scripting tool, you can use MQSC commands to create a local queue
and listener.

Procedure

1. Start the scripting tool by typing the following command:
runmqsc QM2

A message is displayed to confirm that the tool has started.
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2. Create a local queue called RECEIVEQUEUE. The queue must have the same name as referred to in the
remote queue definition on the source queue manager. In the MQSC interface, type:
DEFINE QLOCAL(RECEIVEQUEUE) DESCR(’Receiving queue’)

The local queue is created.
3. Create a listener called LISTENER1. In the MQSC interface, type:

DEFINE LISTENER(LISTENER1) TRPTYPE(TCP) PORT(1414) CONTROL(QMGR)

Note: Port 1414 is the default port for IBM MQ. If you chose a different port number, you must add it
to the CONNAME of the sender channel on the sending queue manager.

4. Start the listener so it is ready to accept inbound connections. In the MQSC interface, type:
START LISTENER(LISTENER1)

Note: Since the listener was created with the option CONTROL(QMGR), next time the queue manager is
started, the listener will also be automatically started.

5. Type end to exit the MQSC interface.

What to do next

To create the receiver channel to create the connection between the source and target queue managers,
follow the instructions in “Creating the receiver channel.”

Creating the receiver channel:

Create the receiver channel for the target queue manager to enable communication between the source
and target queue managers.

Before you begin

To create a channel that uses TLS, follow the instructions in “Creating the channels to use TLS” on page
28. This can be done afterward if you want to test the solution without TLS security.

About this task

Use the MQSC interface to create a receiver channel that is managed by QM2.

Procedure

1. On the command-line, type:
runmqsc QM2

After a confirmation message, the tool is ready to accept commands.
2. Create a receiver channel called TO.QM2. The channel must have the same name as the sender channel

on the source queue manager. In the MQSC interface, type:
DEFINE CHANNEL(TO.QM2) CHLTYPE(RCVR) TRPTYPE(TCP)

The receiver channel is created.

What to do next

To start the sender channel on the source queue manager, that in turn initiates the receiver channel on the
target queue manager, ollow the instructions in “Starting the sender channel” on page 25.
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Starting the sender channel:

Start the sender channel on the source queue manager, the receiver channel on the target queue manager
is also started. Messages can be sent from the source queue manager to the target queue manager.

About this task

Start the MQSC interface to administer objects that are connected to the queue manager. Start the sender
channel to connect to the target queue manager, enabling communication. The receiver channel starts
automatically when the source channel is started.

Procedure

1. On the command-line, type:
runmqsc QM1

After a confirmation message, the tool is ready to accept commands.
2. Start the sender channel on the source queue manager. In the MQSC interface, type:

START CHANNEL(TO.QM2)

The sender channel starts, the receiver channel on the target queue manager is also started.
3. Check that the channel is running. In the MQSC interface, type:

DISPLAY CHSTATUS(TO.QM2)

If the channel is running, you will see that it reports STATUS(RUNNING). If it reports any other value in
STATUS then check the error log.

What to do next

To verify that the source queue manager can send messages to the target queue manager, follow the
instructions in “Verifying the solution.”

Verifying the solution
Verify that the source queue manager can put a message onto the remote queue. Verify that the target
queue manager can get the message from the queue.

About this task

Use the sample applications, amqsput and amqsget to verify the solution.

Procedure
1. Send a message to the target queue manager, QM2 from the source queue manager.

a. In the command-line interface, type:
amqsput QUEUE.ON.QM2 QM1

You must use the name of the remote queue definition to send the message to the target queue
manager. The following message is displayed:
Sample AMQSPUT0 start
target queue is QUEUE.ON.QM2

b. Type Hello world., press Enter twice.
2. Get the message on the target queue manager.

a. In the command-line interface, type:
amqsget RECEIVEQUEUE QM2
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The following message is displayed:
Sample AMQSGET0 start
message <Hello world.>
no more messages
Sample AMQSGET0 end

Results

The target queue manager received the message from the source queue manager, verifying that point to
point communication is achieved.

What to do next

If you want to add security to the solution, follow the instructions in “Securing the point-to-point
topology.”

Securing the point-to-point topology
Secure the point-to-point topology so that messages can be transmitted in a production environment.

About this task

Secure the source and target queue manager objects so that the correct level of access is granted. Define
which user groups have access to the queues and queue managers. Secure the network connection by
using digitally signed certificates to connect using Transport Layer Security (TLS).

Securing the source queue manager objects
Set the authorization values for the objects on the source queue manager.

About this task

Use the setmqaut command to grant authorities to the user group running the application.

Procedure
1. To grant the specified user group with connect authorization to the queue manager, on the

command-line interface, type:
setmqaut -m QM1 -t qmgr -g userGroup +connect

2. To grant the specified user group with put authorization on the remote queue definition, on the
command-line interface, type:
setmqaut -m QM1 -t q -n "QUEUE.ON.QM2" -g userGroup +put
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Securing the target queue manager objects
Set the authorization values for the objects on the target queue manager.

About this task

Use the setmqaut command to grant authorities to the user group running the application.

Procedure
1. To grant the specified user group with connect authorization to the queue manager, on the

command-line interface, type:
setmqaut -m QM2 -t qmgr -g userGroup +connect

2. To grant the specified user group with get authorization on the remote queue definition, in the
command-line interface, type:
setmqaut -m QM2 -t q -n "RECEIVEQUEUE" -g userGroup +get

Securing the network
Secure the network connections between the source and remote queue managers.

About this task

Use signed certificates to verify the authenticity of the source and remote queue managers. Transfer
messages using a TLS network to encrypt messages.

Preparing the queue managers to use TLS:

The IBM MQ queue manager's key repository is used to store the queue manager's personal certificate
and the public Certificate Authority (CA) certificate. The personal certificate request from the IBM MQ
queue manager must be signed by a CA, the public certificate is used by the other entities to authenticate
the IBM MQ queue manager.

Before you begin

You must have the public Certificate Authority certificate in a file.

About this task

Create the IBM MQ queue manager's key repository, import the certificate authority's signer certificate
and create the queue manager's personal certificate request.

Procedure

1. Create a CMS key repository file for the queue manager called key.kdb. Navigate to the
Qmgrs\QM1\ssl directory, and on the command line, type:
runmqckm -keydb -create -db key.kdb -pw passw0rd -type cms -stash

Note: For this simple example we have used a password of passw0rd. You may wish to choose a
different password and change each of the following commands to use your own password instead.

2. Add the CA certificate, which you have in a file, to the key repository, on the command line, type:
runmqckm -cert -add -file CA-certificate-file -db key.kdb -pw passw0rd -label TrustedCA

3. Request a personal certificate that will be written to a request file called QM1req.req. On the command
line, enter:
runmqckm -certreq -create -db key.kdb -pw passw0rd -label ibmwebspheremqqm1
-dn CN="QM1" -size 1024 -file QM1req.req
-sig_alg SHA1WithRSA
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The default certificate label name is shown in this example. You can set your own name if you prefer.
For details, see Digital certificate labels.

4. Send the certificate request file to your CA, they will issue a digitally signed certificate. Put the
received, signed certificate file in a suitable location to be received into the queue manager's key
repository.

5. Receive the signed personal certificate into the queue manager's key repository.
runmqckm -cert -receive -file Signed-certificate-file -db key.kdb -pw passw0rd -format ascii

6. Complete these steps for each queue manager, changing the queue manager name accordingly.

What to do next

To enable secure communication over the sender and receiver channels, follow the instructions in
“Creating the channels to use TLS.”

Creating the channels to use TLS:

Create a new channel that uses TLS to create a connection.

Before you begin

To communicate over a channel that uses TLS, first you must have the required certificates for each end
of the connection. To create the required certificates, follow the instructions in “Preparing the queue
managers to use TLS” on page 27.

About this task

Use the MQSC interface to define channels with TLS attributes set. This task can be done even if you
defined your channels without TLS in a prior step through the use of the REPLACE keyword.

Procedure

1. On the command-line, type:
runmqsc QM1

2. Create the sender channel on QM1, called TO.QM2, in the MQSC interface, type:
DEFINE CHANNEL(TO.QM2) CHLTYPE(SDR) TRPTYPE(TCP)
CONNAME(’remoteHost’) XMITQ(QM2)
SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA256)
DESCR(’Sender channel using TLS from QM1 to QM2’)
REPLACE

Note: The variable remoteHost is the host name or IP address of the target queue manager.

You can specify a CERTLABL attribute for the channel. If you do, it must match the value on the
-label parameter of the runmqckm command that you previously ran in step 3 of “Preparing the queue
managers to use TLS” on page 27. For more information on certificate labels, see Digital certificate
labels, understanding the requirements.

3. Type end to exit the MQSC interface.
4. On the command-line, type:

runmqsc QM2

5. Create a receiver channel on QM2, called TO.QM2, in the MQSC interface, type:
DEFINE CHANNEL(TO.QM2) CHLTYPE(RCVR) TRPTYPE(TCP)
SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA256) SSLCAUTH(REQUIRED)
DESCR(’Receiver channel using TLS from QM1 to QM2’)
REPLACE

6. Type end to exit the MQSC interface.
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What to do next

To verify that the source queue manager can send messages to the target queue manager using TLS,
follow the instructions in “Verifying the solution” on page 25.

Publish/subscribe scenarios
Two sets of scenarios that demonstrate use of publish/subscribe clusters and publish/subscribe
hierarchies.

The available publish/subscribe scenarios are described in the following subtopics:

Publish/subscribe cluster scenario
In this scenario you create a simple three queue manager cluster and configure it to allow subscriptions
created on one queue manager to receive messages published by an application connected to another
queue manager.

Before you begin

The starting point for this scenario is an existing IBM MQ installation. For instructions to install IBM MQ
, follow the steps in Installing an IBM MQ server on Windows.

About this task

By completing the steps in this scenario, you first create the following cluster:

DEMO

PS1 PS2

PS3

Full repos Full repos

Partial repos

Receiver and sender channels
defined at queue managers

Port 5000 Port 5001

Port 5002

 .

This cluster consists of three queue managers, two of which are defined as full repository queue
managers.

You then define a cluster topic on queue manager PS3. By creating the cluster topic, you have made the
cluster into a publish/subscribe cluster. To test the publish/subscribe cluster, you subscribe to the topic
on any queue manager, then publish a message to the topic from another queue manager and check that
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your subscription receives the message.
Related information:
Designing publish/subscribe clusters
Configuring a queue manager cluster

Creating and starting the queue managers
Create and start three queue managers, called PS1, PS2 and PS3.

Procedure
1. Create and start queue manager PS1.

a. Create the queue manager.
In the command line, enter the following command:
crtmqm PS1

b. Start the queue manager.
In the command line, enter the following command:
strmqm PS1

2. Repeat step 1 to create and start queue manager PS2.
3. Repeat step 1 to create and start queue manager PS3.

What to do next

You are now ready to configure the first queue manager.

Configuring the first queue manager
Use the MQSC interface to define a listener and a receiver channel for PS1, to set the queue manager as a
full repository for the cluster, and to define a sender channel from PS1 to PS2 so the two full repositories
can exchange information.

Before you begin

This task assumes that you have completed the steps in “Creating and starting the queue managers.”

Procedure
1. Define and start a listener for PS1.

a. Launch the MQSC interface.
In the command line, enter the following command:
runmqsc PS1

b. Define a listener.
Enter the following MQSC command:
DEFINE LISTENER(PS1_LS) TRPTYPE(TCP) CONTROL(QMGR) PORT(5000)

c. Start the listener.
Enter the following MQSC command:
START LISTENER(PS1_LS)

2. Set the queue manager as a full repository for the cluster.
Enter the following MQSC command:
ALTER QMGR REPOS(DEMO)

3. Define a receiver channel for PS1, to allow other queue managers in the cluster to communicate with
it.
Enter the following MQSC command:
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DEFINE CHANNEL(DEMO.PS1) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5000)’) CLUSTER(DEMO)
DESCR(’TCP Cluster-receiver channel for queue manager PS1’)

4. Define a sender channel from PS1 to PS2, to allow the two full repositories to exchange information.
Enter the following MQSC command:
DEFINE CHANNEL(DEMO.PS2) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5001)’) CLUSTER(DEMO)

DESCR(’TCP Cluster-sender channel from PS1 to queue manager PS2’)

What to do next

You are now ready to configure the second queue manager.

Configuring the second queue manager
Use the MQSC interface to define a listener and a receiver channel for PS2, to set the queue manager as a
full repository for the cluster, and to define a sender channel from PS2 to PS1 so the two full repositories
can exchange information.

Before you begin

This task assumes that you have completed the steps in “Configuring the first queue manager” on page
30.

Procedure
1. Define and start a listener for PS2.

a. Launch the MQSC interface.
In the command line, enter the following command:
runmqsc PS2

b. Define a listener.
Enter the following MQSC command:
DEFINE LISTENER(PS2_LS) TRPTYPE(TCP) CONTROL(QMGR) PORT(5001)

c. Start the listener.
Enter the following MQSC command:
START LISTENER(PS2_LS)

2. Set the queue manager as a full repository for the cluster.
Enter the following MQSC command:
ALTER QMGR REPOS(DEMO)

3. Define a receiver channel for PS2, to allow other queue managers in the cluster to communicate with
it.
Enter the following MQSC command:
DEFINE CHANNEL(DEMO.PS2) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5001)’) CLUSTER(DEMO)

DESCR(’TCP Cluster-receiver channel for queue manager PS2’)

4. Define a sender channel from PS2 to PS1, to allow the two full repositories to exchange information.
Enter the following MQSC command:
DEFINE CHANNEL(DEMO.PS1) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5000)’) CLUSTER(DEMO)

DESCR(’TCP Cluster-sender channel from PS2 to PS1’)

What to do next

You are now ready to configure the third queue manager.
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Configuring the third queue manager
Use the MQSC interface to define a listener and a receiver channel for PS3. Join PS3 into the cluster by
defining a sender channel from PS3 to one of the full repository queue managers.

Before you begin

This task assumes that you have completed the steps in “Configuring the second queue manager” on
page 31.

Procedure
1. Define and start a listener for PS3.

a. Launch the MQSC interface.
In the command line, enter the following command:
runmqsc PS3

b. Define a listener.
Enter the following MQSC command:
DEFINE LISTENER(PS3_LS) TRPTYPE(TCP) CONTROL(QMGR) PORT(5002)

c. Start the listener.
Enter the following MQSC command:
START LISTENER(PS3_LS)

2. Define a receiver channel for PS3, to allow other queue managers in the cluster to communicate with
it.
Enter the following MQSC command:
DEFINE CHANNEL(DEMO.PS3) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5002)’) CLUSTER(DEMO)

DESCR(’TCP Cluster-receiver channel for queue manager PS3’)

3. Define a sender channel from PS3 to one of the full repository queue managers (for example, PS1 ).
This joins PS3 into the cluster.
Enter the following MQSC command:
DEFINE CHANNEL(DEMO.PS1) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’$HOSTNAME(5000)’) CLUSTER(DEMO)

DESCR(’TCP Cluster-sender channel from PS3 to PS1’)

4. Validate that PS3 has successfully joined the cluster.
Enter the following MQSC command:
DISPLAY CLUSQMGR(*) QMTYPE

This command returns three entries, one each for QM1, QM2 and QM3. QM1 and QM2 should have a QMTYPE
of REPOS, and QM3 should have a QMTYPE of NORMAL.

What to do next

You are now ready to define a cluster topic.
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Defining cluster topics
Publishing and subscribing applications can publish to any topic string, with no need for an administered
topic object to be defined. However, if the publishing applications are connected to a cluster queue
manager that is different to the queue managers where subscriptions are created, an administered topic
object must be defined and added to the cluster. To make a topic a cluster topic, you specify the name of
the cluster in its definition.

Before you begin

This task assumes that you have completed the steps in “Configuring the third queue manager” on page
32.

About this task

The administered topic object identifies the point in the topic tree that is clustered through its topic
string. Publishing and subscribing applications can use any topic string at or below that point, and their
messages are automatically transmitted between queue managers.

When you define a cluster topic, you also choose its routing model. For more information about
publication routing in clusters, see Designing publish/subscribe clusters.

For this scenario we use the default routing of DIRECT. This means that messages are sent direct from a
publishing queue manager to the subscribing queue managers.

Procedure
1. Define the cluster topic SCORES on PS3.

To make the topic a cluster topic, specify the name of the cluster, and set the cluster routing ( CLROUTE
) that you want to use for publications and subscriptions for this topic.
a. Launch the MQSC interface.

In the command line, enter the following command:
runmqsc PS3

b. Define the cluster topic SCORES.
Enter the following MQSC command:
DEFINE TOPIC(SCORES) TOPICSTR(’/Sport/Scores’) CLUSTER(DEMO) CLROUTE(DIRECT)

c. Enter end to exit the MQSC interface for PS3.
2. Verify the topic definition on PS1.

a. Launch the MQSC interface for PS1.
In the command line, enter the following command:
runmqsc PS1

b. Display the cluster state for cluster topic SCORES.
Enter the following MQSC command:
DISPLAY TCLUSTER(SCORES) CLSTATE

The CLSTATE for cluster topic SCORES is shown as ACTIVE.

What to do next

For a more detailed exploration of this task, see Configuring a publish/subscribe cluster.

You are now ready to verify the solution. See “Testing the publish/subscribe cluster” on page 34.
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Testing the publish/subscribe cluster
Test the publish/subscribe cluster by publishing and subscribing to a topic string from different queue
managers in the cluster.

Before you begin

This task assumes that you have completed the steps in“Defining cluster topics” on page 33.

About this task

Using the command line, and the amqspub and amqssub sample applications that are included with IBM
MQ , you can publish a topic from one queue manager and subscribe to the topic with the other queue
managers. When a message is published to the topic, it is received by the subscribing queue managers.

Procedure
1. In the command line, enter the following command:

amqspub /Sport/Scores/Football PS1

2. Concurrently, in separate command lines, enter the following commands:
amqssub /Sport/Scores/Football PS2

amqssub /Sport/Scores/Football PS3

3. In the first command line, enter a message. The message is displayed in both the subscribing
command lines.

Note: The amqssub application will time out if a publication is not received for ten seconds.

Results

The publish/subscribe cluster set up is complete.

What to do next

Try defining different topic objects for different branches of the topic tree, and with different routing
models.

Publish/subscribe hierarchy scenarios
Three scenarios that demonstrate use of publish/subscribe hierarchies. Each of the three scenarios sets up
the same simple publish/subscribe topology. In each scenario, the queue managers rely on a different
method for connecting to their neighboring queue managers in the hierarchy.

The available publish/subscribe hierarchy scenarios are described in the following subtopics:
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Related information:
Publish/subscribe hierarchies

Publish/subscribe hierarchy scenario 1: Using point-to-point channels with queue
manager name alias
This is the first in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with queue manager name alias.

About this task

This set of scenarios all use a parent queue manager called QM1, and two child queue managers called
QM2, and QM3.

Scenario 1 is split into smaller sections to make the process easier to follow.

QM1

Parent

Publish/subscribe hierarchy

Children

SDR

9999

SDR

7777

SDR

8888

SDR

9999

RCVR RCVR

RCVRRCVR
QM2 QM3

Figure 3. Topology diagram showing the relationship between queue managers in a typical publisher/subscribe
hierarchy.
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Scenario 1 part 1: Create the queue managers:
Procedure

1. Create and start three queue managers called QM1, QM2, and QM3 using the following commands:
crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM1
strmqm QM1

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM2
strmqm QM2

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM3
strmqm QM3

2. Enable the queue manager publish/subscribe mode by using the following command on all three
queue managers:
ALTER QMGR PSMODE(ENABLED)

Scenario 1 part 2: Point-to-point channel connections:
About this task

Establish point-to-point channel connections between queue managers using a queue manager alias with
the same name as the parent queue manager.

Procedure

1. Define a transmission queue and queue manager alias on QM2 to QM1. Define a sender channel to QM1
and a receiver channel for the sender channel created on QM1 for QM2:
DEFINE QLOCAL(QM1.XMITQ) USAGE(XMITQ)

DEFINE QREMOTE (QM1) RNAME(’’) RQMNAME(QM1) XMITQ(QM1.XMITQ)

DEFINE CHANNEL(’QM2.TO.QM1’) CHLTYPE(SDR) CONNAME(’localhost(9999)’) XMITQ(QM1.XMITQ) TRPTYPE(TCP)

DEFINE CHANNEL(’QM1.TO.QM2’) CHLTYPE(RCVR) TRPTYPE(TCP)

2. Define a transmission queue and queue manager alias on QM3 to QM1. Define sender channel to QM1
and a receiver channel for the sender channel created on QM1 for QM3:
DEFINE QLOCAL(QM1.XMITQ) USAGE(XMITQ)

DEFINE QREMOTE (QM1) RNAME(’’) RQMNAME(QM1) XMITQ(QM1.XMITQ)

DEFINE CHANNEL(’QM3.TO.QM1’) CHLTYPE(SDR) CONNAME(’localhost(9999)’) XMITQ(QM1.XMITQ) TRPTYPE(TCP)

DEFINE CHANNEL(’QM1.TO.QM3’) CHLTYPE(RCVR) TRPTYPE(TCP)

3. Define a transmission queue and queue manager alias on QM1 to QM2 and QM3. Define sender channel
to QM2 and QM3, and a receiver channel for the sender channels created on QM2 and QM3 for QM1:
DEFINE QLOCAL(QM2.XMITQ) USAGE(XMITQ)

DEFINE QREMOTE (QM2) RNAME(’’) RQMNAME(QM2) XMITQ(QM2.XMITQ)

DEFINE CHANNEL(’QM1.TO.QM2’) CHLTYPE(SDR) CONNAME(’localhost(7777)’) XMITQ(QM2.XMITQ) TRPTYPE(TCP)

DEFINE CHANNEL(’QM2.TO.QM1’) CHLTYPE(RCVR) TRPTYPE(TCP)

DEFINE QLOCAL(QM3.XMITQ) USAGE(XMITQ)

DEFINE QREMOTE (QM3) RNAME(’’) RQMNAME(QM3) XMITQ(QM3.XMITQ)

DEFINE CHANNEL(’QM1.TO.QM3’) CHLTYPE(SDR) CONNAME(’localhost(8888)’) XMITQ(QM3.XMITQ) TRPTYPE(TCP)

DEFINE CHANNEL(’QM3.TO.QM1’) CHLTYPE(RCVR) TRPTYPE(TCP)

4. Start the appropriate listeners on the queue managers:
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runmqlsr -m QM1 -t TCP -p 9999 &
runmqlsr -m QM2 -t TCP -p 7777 &
runmqlsr -m QM3 -t TCP -p 8888 &

5. Start the following channels:
a. On QM1:

START CHANNEL(’QM1.TO.QM2’)

START CHANNEL(’QM1.TO.QM3’)

b. On QM2:
START CHANNEL(’QM2.TO.QM1’)

c. On QM3:
START CHANNEL(’QM3.TO.QM1’)

6. Check that all the channels have started:
DISPLAY CHSTATUS(’QM1.TO.QM2’)

DISPLAY CHSTATUS(’QM1.TO.QM3’)

DISPLAY CHSTATUS(’QM2.TO.QM1’)

DISPLAY CHSTATUS(’QM3.TO.QM1’)

Scenario 1 part 3: Connect queue managers and define a topic:
About this task

Connect the child queue managers QM2 and QM3 to the parent queue manager QM1.

Procedure

1. On QM2 and QM3, set the parent queue manager to QM1:
ALTER QMGR PARENT (QM1)

2. Run the following command on all queue managers to check that the child queue managers are
connected to the parent queue manager:
DISPLAY PUBSUB TYPE(ALL)

Command output is displayed. For example, here is output for QM1, with the key details highlighted:
DISPLAY PUBSUB ALL
1 : DISPLAY PUBSUB ALL
AMQ8723: Display pub/sub status details.
QMNAME(QM1) TYPE(LOCAL)
STATUS(ACTIVE) SUBCOUNT(6)
TPCOUNT(9)
AMQ8723: Display pub/sub status details.
QMNAME(QM2) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)
AMQ8723: Display pub/sub status details.
QMNAME(QM3) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)

Scenario 1 part 4: Publish and subscribe the topic:
About this task

Use the amqspub.exe and amqssub.exe applications to publish and subscribe the topic.

Procedure

1. Run this command in the first command window:
amqspub Sport/Soccer QM2
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2. Run this command in the second command window:
amqssub Sport/Soccer QM1

3. Run this command in the third command window:
amqssub Sport/Soccer QM3

Results

The amqssub.exe applications in the second and third command windows receive the messages published
in the first command window.
Related tasks:
“Publish/subscribe hierarchy scenario 2: Using point-to-point channels with same name for transmission
queue and remote queue manager”
This is the second in a set of three scenarios that set up a publish/subscribe hierarchy in different ways
to establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with the transmission queue name the same as the remote queue
manager.
“Publish/subscribe hierarchy scenario 3: Using a cluster channel to add a queue manager” on page 41
This is the third in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario uses a cluster channel to add a queue
manager to a hierarchy.
Related information:
Connecting a queue manager to a publish/subscribe hierarchy

Publish/subscribe hierarchy scenario 2: Using point-to-point channels with same
name for transmission queue and remote queue manager
This is the second in a set of three scenarios that set up a publish/subscribe hierarchy in different ways
to establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with the transmission queue name the same as the remote queue
manager.

About this task

This set of scenarios all use a parent queue manager called QM1, and two child queue managers called
QM2, and QM3.

Scenario 2 is split into smaller sections to make the process easier to follow. This scenario reuses Scenario
1 part 1, Scenario 1 part 3, and Scenario 1 part 4 from “Publish/subscribe hierarchy scenario 1: Using
point-to-point channels with queue manager name alias” on page 35.
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Scenario 2 part 1: Create queue manager and set PSMODE:
Procedure

1. Create and start three queue managers called QM1, QM2, and QM3 using the following commands:
crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM1
strmqm QM1

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM2
strmqm QM2

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM3
strmqm QM3

2. Enable the queue manager publish/subscribe mode by using the following command on all three
queue managers:
ALTER QMGR PSMODE(ENABLED)

Scenario 2 part 2: Point-to-point channel connections:
About this task

Establish point-to-point channel connections between a queue manager using a transmission queue with
the same name as the parent queue manager.

Procedure

1. Define a transmission queue on QM2 to QM1. Define a sender channel to QM1 and a receiver channel for
the sender channel for QM2 created on QM1:
DEFINE QLOCAL(QM1) USAGE(XMITQ)

DEFINE CHANNEL(’QM2.TO.QM1’) CHLTYPE(SDR) CONNAME(’localhost(9999)’) XMITQ(QM1) TRPTYPE(TCP)

DEFINE CHANNEL(’QM1.TO.QM2’) CHLTYPE(RCVR) TRPTYPE(TCP)

2. Define a transmission queue on QM3 to QM1. Define sender channel to QM1 and a receiver channel for
the sender channel created on QM1 for QM3:

QM1

Parent

Publish/subscribe hierarchy

Children

SDR

9999

SDR

7777

SDR

8888

SDR

9999

RCVR RCVR

RCVRRCVR
QM2 QM3

Figure 4. Topology diagram showing the relationship between queue managers in a typical publisher/subscribe
hierarchy.

Scenarios 39



DEFINE QLOCAL(QM1) USAGE(XMITQ)

DEFINE CHANNEL(’QM3.TO.QM1’) CHLTYPE(SDR) CONNAME(’localhost(9999)’) XMITQ(QM1) TRPTYPE(TCP)

DEFINE CHANNEL(’QM1.TO.QM3’) CHLTYPE(RCVR) TRPTYPE(TCP)

3. Define transmission queues on QM1 to QM2 and QM3. Define sender channels to QM2 and QM3, and a
receiver channel for the sender channels created on QM2 and QM3 for QM1:
DEFINE QLOCAL(QM2) USAGE(XMITQ)

DEFINE CHANNEL(’QM1.TO.QM2’) CHLTYPE(SDR) CONNAME(’localhost(7777)’) XMITQ(QM2) TRPTYPE(TCP)

DEFINE CHANNEL(’QM2.TO.QM1’) CHLTYPE(RCVR) TRPTYPE(TCP)

DEFINE QLOCAL(QM3) USAGE(XMITQ)

DEFINE CHANNEL(’QM1.TO.QM3’) CHLTYPE(SDR) CONNAME(’localhost(8888)’) XMITQ(QM3) TRPTYPE(TCP)

DEFINE CHANNEL(’QM3.TO.QM1’) CHLTYPE(RCVR) TRPTYPE(TCP)

4. Start the appropriate listeners on the queue managers:
runmqlsr -m QM1 -t TCP -p 9999 &
runmqlsr -m QM2 -t TCP -p 7777 &
runmqlsr -m QM3 -t TCP -p 8888 &

5. Start the following channels:
a. On QM1:

START CHANNEL(’QM1.TO.QM2’)

START CHANNEL(’QM1.TO.QM3’)

b. On QM2:
START CHANNEL(’QM2.TO.QM1’)

c. On QM3:
START CHANNEL(’QM3.TO.QM1’)

6. Check that all the channels have started:
DISPLAY CHSTATUS(’QM1.TO.QM2’)

DISPLAY CHSTATUS(’QM1.TO.QM3’)

DISPLAY CHSTATUS(’QM2.TO.QM1’)

DISPLAY CHSTATUS(’QM3.TO.QM1’)

Scenario 2 part 3: Connect queue managers and define a topic:
About this task

Connect the child queue managers QM2 and QM3 to the parent queue manager QM1.

Procedure

1. On QM2 and QM3, set the parent queue manager to QM1:
ALTER QMGR PARENT (QM1)

2. Run the following command on all queue managers to check that the child queue managers are
connected to the parent queue manager:
DISPLAY PUBSUB TYPE(ALL)

Command output is displayed. For example, here is output for QM1, with the key details highlighted:
DISPLAY PUBSUB ALL
1 : DISPLAY PUBSUB ALL
AMQ8723: Display pub/sub status details.
QMNAME(QM1) TYPE(LOCAL)
STATUS(ACTIVE) SUBCOUNT(6)
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TPCOUNT(9)
AMQ8723: Display pub/sub status details.
QMNAME(QM2) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)
AMQ8723: Display pub/sub status details.
QMNAME(QM3) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)

Scenario 2 part 4: Publish and subscribe the topic:
About this task

Use the amqspub.exe and amqssub.exe applications to publish and subscribe the topic.

Procedure

1. Run this command in the first command window:
amqspub Sport/Soccer QM2

2. Run this command in the second command window:
amqssub Sport/Soccer QM1

3. Run this command in the third command window:
amqssub Sport/Soccer QM3

Results

The amqssub.exe applications in the second and third command windows receive the messages published
in the first command window.
Related tasks:
“Publish/subscribe hierarchy scenario 1: Using point-to-point channels with queue manager name alias”
on page 35
This is the first in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with queue manager name alias.
“Publish/subscribe hierarchy scenario 3: Using a cluster channel to add a queue manager”
This is the third in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario uses a cluster channel to add a queue
manager to a hierarchy.
Related information:
Connecting a queue manager to a publish/subscribe hierarchy

Publish/subscribe hierarchy scenario 3: Using a cluster channel to add a queue
manager
This is the third in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario uses a cluster channel to add a queue
manager to a hierarchy.

About this task

This set of scenarios all use a parent queue manager called QM1, and two child queue managers called
QM2, and QM3.

Note: This scenario is only using the cluster configuration to connect queue managers together, not to
propagate publish/subscribe traffic through clustering topics. When defining child/parent hierarchy
relationships between queue managers in the same cluster, propagation of publications between queue
managers will occur based on the publication and subscription scope settings of the topics in the topic
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tree. It is important not to use the cluster name setting of a topic to add the topics into the cluster. If
using the cluster name, the topology becomes a publish/subscribe cluster and does not require the
child/parent hierarchy relationships defined. See “Publish/subscribe cluster scenario” on page 29 and
Planning your distributed publish/subscribe network.

Scenario 3 is split into smaller sections to make the process easier to follow. This scenario reuses Scenario
1 part 1, Scenario 1 part 3, and Scenario 1 part 4 from “Publish/subscribe hierarchy scenario 1: Using
point-to-point channels with queue manager name alias” on page 35.

This scenario creates a cluster called DEMO where QM1 and QM2 are full repositories, and QM3 is a partial
repository. Queue manager QM1 is the parent of queue managers QM2 and QM3.

Scenario 3 part 1: Create queue manager and set PSMODE:
Procedure

1. Create and start three queue managers called QM1, QM2, and QM3 using the following commands:
crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM1
strmqm QM1

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM2
strmqm QM2

crtmqm -u SYSTEM.DEAD.LETTER.QUEUE QM3
strmqm QM3

2. Enable the queue manager publish/subscribe mode by using the following command on all three
queue managers:
ALTER QMGR PSMODE(ENABLED)

Scenario 3 part 2: Point-to-point channel connections:
About this task

Establish point-to-point channel connections between queue managers a cluster.

QM1
Full repos

Parent

Publish/subscribe hierarchy
using clustering

Children

CLUSRCVR    9999

CLUSRCVR
8888

CLUSRCVR
7777

Auto-defined channel

Auto-defined
channel

CLUSSDR
7777CLUSSDR

9999
CLUSSDR

9999

QM2
Full repos

QM3
Partial repos

Figure 5. Topology diagram showing the relationship between queue managers that are using a cluster channel.
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Procedure

1. On QM1 and QM2, set the REPOS parameter to the name of the cluster DEMO:
ALTER QMGR REPOS(DEMO)

2. Start the appropriate listeners on the queue managers:
runmqlsr -m QM1 -t TCP -p 9999 &
runmqlsr -m QM2 -t TCP -p 7777 &
runmqlsr -m QM3 -t TCP -p 8888 &

3. Define the cluster receiver channel on each queue manager:
a. On QM1:

DEFINE CHANNEL(TO.QM1) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’localhost(9999)’) CLUSTER(DEMO)

b. On QM2:
DEFINE CHANNEL(TO.QM2) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’localhost(7777)’) CLUSTER(DEMO)

c. On QM3:
DEFINE CHANNEL(TO.QM3) CHLTYPE(CLUSRCVR) TRPTYPE(TCP) CONNAME(’localhost(8888)’) CLUSTER(DEMO)

4. Define a cluster sender channel to a full repository on each queue manager in the cluster:
a. On QM1:

DEFINE CHANNEL(TO.QM2) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’localhost(7777)’) CLUSTER(DEMO)

b. On QM2:
DEFINE CHANNEL(TO.QM1) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’localhost(9999)’) CLUSTER(DEMO)

c. QM3 can have a cluster sender channel to either full repository on QM1 or QM2. This example defines
the channel to QM1:
DEFINE CHANNEL(TO.QM1) CHLTYPE(CLUSSDR) TRPTYPE(TCP) CONNAME(’localhost(9999)’) CLUSTER(DEMO)

Scenario 3 part 3: Connect queue managers and define a topic:
About this task

Connect the child queue managers QM2 and QM3 to the parent queue manager QM1.

Procedure

1. On QM2 and QM3, set the parent queue manager to QM1:
ALTER QMGR PARENT (QM1)

2. Run the following command on all queue managers to check that the child queue managers are
connected to the parent queue manager:
DISPLAY PUBSUB TYPE(ALL)

Command output is displayed. For example, here is output for QM1, with the key details highlighted:
DISPLAY PUBSUB ALL
1 : DISPLAY PUBSUB ALL
AMQ8723: Display pub/sub status details.
QMNAME(QM1) TYPE(LOCAL)
STATUS(ACTIVE) SUBCOUNT(6)
TPCOUNT(9)
AMQ8723: Display pub/sub status details.
QMNAME(QM2) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)
AMQ8723: Display pub/sub status details.
QMNAME(QM3) TYPE(CHILD)
STATUS(ACTIVE) SUBCOUNT(NONE)
TPCOUNT(NONE)

Scenario 3 part 4: Publish and subscribe the topic:
About this task

Use the amqspub.exe and amqssub.exe applications to publish and subscribe the topic.
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Procedure

1. Run this command in the first command window:
amqspub Sport/Soccer QM2

2. Run this command in the second command window:
amqssub Sport/Soccer QM1

3. Run this command in the third command window:
amqssub Sport/Soccer QM3

Results

The amqssub.exe applications in the second and third command windows receive the messages published
in the first command window.
Related tasks:
“Publish/subscribe hierarchy scenario 1: Using point-to-point channels with queue manager name alias”
on page 35
This is the first in a set of three scenarios that set up a publish/subscribe hierarchy in different ways to
establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with queue manager name alias.
“Publish/subscribe hierarchy scenario 2: Using point-to-point channels with same name for transmission
queue and remote queue manager” on page 38
This is the second in a set of three scenarios that set up a publish/subscribe hierarchy in different ways
to establish the connection between queue managers. This scenario sets up a publish/subscribe hierarchy
that uses point-to-point channels with the transmission queue name the same as the remote queue
manager.
Related information:
Connecting a queue manager to a publish/subscribe hierarchy

Transactional support scenarios
Using transactional support you can enable your applications to work reliably with databases.

This section introduces transactional support. The work required to enable your applications to use IBM
MQ with a database product spans the areas of application programming and system administration. Use
the information here together with Committing and backing out units of work.

We start by introducing the units of work that form transactions, then describe the ways in which you
enable IBM MQ to coordinate transactions with databases.
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Related concepts:
“Introducing units of work”
This topic introduces and defines the general concepts of unit of work, commit, backout and sync point.
It also contains two scenarios that illustrate global units of work.
Related information:

IBM MQ and HP NonStop TMF

Introducing units of work
This topic introduces and defines the general concepts of unit of work, commit, backout and sync point.
It also contains two scenarios that illustrate global units of work.

When a program puts messages on queues within a unit of work, those messages are made visible to
other programs only when the program commits the unit of work. To commit a unit of work, all updates
must be successful to preserve data integrity.

If the program detects an error and decides not to make the put operation permanent, it can back out the
unit of work. When a program performs a backout, IBM MQ restores the queues by removing the
messages that were put on the queues by that unit of work.

Similarly, when a program gets messages from one or more queues within a unit of work, those messages
remain on the queues until the program commits the unit of work, but the messages are not available to
be retrieved by other programs. The messages are permanently deleted from the queues when the
program commits the unit of work. If the program backs out the unit of work, IBM MQ restores the
queues by making the messages available to be retrieved by other programs.

The decision to commit or back out the changes is taken, in the simplest case, at the end of a task.
However, it can be more useful for an application to synchronize data changes at other logical points
within a task. These logical points are called sync points (or synchronization points) and the period of
processing a set of updates between two sync points is called a unit of work. Several MQGET calls and
MQPUT calls can be part of a single unit of work.

With IBM MQ, we need to distinguish between local and global units of work:

Local units of work
Are those in which the only actions are puts to, and gets from, IBM MQ queues, and the
coordination of each unit of work is provided within the queue manager using a single-phase
commit process.

Use local units of work when the only resources to be updated are the queues that are managed
by a single IBM MQ queue manager. Updates are committed by using the MQCMIT verb or
backed out using MQBACK.

There are no system administration tasks, other than log management, which is involved in using
local units of work. In your applications, where you use the MQPUT and MQGET calls with
MQCMIT and MQBACK, try using the MQPMO_SYNCPOINT and MQGMO_SYNCPOINT
options. (For information about log management, see Managing log files.)

Global units of work
Are those in which other resources, such as tables in a relational database, are also updated.
When more than one resource manager is involved, there is a need for transaction manager software
that uses a two-phase commit process to coordinate the global unit of work.

Use global units of work when you also need to include updates to relational database manager
software, such as DB2®, Oracle, Sybase, and Informix®.

There are several possible scenarios for using global units of work. Documented here are two
scenarios:
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1. In the first, the queue manager itself acts as the transaction manager. In this scenario, MQI
verbs control the global units of work; they are started in applications using the MQBEGIN
verb and then committed using MQCMIT or backed out using MQBACK.

2. In the second, the transaction manager role is performed by other software, such as TXSeries®,
Encina, or Tuxedo. In this scenario, an API provided by the transaction manager software is
used to control the unit of work (for example, EXEC CICS® SYNCPOINT for TXSeries ).

The following sections describe all the steps necessary to use global units of work, organized by
the two scenarios:
v Scenario 1: Queue manager performs the coordination
v “Scenario 2: Other software provides the coordination” on page 71

Scenario 1: Queue manager performs the coordination

In scenario 1, the queue manager acts as the transaction manager. In this scenario, MQI verbs control the
global units of work; they are started in applications using the MQBEGIN verb and then committed using
MQCMIT or backed out using MQBACK.

Isolation level

In IBM MQ, a message on a queue might be visible before a database update, depending on the
transaction isolation design implemented within the database.

When an IBM MQ queue manager is working as an XA transaction manager, to coordinate updates to XA
resource managers, the following commit protocol is followed:
1. Prepare all XA resource managers.
2. Commit the IBM MQ queue manager resource manager.
3. Commit other resource managers.

Between step 2 and 3, an application might see a message that is committed to the queue but the
corresponding row in the database does not reflect this message.

This is not a problem if the database is configured such that the application's database API calls wait for
pending updates to be completed.

You can resolve this by configuring the database differently. The type of configuration needed is referred
to as the "isolation level". For more information on isolation levels, refer to the database documentation.
You can, alternatively, configure the queue manager to commit the resource managers in the following
reverse order:
1. Prepare all XA resource managers.
2. Commit other resource managers.
3. Commit the IBM MQ queue manager resource manager.

When you change the protocol the IBM MQ queue manager is committed last, so applications that read
messages from the queues see a message only after the corresponding database update has been
completed.

To configure the queue manager to use this changed protocol, set the AMQ_REVERSE_COMMIT_ORDER
environment variable.

Set this environment variable in the environment from which the strmqm is run to start the queue
manager. For example, run the following in the shell just before starting the queue manager:
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export AMQ_REVERSE_COMMIT_ORDER=1

Note: Setting this environment variable might cause an extra log entry per transaction, so this will have a
small impact on the performance of each transaction.

Database coordination

When the queue manager coordinates global units of work itself, it becomes possible to integrate
database updates within the units of work. That is, a mixed MQI and SQL application can be written,
and the MQCMIT and MQBACK verbs can be used to commit or roll back the changes to the queues and
databases together.

The queue manager achieves this using the two-phase commit protocol described in X/Open Distributed
Transaction Processing: The XA Specification. When a unit of work is to be committed, the queue manager
first asks each participating database manager whether it is prepared to commit its updates. Only if all
the participants, including the queue manager itself, are prepared to commit, are all the queue and
database updates committed. If any participant cannot prepare its updates, the unit of work is backed out
instead.

In general, a global unit of work is implemented in an application by the following method (in
pseudocode):

MQBEGIN
MQGET (include the flag MQGMO_SYNCPOINT in the message options)
MQPUT (include the flag MQPMO_SYNCPOINT in the message options)
SQL INSERT
MQCMIT

The purpose of MQBEGIN is to denote the beginning of a global unit of work. The purpose of MQCMIT
is to denote the end of the global unit of work, and to complete it with all participating resource
managers, using the two-phase commit protocol.

When the unit of work (also known as a transaction ) is completed successfully using MQCMIT, all
actions taken within that unit of work are made permanent or irreversible. If, for any reason, the unit of
work fails, all actions are instead backed out. It is not possible for one action in a unit of work to be
made permanent while another is backed out. This is the principle of a unit of work: either all actions
within the unit of work are made permanent or none of them are.

Note:

1. The application programmer can force a unit of work to be backed out by calling MQBACK. The unit
of work is also backed out by the queue manager if the application or database fails before MQCMIT
is called.

2. If an application calls MQDISC without calling MQCMIT, the queue manager behaves as if MQCMIT
had been called, and commits the unit of work.

In between MQBEGIN and MQCMIT, the queue manager does not make any calls to the database to
update its resources. That is, the only way a database's tables are changed is by your code (for example,
the SQL INSERT in the pseudocode).

Full recovery support is provided if the queue manager loses contact with any of the database managers
during the commit protocol. If a database manager becomes unavailable while it is in doubt, that is, it
has successfully prepared to commit, but has yet to receive a commit or backout decision, the queue
manager remembers the outcome of the unit of work until that outcome has been successfully delivered
to the database. Similarly, if the queue manager terminates with incomplete commit operations
outstanding, these are remembered over queue manager restart. If an application terminates
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unexpectedly, the integrity of the unit of work is not compromised, but the outcome depends on where in
the process the application terminated, as described in Table 2.

What happens when the database or application program fails is summarized in the following tables:

Table 1. What happens when a database server fails

Failure occurrence Outcome

Before the application call to MQCMIT. The unit of work is backed out.

During the application call to MQCMIT, before all
databases have indicated that they have successfully
prepared.

The unit of work is backed out with a reason code of
MQRC_BACKED_OUT.

During the application call to MQCMIT, after all
databases have indicated that they have successfully
prepared, but before all have indicated that they have
successfully committed.

The unit of work is held in recoverable state by the
queue manager, with a reason code of
MQRC_OUTCOME_PENDING.

During the application call to MQCMIT, after all
databases have indicated that they have successfully
committed.

The unit of work is committed with a reason code of
MQRC_NONE.

After the application call to MQCMIT. The unit of work is committed with a reason code of
MQRC_NONE.

Table 2. What happens when an application program fails

Failure occurrence Outcome

Before the application call to MQCMIT. The unit of work is backed out.

During the application call to MQCMIT, before the queue
manager has received the application's MQCMIT request.

The unit of work is backed out.

During the application call to MQCMIT, after the queue
manager has received the application's MQCMIT request.

The queue manager tries to commit using two-phase
commit (subject to the database products successfully
executing and committing their parts of the unit of
work).

In the case where the reason code on return from MQCMIT is MQRC_OUTCOME_PENDING, the unit of
work is remembered by the queue manager until it has been able to reestablish contact with the database
server, and tell it to commit its part of the unit of work. Refer to “Considerations when contact is lost
with the XA resource manager” on page 64 for information on how and when recovery is done.

The queue manager communicates with database managers using the XA interface as described in X/Open
Distributed Transaction Processing: The XA Specification. Examples of these function calls are xa_open,
xa_start, xa_end, xa_prepare, and xa_commit. We use the terms transaction manager and resource manager
in the same sense as they are used in the XA specification.

48 IBM MQ: Scenarios



Restrictions:

There are restrictions to the database coordination support.

The following restrictions apply:
v The ability to coordinate database updates within IBM MQ units of work is not supported in an MQI

client application. The use of MQBEGIN in a client application fails. A program that calls MQBEGIN
must run as a server application on the same machine as the queue manager.

Note: A server application is a program that has been linked with the necessary IBM MQ server
libraries; a client application is a program that has been linked with the necessary IBM MQ client
libraries. See Building applications for IBM MQ MQI clients and Building a procedural application for
details on compiling and linking programs that you write in a procedural language.

v The database server can reside on a different machine from the queue manager server, as long as the
database client is installed on the same machine as the queue manager, and it supports this function.
Consult the database product's documentation to determine whether their client software can be used
for two-phase commit systems.

v Although the queue manager behaves as a resource manager (for the purposes of being involved in
Scenario 2 global units of work), it is not possible to make one queue manager coordinate another
queue manager within its Scenario 1 global units of work.

Switch load files:

The switch load file is a shared library (a DLL on Windows systems) that is loaded by the code in your
IBM MQ application and the queue manager. Its purpose is to simplify the loading of the database's
client shared library, and to return the pointers to the XA functions.

The details of the switch load file must be specified before the queue manager is started. The details are
placed in the qm.ini file on Windows, UNIX and Linux systems.
v On Windows and Linux (x86 and x86-64 platforms) systems, use the IBM MQ Explorer to update the

qm.ini file.
v On all other systems edit the file, qm.ini, directly.

The C source for the switch load file is supplied with the IBM MQ installation if it supports Scenario 1
global units of work. The source contains a function called MQStart. When the switch load file is loaded,
the queue manager calls this function, which returns the address of a structure called an XA switch.

The XA switch structure exists in the database client shared library, and contains a number of function
pointers, as described in Table 3:

Table 3. XA switch function pointers

Function pointer name XA function Purpose

xa_open_entry xa_open Connect to database

xa_close_entry xa_close Disconnect from database

xa_start_entry xa_start Start a branch of a global unit of
work

xa_end_entry xa_end Suspend a branch of a global unit of
work

xa_rollback_entry xa_rollback Roll back a branch of a global unit of
work

xa_prepare_entry xa_prepare Prepare to commit a branch of a
global unit of work
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Table 3. XA switch function pointers (continued)

Function pointer name XA function Purpose

xa_commit_entry xa_commit Commit a branch of a global unit of
work

xa_recover_entry xa_recover Discover from the database whether
it has an in-doubt unit of work

xa_forget_entry xa_forget Allow a database to forget a branch
of a global unit of work

xa_complete_entry xa_complete Complete a branch of a global unit of
work

During the first MQBEGIN call in your application, the IBM MQ code that executes as part of MQBEGIN
loads the switch load file, and calls the xa_open function in the database shared library. Similarly, during
queue manager startup, and on other subsequent occasions, some queue manager processes load the
switch load file and call xa_open.

You can reduce the number of xa_* calls by using dynamic registration. For a complete description of this
optimization technique, see “XA dynamic registration” on page 69.

Configuring your system for database coordination:

There are several tasks that you must perform before a database manager can participate in global units
of works coordinated by the queue manager. These are described here as follows:
v “Installing and configuring the database product”
v “Creating switch load files” on page 51
v “Adding configuration information to the queue manager” on page 52
v “Writing and modifying your applications” on page 53
v “Testing the system” on page 54

Installing and configuring the database product:

To install and configure your database product, see the product's own documentation. This topics in this
section describe general configuration issues and how they relate to interoperation between IBM MQ and
the database.

Database connections

An application that establishes a standard connection to the queue manager is associated with a thread in
a separate local queue manager agent process. (A connection that is not a fastpath connection is a standard
connection in this context. See Connecting to a queue manager using the MQCONNX call.)

When the application issues MQBEGIN, both it and the agent process call the xa_open function in the
database client library. In response to this, the database client library code connects to the database that is
to be involved in the unit of work from both the application and queue manager processes. These database
connections are maintained as long as the application remains connected to the queue manager.

This is an important consideration if the database supports only a limited number of users or
connections, because two connections are being made to the database to support the one application
program.
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Client/server configuration

The database client library that is loaded into the IBM MQ queue manager and application processes
must be able to send to and receive from its server. Ensure that:
v The database's client/server configuration files have the correct details
v The relevant environment variables are set in the environment of the queue manager and the

application processes

Creating switch load files:

IBM MQ comes with a sample makefile, used to build switch load files for the supported database
managers.

MQ_INSTALLATION_PATH represents the high-level directory in which IBM MQ is installed.

The sample makefile, together with all the associated C source files required to build the switch load
files, is installed in the following directories:
v For IBM MQ for Windows, in the MQ_INSTALLATION_PATH\tools\c\samples\xatm\ directory
v For IBM MQ for UNIX and Linux systems, in the MQ_INSTALLATION_PATH/samp/xatm/ directory

The sample source modules used to build the switch load files are:
v For Db2, db2swit.c
v For Oracle, oraswit.c
v For Informix, infswit.c
v For Sybase, sybswit.c

When you generate switch load files, install 32-bit switch load files in /var/mqm/exits and install 64-bit
switch load files in /var/mqm/exits64.

Note: This switch load file is used by IBM MQ C applications. For Java applications, see JTA/JDBC
coordination using IBM MQ classes for Java.

If you have 32-bit queue managers then the sample make file, xaswit.mak, installs a 32-bit switch load file
in /var/mqm/exits.

If you have 64-bit queue managers then the sample make file, xaswit.mak, installs a 32-bit switch load file
in /var/mqm/exits, and a 64-bit switch load file in /var/mqm/exits64.

File security

It is possible that your operating system might fail the loading of the switch load file by IBM MQ, for
reasons outside the control of IBM MQ. If this occurs, error messages are written to the IBM MQ error
logs, and potentially the MQBEGIN call can fail. To help to ensure that your operating system does not
fail the loading of the switch load file, you must fulfil the following requirements:
1. The switch load file must be available in the location that is given in the qm.ini file.
2. The switch load file must be accessible to all processes that need to load it, including the queue

manager processes and application processes.
3. All of the libraries upon which the switch load file depends, including the libraries that are provided

by the database product, must be present and accessible.
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Adding configuration information to the queue manager:

When you have created a switch load file for your database manager, and placed it in a safe location, you
must specify that location to your queue manager.

To specify the location, perform the following steps:
v On Windows and Linux (x86 and x86-64 platforms) systems use the IBM MQ Explorer. Specify the

details of the switch load file in the queue manager properties panel, under XA resource manager.
v On all other systems specify the details of the switch load file in the XAResourceManager stanza in the

queue manager's qm.ini file.

Add an XAResourceManager stanza for the database that your queue manager is going to coordinate.
The most common case is for there to be only one database, and therefore only one XAResourceManager
stanza. For details of more complicated configurations involving multiple databases, see “Multiple
database configurations” on page 63. The attributes of the XAResourceManager stanza are as follows:

Name=name
User-chosen string that identifies the resource manager. In effect, it gives a name to the
XAResourceManager stanza. The name is mandatory and can be up to 31 characters in length.

The name you choose must be unique; there must be only one XAResourceManager stanza with this
name in this qm.ini file. The name should also be meaningful, because the queue manager uses it to
refer to this resource manager both in queue manager error log messages and in output when the
dspmqtrn command is used. (See “Displaying outstanding units of work with the dspmqtrn
command” on page 65 for more information.)

Once you have chosen a name, and have started the queue manager, do not change the Name
attribute. For more details about changing configuration information, see “Changing configuration
information” on page 68.

SwitchFile=name
This is the name of the XA switch load file you built earlier. This is a mandatory attribute. The code
in the queue manager and IBM MQ application processes tries to load the switch load file on two
occasions:
1. At queue manager startup
2. When you make the first call to MQBEGIN in your IBM MQ application process

The security and permissions attributes of your switch load file must allow these processes to
perform this action.

XAOpenString=string
This is a string of data that IBM MQ code passes in its calls to the database manager's xa_open
function. This is an optional attribute; if it is omitted a zero-length string is assumed.

The code in the queue manager and IBM MQ application processes call the xa_open function on two
occasions:
1. At queue manager startup
2. When you make the first call to MQBEGIN in your IBM MQ application process

The format for this string is particular to each database product, and will be described in the
documentation for that product. In general, the xa_open string contains authentication information
(user name and password) to allow a connection to the database in both the queue manager and the
application processes.

From IBM MQ Version 8.0.0, Fix Pack 4, when the XAOpenString contains a password, you can get
IBM MQ to protect this information, rather than having the password visible in plain text in the
qm.ini file. IBM MQ stores the user name and the password (in an encrypted form) in a different file,
and uses these credentials to connect to the database. For details, see Protection of database
authentication details.
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XACloseString=string
This is a string of data that IBM MQ code passes in its calls to the database manager's xa_close
function. This is an optional attribute; if it is omitted a zero-length string is assumed.

The code in the queue manager and IBM MQ application processes call the xa_close function on two
occasions:
1. At queue manager startup
2. When you make a call to MQDISC in your IBM MQ application process, having earlier made a

call to MQBEGIN

The format for this string is particular to each database product, and will be described in the
documentation for that product. In general, the string is empty, and it is common to omit the
XACloseString attribute from the XAResourceManager stanza.

ThreadOfControl=THREAD|PROCESS
The ThreadOfControl value can be THREAD or PROCESS. The queue manager uses it for
serialization purposes. This is an optional attribute; if it is omitted, the value PROCESS is assumed.

If the database client code allows threads to call the XA functions without serialization, the value for
ThreadOfControl can be THREAD. The queue manager assumes that it can call the XA functions in
the database client shared library from multiple threads at the same time, if necessary.

If the database client code does not allow threads to call its XA functions in this way, the value for
ThreadOfControl must be PROCESS. In this case, the queue manager serializes all calls to the
database client shared library so that only one call at a time is made from within a particular process.
You probably also need to ensure that your application performs similar serialization if it runs with
multiple threads.

Note that this issue, of the database product's ability to cope with multi-threaded processes in this
way, is an issue for that product's vendor. Consult the database product's documentation for details
on whether you can set the ThreadOfControl attribute to THREAD or PROCESS. We recommend that,
if you can, you set ThreadOfControl to THREAD. If in doubt, the safer option is to set it to PROCESS,
although you will lose the potential performance benefits of using THREAD.

Writing and modifying your applications:

How to implement a global unit of work.

The sample application programs for Scenario 1 global units of work that are supplied with an IBM MQ
installation are described in the “Introducing units of work” on page 45.

In general, a global unit of work is implemented in an application by the following method (in
pseudocode):

MQBEGIN
MQGET
MQPUT
SQL INSERT
MQCMIT

The purpose of MQBEGIN is to denote the beginning of a global unit of work. The purpose of MQCMIT
is to denote the end of the global unit of work, and to complete it with all participating resource
managers, using the two-phase commit protocol.

In between MQBEGIN and MQCMIT, the queue manager does not make any calls to the database to
update its resources. That is, the only way a database's tables are changed is by your code (for example,
the SQL INSERT in the pseudocode).

The role of the queue manager, as far as the database is concerned, is to tell it when a global unit of work
has started, when it has ended, and whether the global unit of work should be committed or rolled-back.
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As far as your application is concerned, the queue manager performs two roles: a resource manager
(where the resources are messages on queues) and the transaction manager for the global unit of work.

Start with the supplied sample programs, and work through the various IBM MQ and database API calls
that are being made in those programs. The API calls concerned are fully documented in Sample IBM
MQ procedural programs, Data types used in the MQI, and (in the case of the database's own API) the
database's own documentation.

Testing the system:

You know whether your application and system are correctly configured only by running them during
testing. You can test the system's configuration (the successful communication between queue manager
and database) by building and running one of the supplied sample programs.

Configuring Db2

Db2 support and configuration information.

The supported levels of Db2 are defined at the System Requirements for IBM MQ page.

Note: 32-bit instances of Db2 are not supported on platforms where the queue manager is 64-bit.

Do the following:
1. Check the environment variable settings.
2. Create the Db2 switch load file.
3. Add resource manager configuration information.
4. Change Db2 configuration parameters if necessary.

Read this information in conjunction with the general information provided in “Configuring your system
for database coordination” on page 50.

Warning: If you run db2profile on UNIX and Linux platforms, the environment variable LIBPATH and
LD_LIBRARY_PATH are set. It is advisable to unset these environment variables. See crtmqenv or
setmqenv for more information.

Checking the Db2 environment variable settings

Ensure that your Db2 environment variables are set for queue manager processes as well as in your
application processes. In particular, you must always set the Db2INSTANCE environment variable before
you start the queue manager. The DB2INSTANCE environment variable identifies the Db2 instance
containing the Db2 databases that are being updated. For example:
v On UNIX and Linux systems, use:

export DB2INSTANCE=db2inst1

v On Windows systems, use:
set DB2INSTANCE=Db2

On Windows with a Db2 database, you must add the user MUSR_MQADMIN to the DB2USERS group,
to enable the queue manager to start.

Creating the Db2 switch load file

The easiest way to create the Db2 switch load file is to use the sample file xaswit.mak, which IBM MQ
provides to build the switch load files for a variety of database products.
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On Windows systems, you can findxaswit.mak in the directory MQ_INSTALLATION_PATH\tools\c\samples\
xatm. MQ_INSTALLATION_PATH represents the high-level directory in which IBM MQ is installed. To create
the Db2 switch load file with Microsoft Visual C++, use:
nmake /f xaswit.mak db2swit.dll

The generated switch file is placed in C:\Program Files\IBM\MQ\exits.

You can find xaswit.mak in the directory MQ_INSTALLATION_PATH/samp/xatm. MQ_INSTALLATION_PATH
represents the high-level directory in which IBM MQ is installed.

Edit xaswit.mak to uncomment the lines appropriate to the version of Db2 you are using. Then execute the
makefile using the command:
make -f xaswit.mak db2swit

The generated 32-bit switch load file is placed in /var/mqm/exits.

The generated 64-bit switch load file is placed in /var/mqm/exits64.

Adding resource manager configuration information for Db2

You must modify the configuration information for the queue manager to declare Db2 as a participant in
global units of work. Modifying configuration information in this way is described in more details in
“Adding configuration information to the queue manager” on page 52.
v On Windows and Linux (x86 and x86-64 platforms) systems, use the IBM MQ Explorer. Specify the

details of the switch load file in the queue manager properties panel, under XA resource manager.
v On all other systems specify the details of the switch load file in the XAResourceManager stanza in the

queue manager's qm.ini file.

Figure 6 is a UNIX sample, showing an XAResourceManager entry where the database to be coordinated
is called mydbname, this name being specified in the XAOpenString:

Note:

1. ThreadOfControl=THREAD cannot be used with Db2 versions earlier than version 8. Set ThreadOfControl
and the XAOpenString parameter toc to one of the following combinations:
v ThreadOfControl=THREAD and toc=t
v ThreadOfControl=PROCESS and toc=p
If you are using the jdbcdb2 XA switch load file to enable JDBC/JTA coordination, you must use
ThreadOfControl=PROCESS and toc=p.

Changing Db2 configuration parameters

For each Db2 database that the queue manager is coordinating, you must set database privileges, change
the tp_mon_name parameter, and reset the maxappls parameter. To do this, perform the following steps:

XAResourceManager:
Name=mydb2
SwitchFile=db2swit
XAOpenString=mydbname,myuser,mypasswd,toc=t
ThreadOfControl=THREAD

Figure 6. Sample XAResourceManager entry for Db2 on UNIX
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Set database privileges
The queue manager processes run with effective user and group mqm on UNIX and Linux
systems. On Windows systems, they run as the user that started the queue manager. This can be
one of:
1. The user who issued the strmqm command, or
2. The user under which the IBM MQ Service COM server runs

By default, this user is called MUSR_MQADMIN.

If you have not specified a user name and password on the xa_open string, the user under
which the queue manager is running is used by Db2 to authenticate the xa_open call. If this user
(for example, user mqm on UNIX and Linux systems) does not have minimal privileges in the
database, the database refuses to authenticate the xa_open call.

The same considerations apply to your application process. If you have not specified a user name
and password on the xa_open string, the user under which your application is running is used by
Db2 to authenticate the xa_open call that is made during the first MQBEGIN. Again, this user
must have minimal privileges in the database for this to work.

For example, give the mqm user connect authority in the mydbname database by issuing the
following Db2 commands:
db2 connect to mydbname
db2 grant connect on database to user mqm

See “Security considerations” on page 64 for more information about security.

Change the TP_MON_NAME parameter
For Db2 on Windows systems only, change the TP_MON_NAME configuration parameter to
name the DLL that Db2 uses to call the queue manager for dynamic registration.

Use the command db2 update dbm cfg using TP_MON_NAME mqmax to name MQMAX.DLL as the
library that Db2 uses to call the queue manager. This must be present in a directory within PATH.

Reset the maxappls parameter
You might need to review your setting for the maxappls parameter, which limits the maximum
number of applications that can be connected to a database. Refer to “Installing and configuring
the database product” on page 50.

Configuring Oracle

Oracle support and configuration information.

Complete the following steps:
1. Check environment variable settings.
2. Create the Oracle switch load file.
3. Add resource manager configuration information.
4. Change the Oracle configuration parameters, if necessary.

For a current list of levels of Oracle supported by IBM MQ, see System Requirements for IBM MQ.

Checking the Oracle environment variable settings

Ensure that your Oracle environment variables are set for queue manager processes as well as in your
application processes. In particular, always set the following environment variables before starting the
queue manager:

ORACLE_HOME
The Oracle home directory. For example, on UNIX and Linux systems, use:
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export ORACLE_HOME=/opt/oracle/product/8.1.6

On Windows systems, use:
set ORACLE_HOME=c:\oracle\ora81

ORACLE_SID
The Oracle SID being used. If you are using Net8 for client/server connectivity, you might not
have to set this environment variable. Consult your Oracle documentation.

The subsequent example is an example of setting this environment variable, on UNIX and Linux
systems:
export ORACLE_SID=sid1

The equivalent on Windows systems is:
set ORACLE_SID=sid1

If you run queue managers on Windows 64 bit systems, then only 64 bit Oracle clients must be installed.
The switch load file, loaded by 64 bit queue managers, must access the Oracle 64 bit client libraries.

Creating the Oracle switch load file

To create the Oracle switch load file, use the sample file xaswit.mak, which IBM MQ provides to build
the switch load files for various database products. On Windows systems, you can find xaswit.mak in the
directory C:\Program Files\IBM\MQ\tools\c\samples\xatm. To create the Oracle switch load file with
Microsoft Visual C++, use: nmake /f xaswit.mak oraswit.dll

Note: These switch load files can be used only with C applications. For Java applications, see JTA/JDBC
coordination using IBM MQ classes for Java.

The generated switch file is placed in MQ_INSTALLATION_PATH\exits. MQ_INSTALLATION_PATH represents the
high-level directory in which IBM MQ is installed.

You can find xaswit.mak in the directory MQ_INSTALLATION_PATH/samp/xatm. MQ_INSTALLATION_PATH
represents the high-level directory in which IBM MQ is installed.

Edit xaswit.mak to uncomment the lines appropriate to the version of Oracle you are using. Then execute
the makefile using the command:
make -f xaswit.mak oraswit

The contents of MQ_INSTALLATION_PATH/samp/xatm are read-only when IBM MQ is installed, so to edit
xaswit.mak, copy all the files out of samp/xatm to another directory, modify xaswit.mak, and then run
make -f xaswit.makoraswit from that directory.

The generated 32 bit switch load file is placed in /var/mqm/exits.

The generated 64 bit switch load file is placed in /var/mqm/exits64.

Adding resource manager configuration information for Oracle

You must modify the configuration information for the queue manager to declare Oracle as a participant
in global units of work. Modifying the configuration information for the queue manager in this way is
described in more detail in “Adding configuration information to the queue manager” on page 52.
v On Windows and Linux (x86 and x86-64 platforms) systems, use the IBM MQ Explorer. Specify the

details of the switch load file in the queue manager properties panel, under XA resource manager.
v On all other systems specify the details of the switch load file in the XAResourceManager stanza in the

qm.ini file of the queue manager.
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Figure 7 is a UNIX and Linux systems sample showing an XAResourceManager entry. You must add a
LogDir to the XA open string so that all error and tracing information is logged to the same place.

Note:

1. In Figure 7, the xa_open string has been used with four parameters. Additional parameters can be
included as described in Oracle's documentation.

2. When using the IBM MQ parameter ThreadOfControl=THREAD you must use the Oracle parameter
+threads=true in the XAResourceManager stanza.

See the Oracle8 Server Application Developer's Guide for more information about the xa_open string.

Changing Oracle configuration parameters

For each Oracle database that the queue manager is coordinating, you must review your maximum
sessions and set database privileges. To do so, complete these steps:

Review your maximum sessions
You might have to review your LICENSE_MAX_SESSIONS and PROCESSES settings to take into
account the additional connections required by processes belonging to the queue manager. See
“Installing and configuring the database product” on page 50 for more details.

Set database privileges
The Oracle user name specified in the xa_open string must have privileges to access the
DBA_PENDING_TRANSACTIONS view, as described in the Oracle documentation.

The necessary privilege can be given using the following example command:
grant select on DBA_PENDING_TRANSACTIONS to myuser;

Configuring Informix

Informix support and configuration information.

Complete the following steps:
1. Ensure that you have installed the appropriate Informix client SDK:
v 32 bit queue managers and applications require a 32 bit Informix client SDK.
v 64 bit queue managers and applications require a 64 bit Informix client SDK.

2. Ensure that Informix databases are created correctly.
3. Check environment variable settings.
4. Build the Informix switch load file.
5. Add resource manager configuration information.

For a current list of levels of Informix supported by IBM MQ, see System Requirements for IBM MQ.

XAResourceManager:
Name=myoracle
SwitchFile=oraswit
XAOpenString=Oracle_XA+Acc=P/myuser/mypasswd+SesTm=35+LogDir=/tmp+threads=true
ThreadOfControl=THREAD

Figure 7. Sample XAResourceManager entry for Oracle on UNIX and Linux platforms
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Ensuring that Informix databases are created correctly

Every Informix database that is to be coordinated by an IBM MQ queue manager must be created
specifying the log parameter. For example:
create database mydbname with log;

IBM MQ queue managers are unable to coordinate Informix databases that do not have the log
parameter specified on creation. If a queue manager attempts to coordinate an Informix database that
does not have the log parameter specified on creation, the xa_open call to Informix fails, and a number of
FFST™ errors are generated.

Checking the Informix environment variable settings

Ensure that your Informix environment variables are set for queue manager processes as well as in your
application processes. In particular, always set the following environment variables before starting the
queue manager:

INFORMIXDIR
The directory of the Informix product installation.
v For 32 bit UNIX and Linux applications, use the following command:

export INFORMIXDIR=/opt/informix/32-bit

v For 64 bit UNIX and Linux applications, use the following command:
export INFORMIXDIR=/opt/informix/64-bit

v For Windows applications, use the following command:
set INFORMIXDIR=c:\informix

For systems that have 64 bit queue managers that must support both 32 bit and 64 bit
applications, you need both the Informix 32 bit and 64 bit client SDKs installed. The sample
makefile xaswit.mak, used for creating a switch load file also sets both product installation
directories.

INFORMIXSERVER
The name of the Informix server. For example, on UNIX and Linux systems, use:
export INFORMIXSERVER=hostname_1

On Windows systems, use:
set INFORMIXSERVER=hostname_1

ONCONFIG
The name of the Informix server configuration file. For example, on UNIX and Linux systems,
use:
export ONCONFIG=onconfig.hostname_1

On Windows systems, use:
set ONCONFIG=onconfig.hostname_1

Creating the Informix switch load file

To create the Informix switch load file, use the sample file xaswit.mak, which IBM MQ provides to build
the switch load files for various database products. On Windows systems, you can find xaswit.mak in the
directory MQ_INSTALLATION_PATH\tools\c\samples\xatm. MQ_INSTALLATION_PATH represents the high-level
directory in which IBM MQ is installed. To create the Informix switch load file with Microsoft Visual
C++, use:
nmake /f xaswit.mak infswit.dll

The generated switch file is placed in C:\Program Files\IBM\MQ\exits.
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You can find xaswit.mak in the directory MQ_INSTALLATION_PATH/samp/xatm. MQ_INSTALLATION_PATH
represents the high-level directory in which IBM MQ is installed.

Edit xaswit.mak to uncomment the lines appropriate to the version of Informix you are using. Then
execute the makefile using the command:
make -f xaswit.mak infswit

The generated 32 bit switch load file is placed in /var/mqm/exits.

The generated 64 bit switch load file is placed in /var/mqm/exits64.

Adding resource manager configuration information for Informix

You must modify the configuration information for the queue manager to declare Informix as a
participant in global units of work. Modifying the configuration information for the queue manager in
this way is described in more detail in “Adding configuration information to the queue manager” on
page 52.
v On Windows and Linux (x86 and x86-64 platforms) systems, use the IBM MQ Explorer. Specify the

details of the switch load file in the queue manager properties panel, under XA resource manager.
v On all other systems specify the details of the switch load file in the XAResourceManager stanza in the

qm.ini file of the queue manager.

Figure 8 is a UNIX sample, showing a qm.ini XAResourceManager entry where the database to be
coordinated is called mydbname, this name being specified in the XAOpenString:

Note: By default the sample xaswit.mak on UNIX creates a switch load file that uses threaded Informix
libraries. You must ensure that ThreadOfControl is set to THREAD when using these Informix libraries.
In Figure 8, the qm.ini file XAResourceManager stanza attribute ThreadOfControl is set to THREAD.
When THREAD is specified, applications must be built using the threaded Informix libraries and the IBM
MQ threaded API libraries.

The XAOpenString attribute must contain the database name, followed by the @ symbol, and then
followed by the Informix server name.

To use the nonthreaded Informix libraries, you must ensure that the qm.ini file XAResourceManager
stanza attribute ThreadOfControl is set to PROCESS. You must also make the following changes to the
sample xaswit.mak:
1. Uncomment the generation of a nonthreaded switch load file.
2. Comment out the generation of the threaded switch load file.

XAResourceManager:
Name=myinformix
SwitchFile=infswit
XAOpenString=DB=mydbname@myinformixserver\;USER=myuser\;PASSWD=mypasswd
ThreadOfControl=THREAD

Figure 8. Sample XAResourceManager entry for Informix on UNIX
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Sybase configuration

Sybase support and configuration information.

Complete the following steps:
1. Ensure you have installed the Sybase XA libraries, for example by installing the XA DTM option.
2. Check environment variable settings.
3. Enable Sybase XA support.
4. Create the Sybase switch load file.
5. Add resource manager configuration information.

For a current list of levels of Sybase supported by IBM MQ, see System Requirements for IBM MQ.

Checking the Sybase environment variable settings

Ensure that your Sybase environment variables are set for queue manager processes as well as in your
application processes. In particular, always set the following environment variables before starting the
queue manager:

SYBASE
The location of the Sybase product installation. For example, on UNIX and Linux systems, use:
export SYBASE=/sybase

On Windows systems, use:
set SYBASE=c:\sybase

SYBASE_OCS
The directory under SYBASE where you have installed the Sybase client files. For example, on
UNIX and Linux systems, use:
export SYBASE_OCS=OCS-12_0

On Windows systems, use:
set SYBASE_OCS=OCS-12_0

Enabling Sybase XA support

Within the Sybase XA configuration file $SYBASE/$SYBASE_OCS/xa_config, define a Logical Resource
Manager (LRM) for each connection to the Sybase server that is being updated. An example of the
contents of $SYBASE/$SYBASE_OCS/xa_config is shown in Figure 9.

Creating the Sybase switch load file

To create the Sybase switch load file, use the sample files supplied with IBM MQ. On Windows systems,
you can find xaswit.mak in the directory C:\Program Files\IBM\MQ\tools\c\samples\xatm. To create the
Sybase switch load file with Microsoft Visual C++, use:

# The first line must always be a comment

[xa]

LRM=lrmname
server=servername

Figure 9. Example contents of $SYBASE/$SYBASE_OCS/xa_config
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nmake /f xaswit.mak sybswit.dll

The generated switch file is placed in C:\Program Files\IBM\MQ\exits.

You can find xaswit.mak in the directory MQ_INSTALLATION_PATH/samp/xatm. MQ_INSTALLATION_PATH
represents the high-level directory in which IBM MQ is installed.

Edit xaswit.mak to uncomment the lines appropriate to the version of Sybase you are using. Then execute
the makefile using the command:
make -f xaswit.mak sybswit

The generated 32-bit switch load file is placed in /var/mqm/exits.

The generated 64-bit switch load file is placed in /var/mqm/exits64.

Adding resource manager configuration information for Sybase

You must modify the configuration information for the queue manager to declare Sybase as a participant
in global units of work. Modifying the configuration information is described in more detail in “Adding
configuration information to the queue manager” on page 52.
v On Windows and Linux (x86 and x86-64 platforms) systems, use the IBM MQ Explorer. Specify the

details of the switch load file in the queue manager properties panel, under XA resource manager.
v On all other systems specify the details of the switch load file in the XAResourceManager stanza in the

queue manager's qm.ini file.

Figure 10 shows a UNIX and Linux sample, which uses the database associated with the lrmname LRM
definition in the Sybase XA configuration file, $SYBASE/$SYBASE_OCS/xa_config. Include a log file name if
you want XA function calls to be logged:

Using multi-threaded programs with Sybase

If you are using multi-threaded programs with IBM MQ global units of work incorporating updates to
Sybase, you must use the value THREAD for the ThreadOfControl parameter. Also ensure that you link
your program (and the switch load file) with the threadsafe Sybase libraries (the _r versions). Using the
value THREAD for the ThreadOfControl parameter is shown in Figure 10.

XAResourceManager:
Name=mysybase
SwitchFile=sybswit
XAOpenString=-Uuser -Ppassword -Nlrmname -L/tmp/sybase.log -Txa
ThreadOfControl=THREAD

Figure 10. Sample XAResourceManager entry for Sybase on UNIX and Linux platforms
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Multiple database configurations

If you want to configure the queue manager so that updates to multiple databases can be included within
global units of work, add an XAResourceManager stanza for each database.

If the databases are all managed by the same database manager, each stanza defines a separate
database. Each stanza specifies the same SwitchFile, but the contents of the XAOpenString are different
because it specifies the name of the database being updated. For example, the stanzas shown in Figure 11
configure the queue manager with the Db2 databases MQBankDB and MQFeeDB on UNIX and Linux
systems.

Important: You cannot have multiple stanzas pointing to the same database. This configuration does not
work under any circumstances, and if you try this configuration it fails.

You will receive errors of the form when the MQ code makes its second xa_open call in any process in
this environment, the database software fails the second xa_open with a -5 error, XAER_INVAL.

If the databases to be updated are managed by different database managers, add an
XAResourceManager stanza for each. In this case, each stanza specifies a different SwitchFile. For
example, if MQFeeDB is managed by Oracle instead of Db2, use the following stanzas on UNIX and
Linux systems:

In principle, there is no limit to the number of database instances that can be configured with a single
queue manager.

Note: For information on support for including Informix databases in multiple database updates within
global units of work, check the product readme file.

XAResourceManager:
Name=DB2 MQBankDB
SwitchFile=db2swit
XAOpenString=MQBankDB

XAResourceManager:
Name=DB2 MQFeeDB
SwitchFile=db2swit
XAOpenString=MQFeeDB

Figure 11. Sample XAResourceManager entries for multiple Db2 databases

XAResourceManager:
Name=DB2 MQBankDB
SwitchFile=db2swit
XAOpenString=MQBankDB

XAResourceManager:
Name=Oracle MQFeeDB
SwitchFile=oraswit
XAOpenString=Oracle_XA+Acc=P/myuser/mypassword+SesTm=35+LogDir=/tmp/ora.log+DB=MQFeeDB

Figure 12. Sample XAResourceManager entries for a Db2 and Oracle database
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Security considerations

Considerations for running your database under the XA model.

The following information is provided for guidance only. In all cases, refer to the documentation
provided with the database manager to determine the security implications of running your database
under the XA model.

An application process denotes the start of a global unit of work using the MQBEGIN verb. The first
MQBEGIN call that an application issues connects to all participating databases by calling their client library
code at the xa_open entry point. All the database managers provide a mechanism for supplying a user ID
and password in their XAOpenString. This is the only time that authentication information flows.

Note that, on UNIX and Linux platforms, fastpath applications must run with an effective user ID of
mqm while making MQI calls.

Considerations when contact is lost with the XA resource manager

The queue manager tolerates database managers not being available. This means you can start and stop
the queue manager independently from the database server. When contact is restored, the queue manager
and database resynchronize. You can also use the rsvmqtrn command to manually resolve in-doubt units
of work.

In normal operations, only a minimal amount of administration is necessary after you have completed
the configuration steps. The administration job is made easier because the queue manager tolerates
database managers not being available. In particular this means that:
v The queue manager can start at any time without first starting each of the database managers.
v The queue manager does not need to stop and restart if one of the database managers becomes

unavailable.

This allows you to start and stop the queue manager independently from the database server.

Whenever contact is lost between the queue manager and a database, they need to resynchronize when
both become available again. Resynchronization is the process by which any in-doubt units of work
involving that database are completed. In general, this occurs automatically without the need for user
intervention. The queue manager asks the database for a list of units of work that are in doubt. It then
instructs the database to either commit or roll back each of these in-doubt units of work.

When a queue manager starts, it resynchronizes with each database. When an individual database
becomes unavailable, only that database needs to be resynchronized the next time that the queue
manager notices it is available again.

The queue manager regains contact with a previously unavailable database automatically as new global
units of work are started with MQBEGIN. It does this by calling the xa_open function in the database
client library. If this xa_open call fails, MQBEGIN returns with a completion code of MQCC_WARNING
and a reason code of MQRC_PARTICIPANT_NOT_AVAILABLE. You can retry the MQBEGIN call later.

Do not continue to attempt a global unit of work that involves updates to a database that has indicated
failure during MQBEGIN. There will not be a connection to that database through which updates can be
made. Your only options are to end the program, or to retry MQBEGIN periodically in the hope that the
database might become available again.

Alternatively, you can use the rsvmqtrn command to resolve explicitly all in-doubt units of work.
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In-doubt units of work:

A database might have in-doubt units of work if contact with the queue manager is lost after the
database manager has been instructed to prepare. Until the database server receives the outcome from the
queue manager (commit or roll back), it needs to retain the database locks associated with the updates.

Because these locks prevent other applications from updating or reading database records,
resynchronization needs to take place as soon as possible.

If, for some reason, you cannot wait for the queue manager to resynchronize with the database
automatically, you can use facilities provided by the database manager to commit or roll back the
database updates manually. In the X/Open Distributed Transaction Processing: The XA Specification, this is
called making a heuristic decision. Use it only as a last resort because of the possibility of compromising
data integrity; you might, for example, mistakenly roll back the database updates when all other
participants have committed their updates.

It is far better to restart the queue manager, or use the rsvmqtrn command when the database has been
restarted, to initiate automatic resynchronization.

Displaying outstanding units of work with the dspmqtrn command:

While a database manager is unavailable, you can use the dspmqtrn command to check the state of
outstanding global units of work involving that database.

The dspmqtrn command displays only those units of work in which one or more participants are in
doubt. The participants are awaiting the decision from the queue manager to commit or roll back the
prepared updates.

For each of these global units of work, the state of each participant is displayed in the output from
dspmqtrn. If the unit of work did not update the resources of a particular resource manager, it is not
displayed.

With respect to an in-doubt unit of work, a resource manager is said to have done one of the following
things:

Prepared
The resource manager is prepared to commit its updates.

Committed
The resource manager has committed its updates.

Rolled-back
The resource manager has rolled back its updates.

Participated
The resource manager is a participant, but has not prepared, committed, or rolled back its
updates.

When the queue manager is restarted, it asks each database having an XAResourceManager stanza for a
list of its in-doubt global units of work. If the database has not been restarted, or is otherwise
unavailable, the queue manager cannot yet deliver to the database the final outcomes for those units of
work. The outcome of the in-doubt units of work is delivered to the database at the first opportunity
when the database is again available.

In this case, the database manager is reported as being in prepared state until resynchronization has
occurred.
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Whenever the dspmqtrn command displays an in-doubt unit of work, it first lists all the possible resource
managers that might be participating. These are allocated a unique identifier, RMId, which is used instead
of the Name of the resource managers when reporting their state with respect to an in-doubt unit of work.

Sample dspmqtrn output shows the result of issuing the following command:
dspmqtrn -m MY_QMGR

The output in Sample dspmqtrn output shows that there are three resource managers associated with the
queue manager. The first is resource manager 0, which is the queue manager itself. The other two
resource manager instances are the MQBankDB and MQFeeDB Db2 databases.

The example shows only a single in-doubt unit of work. A message is issued for all three resource
managers, which means that updates were made to the queue manager and both Db2 databases within
the unit of work.

The updates made to the queue manager, resource manager 0, have been committed. The updates to the
Db2 databases are in prepared state, which means that Db2 must have become unavailable before it was
called to commit the updates to the MQBankDB and MQFeeDB databases.

The in-doubt unit of work has an external identifier called an XID ( transaction id ). This is a piece of data
given to Db2 by the queue manager to identify its portion of the global unit of work.

AMQ7107: Resource manager 0 is MQSeries.
AMQ7107: Resource manager 1 is DB2 MQBankDB.
AMQ7107: Resource manager 2 is DB2 MQFeeDB.

AMQ7056: Transaction number 0,1.
XID: formatID 5067085, gtrid_length 12, bqual_length 4

gtrid [3291A5060000201374657374]
bqual [00000001]

AMQ7105: Resource manager 0 has committed.
AMQ7104: Resource manager 1 has prepared.
AMQ7104: Resource manager 2 has prepared.

where Transaction number is the ID of the transaction which can be used with the rsvmqtrn command. See
AMQ7xxx: IBM MQ product messages for further information. The XID variables are part of the X/Open XA
Specification ; for the most up-to-date information about this specification see: http://www.opengroup.org/
publications/catalog/c193.htm.

Figure 13. Sample dspmqtrn output
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Resolving outstanding units of work with the rsvmqtrn command:

Outstanding units of work complete when the queue manager and Db2 resynchronize.

The output shown in Figure 13 on page 66 shows a single in-doubt unit of work in which the commit
decision has yet to be delivered to both Db2 databases.

To complete this unit of work, the queue manager and Db2 need to resynchronize when Db2 next
becomes available. The queue manager uses the start of new units of work as an opportunity to regain
contact with Db2. Alternatively, you can instruct the queue manager to resynchronize explicitly using the
rsvmqtrn command.

Do this soon after Db2 has been restarted, so that any database locks associated with the in-doubt unit of
work are released as quickly as possible. Use the -a option, which tells the queue manager to resolve all
in-doubt units of work. In the following example, Db2 has restarted, so the queue manager can resolve
the in-doubt unit of work:
> rsvmqtrn -m MY_QMGR -a
Any in-doubt transactions have been resolved.

Mixed outcomes and errors:

Although the queue manager uses a two-phase commit protocol, this does not completely remove the
possibility of some units of work completing with mixed outcomes. This is where some participants
commit their updates and some back out their updates.

Units of work that complete with a mixed outcome have serious implications because shared resources
that should have been updated as a single unit of work are no longer in a consistent state.

Mixed outcomes are mainly caused when heuristic decisions are made about units of work instead of
allowing the queue manager to resolve in-doubt units of work itself. Such decisions are outside the queue
manager's control.

Whenever the queue manager detects a mixed outcome, it produces FFST information and documents the
failure in its error logs, with one of two messages:
v If a database manager rolls back instead of committing:

AMQ7606 A transaction has been committed but one or more resource
managers have rolled back.

v If a database manager commits instead of rolling back:
AMQ7607 A transaction has been rolled back but one or more resource

managers have committed.

Further messages identify the databases that are heuristically damaged. It is then your responsibility to
locally restore consistency to the affected databases. This is a complicated procedure in which you need
first to isolate the update that has been wrongly committed or rolled back, then to undo or redo the
database change manually.
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Changing configuration information:

After the queue manager has successfully started to coordinate global units of work, do not change any
of the resource manager configuration information.

If you need to change the configuration information you can do so at any time, but the changes do not
take effect until after the queue manager has been restarted.

If you remove the resource manager configuration information for a database, you are effectively
removing the ability for the queue manager to contact that database manager.

Never change the Name attribute in any of your resource manager configuration information. This
attribute uniquely identifies that database manager instance to the queue manager. If you change this
unique identifier, the queue manager assumes that the database has been removed and a completely new
instance has been added. The queue manager still associates outstanding units of work with the old
Name, possibly leaving the database in an in-doubt state.

Removing database manager instances:

If you need to remove a database from your configuration permanently, ensure that the database is not in
doubt before you restart the queue manager.

Database products provide commands for listing in-doubt transactions. If there are any in-doubt
transactions, first allow the queue manager to resynchronize with the database. Do this by starting the
queue manager. You can verify that resynchronization has taken place by using the rsvmqtrn command
or the database's own command for viewing in-doubt units of work. Once you are satisfied that
resynchronization has taken place, end the queue manager and remove the database's configuration
information.

If you fail to observe this procedure the queue manager still remembers all in-doubt units of work
involving that database. A warning message, AMQ7623, is issued every time the queue manager is
restarted. If you are never going to configure this database with the queue manager again, use the -r
option of the rsvmqtrn command to instruct the queue manager to forget about the database's
participation in its in-doubt transactions. The queue manager forgets about such transactions only when
in-doubt transactions have been completed with all participants.

There are times when you might need to remove some resource manager configuration information
temporarily. On UNIX and Linux systems this is best achieved by commenting out the stanza so that it
can be easily reinstated at a later time. You might decide to do this if there are errors every time the
queue manager contacts a particular database or database manager. Temporarily removing the resource
manager configuration information concerned allows the queue manager to start global units of work
involving all the other participants. Here is an example of a commented-out XAResourceManager stanza
follows:

On Windows systems, use the IBM MQ Explorer to delete the information about the database manager
instance. Take great care to type in the correct name in the Name field when reinstating it. If you mistype
the name, you may face in-doubt problems, as described in “Changing configuration information.”

# This database has been temporarily removed
#XAResourceManager:
# Name=mydb2
# SwitchFile=db2swit
# XAOpenString=mydbname,myuser,mypassword,toc=t
# ThreadOfControl=THREAD

Figure 14. Commented- out XAResourceManager stanza on UNIX and Linux systems
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XA dynamic registration

The XA specification provides a way of reducing the number of xa_* calls that a transaction manager
makes to a resource manager. This optimization is known as dynamic registration.

Dynamic registration is supported by Db2. Other databases might support it; consult the documentation
for your database product for details.

Why is the dynamic registration optimization useful? In your application, some global units of work
might contain updates to database tables; others might not contain such updates. When no persistent
update has been made to a database's tables, there is no need to include that database in the commit
protocol that occurs during MQCMIT.

Whether or not your database supports dynamic registration, your application calls xa_open during the
first MQBEGIN call on an IBM MQ connection. It also calls xa_close on the subsequent MQDISC call.
The pattern of subsequent XA calls depends on whether the database supports dynamic registration:

If your database does not support dynamic registration...
Every global unit of work involves several XA function calls made by IBM MQ code into the
database client library, regardless of whether you made a persistent update to the tables of that
database within your unit of work. These include:
v xa_start and xa_end from the application process. These are used to declare the beginning and

end of a global unit of work.
v xa_prepare, xa_commit, and xa_rollback from the queue manager agent process, amqzlaa0.

These are used to deliver the outcome of the global unit of work: the commit or rollback
decision.

In addition, the queue manager agent process also calls xa_open during the first MQBEGIN.

If your database supports dynamic registration...
The IBM MQ code makes only those XA function calls that are necessary. For a global unit of
work that has not involved persistent updates to database resources, there are no XA calls to the
database. For a global unit of work that has involved such persistent updates, the calls are to:
v xa_end from the application process to declare the end of the global unit of work.
v xa_prepare, xa_commit, and xa_rollback from the queue manager agent process, amqzlaa0.

These are used to deliver the outcome of the global unit of work: the commit or rollback
decision.

For dynamic registration to work, it is vital that the database has a way of telling IBM MQ when it has
performed a persistent update that it wants to be included in the current global unit of work. IBM MQ
provides the ax_reg function for this purpose.

The database's client code that runs in your application process finds the ax_reg function and calls it, to
dynamically register the fact it has done persistent work within the current global unit of work. In response
to this ax_reg call, IBM MQ records that the database has participated. If this is the first ax_reg call on
this IBM MQ connection, the queue manager agent process calls xa_open.

The database client code make this ax_reg call when it is running in your process, for example, during an
SQL UPDATE call or whatever call in the database's client API is responsible
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Error conditions:

In XA dynamic registration there is a possibility of a confusing failure in the queue manager.

A common example is if you forget to set your database environment variables properly before starting
your queue manager, the queue manager's calls to xa_open fail. No global units of work can be used.

To avoid this, ensure that you have set the relevant environment variables before starting the queue
manager. Review your database product's documentation, and the advice given in “Configuring Db2” on
page 54, “Configuring Oracle” on page 56, and “Sybase configuration” on page 61.

With all database products, the queue manager calls xa_open once at queue manager startup, as part of
the recovery session (as explained in “Considerations when contact is lost with the XA resource manager”
on page 64 ). This xa_open call fails if you set your database environment variables incorrectly, but it does
not cause the queue manager to fail to start. This is because the same xa_open error code is used by the
database client library to indicate that the database server is unavailable. IBM MQ does not treat this as a
serious error, as the queue manager must be able to start to continue processing data outside global units
of work involving that database.

Subsequent calls to xa_open are made from the queue manager during the first MQBEGIN on an IBM MQ
connection (if dynamic registration is not being used) or during a call by the database client code to the
IBM MQ-provided ax_reg function (if dynamic registration is being used).

The timing of any error conditions (or, occasionally, FFST reports) depends on whether you are using
dynamic registration:
v If you are using dynamic registration, your MQBEGIN call could succeed, but your SQL UPDATE (or

similar) database call will fail.
v If you are not using dynamic registration, your MQBEGIN call will fail.

Ensure that your environment variables are set correctly in your application and queue manager
processes.

Summarizing XA calls:

Here is a list of the calls that are made to the XA functions in a database client library as a result of the
various MQI calls that control global units of work. This is not a complete description of the protocol
described in the XA specification; it is provided as a brief overview.

Note that xa_start and xa_end calls are always called by IBM MQ code in the application process,
whereas xa_prepare, xa_commit, and xa_rollback are always called from the queue manager agent
process, amqzlaa0.

The xa_open and xa_close calls shown in this table are all made from the application process. The queue
manager agent process calls xa_open in the circumstances described in “Error conditions.”

Table 4. Summary of XA function calls

MQI call XA calls made with dynamic
registration

XA calls made without dynamic
registration

First MQBEGIN xa_open xa_open
xa_start

Subsequent MQBEGIN No XA calls xa_start

MQCMIT ( without ax_reg being
called during the current global unit
of work)

No XA calls xa_end
xa_prepare
xa_commit
xa_rollback
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Table 4. Summary of XA function calls (continued)

MQI call XA calls made with dynamic
registration

XA calls made without dynamic
registration

MQCMIT ( with ax_reg being called
during the current global unit of
work)

xa_end
xa_prepare
xa_commit
xa_rollback

Not applicable. No calls are made to
ax_reg in non-dynamic mode.

MQBACK ( without ax_reg being
called during the current global unit
of work)

No XA calls xa_end
xa_rollback

MQBACK ( with ax_reg being called
during the current global unit of
work)

xa_end
xa_rollback

Not applicable. No calls are made to
ax_reg in non-dynamic mode.

MQDISC, where MQCMIT or
MQBACK was called first. If they
were not, MQCMIT processing is first
done during MQDISC.

xa_close xa_close

Notes:

1. For MQCMIT, xa_commit is called if xa_prepare is successful. Otherwise, xa_rollback is called.

Scenario 2: Other software provides the coordination
In scenario 2, an external transaction manager coordinates global units of work, starting and committing
them under control of the transaction manager's API. The MQBEGIN, MQCMIT, and MQBACK verbs are
unavailable.

This section describes this scenario, including:
v “External sync point coordination”
v “Using CICS” on page 74
v “Using the Microsoft Transaction Server (COM+)” on page 78

 
The IBM MQ client for HP Integrity NonStop Server can use the HP NonStop Transaction

Management Facility (TMF) to coordinate global units of work. For more information, see Using HP
NonStop TMF.

External sync point coordination
A global unit of work can also be coordinated by an external X/Open XA-compliant transaction manager.
Here the IBM MQ queue manager participates in, but does not coordinate, the unit of work.

The flow of control in a global unit of work coordinated by an external transaction manager is as follows:
1. An application tells the external sync point coordinator (for example, TXSeries ) that it wants to start

a transaction.
2. The sync point coordinator tells known resource managers, such as IBM MQ, about the current

transaction.
3. The application issues calls to resource managers associated with the current transaction. For example,

the application could issue MQGET calls to IBM MQ.
4. The application issues a commit or backout request to the external sync point coordinator.
5. The sync point coordinator completes the transaction by issuing the appropriate calls to each resource

manager, typically using two-phase commit protocols.
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The supported levels of external sync point coordinators that can provide a two-phase commit process for
transactions in which IBM MQ participates are defined at System Requirements for IBM MQ.

The rest of this section describes how to enable external units of work.

The IBM MQ XA switch structure:

Each resource manager participating in an externally coordinated unit of work must provide an XA
switch structure. This structure defines both the capabilities of the resource manager and the functions
that are to be called by the sync point coordinator.

IBM MQ provides two versions of this structure:
v MQRMIXASwitch for static XA resource management
v MQRMIXASwitchDynamic for dynamic XA resource management

Consult your transaction manager documentation to determine whether to use the static or dynamic
resource management interface. Wherever a transaction manager supports it, we recommend that you use
dynamic XA resource management.

Some 64-bit transaction managers treat the long type in the XA specification as 64-bit, and some treat it as
32-bit. IBM MQ supports both models:
v If your transaction manager is 32-bit, or your transaction manager is 64-bit but treats the long type as

32-bit, use the switch load file listed in Table 5.
v If your transaction manager is 64-bit and treats the long type as 64-bit, use the switch load file listed in

Table 6 on page 73.

A list of known 64-bit transaction managers that treat the long type as 64-bit is provided in Table 7 on
page 73. Consult your transaction manager documentation if you are unsure which model your
transaction manager uses.

Table 5. XA switch load file names

Platform Switch load file name
(server)

Switch load file name
(extended transactional client)

Windows mqmxa.dll mqcxa.dll

AIX® (nonthreaded) libmqmxa.a libmqcxa.a

AIX (threaded) libmqmxa_r.a libmqcxa_r.a

HP-UX (nonthreaded) libmqmxa.so libmqcxa.so

HP-UX (threaded) libmqmxa_r.so libmqcxa_r.so

Linux (nonthreaded) libmqmxa.so libmqcxa.so

Linux (threaded) libmqmxa_r.so libmqcxa_r.so

Solaris libmqmxa.so libmqcxa.so
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Table 6. Alternative 64-bit XA switch load file names

Platform Switch load file name
(server)

Switch load file name
(extended transactional client)

AIX (nonthreaded) libmqmxa64.a libmqcxa64.a

AIX (threaded) libmqmxa64_r.a libmqcxa64_r.a

HP-UX (nonthreaded) libmqmxa64.so libmqcxa64.so

HP-UX (threaded) libmqmxa64_r.so libmqcxa64_r.so

Linux (nonthreaded) libmqmxa64.so libmqcxa64.so

Linux (threaded) libmqmxa64_r.so libmqcxa64_r.so

Solaris libmqmxa64.so libmqcxa64.so

Table 7. 64-bit transaction managers that require the alternative 64-bit switch load file

Transaction Manager

Tuxedo

Some external sync point coordinators (not CICS ) require that each resource manager participating in a
unit of work supplies its name in the name field of the XA switch structure. The IBM MQ resource
manager name is MQSeries_XA_RMI.

The sync point coordinator defines how the IBM MQ XA switch structure links to it. Information about
linking the IBM MQ XA switch structure with CICS is provided in “Using CICS” on page 74. For
information about linking the IBM MQ XA switch structure with other XA-compliant sync point
coordinators, consult the documentation supplied with those products.

The following considerations apply to using IBM MQ with all XA-compliant sync point coordinators:
v It is expected that the transaction manager library code (running as part of their API that the

application programmer has called) will call xa_open into IBM MQ at some point, before calling
MQCONN.
The xa_open call must be made on the same thread where the MQCONN call is made. The reason for
this requirement, is that the XA specification requires that the thread is used to imply context.
Note that this is the approach taken in sample program amqstxsx.c. This sample program assumes that
an xa_open call is made into IBM MQ, from the library code of the transaction manager, within their
function tpopen).
If no xa_open call is made on the same thread, before the MQCONN call, then the IBM MQ queue
manager connection will not be associated with an XA context.
For more information, see MQCTL.

v The xa_info structure passed on any xa_open call by the sync point coordinator includes the name of
an IBM MQ queue manager. The name takes the same form as the queue manager name passed to the
MQCONN call. If the name passed on the xa_open call is blank, the default queue manager is used.
Alternatively, the xa_info structure can contain values for the TPM and AXLIB parameters. The TPM
parameter specifies the transaction manager being used. The valid values are CICS, TUXEDO and
ENCINA. The AXLIB parameter specifies the name of the library that contains the transaction
manager's ax_reg and ax_unreg functions. For more information on these parameters, see Configuring
an extended transactional client. If the xa_info structure contains either of these parameters, the queue
manager name is specified in the QMNAME parameter, unless the default queue manager is being
used.

v Only one queue manager at a time can participate in a transaction coordinated by an instance of an
external sync point coordinator. The sync point coordinator is effectively connected to the queue
manager, and is subject to the rule that only one connection at a time is supported.
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v All applications that include calls to an external sync point coordinator can connect only to the queue
manager that is participating in the transaction managed by the external coordinator (because they are
already effectively connected to that queue manager). However, such applications must issue an MQCONN
call to obtain a connection handle, and an MQDISC call before they exit.

v A queue manager with resource updates coordinated by an external sync point coordinator must start
before the external sync point coordinator. Similarly, the sync point coordinator must end before the
queue manager.

v If your external sync point coordinator terminates abnormally, stop and restart your queue manager
before restarting the sync point coordinator to ensure that any messaging operations uncommitted at
the time of the failure are properly resolved.

Using CICS
CICS is one of the elements of TXSeries.

The versions of TXSeries that are XA-compliant (and use a two-phase commit process) are defined in the
System Requirements for IBM MQ information.

IBM MQ also supports other transaction managers. See the System Requirements for IBM MQ web page
for links to information about supported software.

Requirements of the two-phase commit process:

Requirements of the two-phase commit process when you use the CICS two-phase commit process with
IBM MQ. These requirements do not apply to z/OS®.

Note the following requirements:
v IBM MQ and CICS must reside on the same physical machine.
v IBM MQ does not support CICS on an IBM MQ MQI client.
v You must start the queue manager, with its name specified in the XAD resource definition stanza,

before you attempt to start CICS. Failure to do this will prevent you from starting CICS if you have
added an XAD resource definition stanza for IBM MQ to the CICS region.

v Only one IBM MQ queue manager can be accessed at a time from a single CICS region.
v A CICS transaction must issue an MQCONN request before it can access IBM MQ resources. The MQCONN

call must specify the name of the IBM MQ queue manager specified on the XAOpen entry of the XAD
resource definition stanza for the CICS region. If this entry is blank, the MQCONN request must specify
the default queue manager.

v A CICS transaction that accesses IBM MQ resources must issue an MQDISC call from the transaction
before returning to CICS. Failure to do this might mean that the CICS application server is still
connected, leaving queues open. Additionally, if you do not install a task termination exit (see “Sample
task termination exit” on page 77 ), the CICS application server might later end abnormally, perhaps
during a subsequent transaction.

v You must ensure that the CICS user ID (cics) is a member of the mqm group, so that the CICS code
has the authority to call IBM MQ.
For transactions running in a CICS environment, the queue manager adapts its methods of
authorization and determining context as follows:
– The queue manager queries the user ID under which CICS runs the transaction. This is the user ID

checked by the Object Authority Manager, and is used for context information.
– In the message context, the application type is MQAT_CICS.
– The application name in the context is copied from the CICS transaction name.
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General XA support:

General XA is not supported on IBM i. An XA switch load module is provided to enable you to link
CICS with IBM MQ on UNIX and Linux systems. Additionally, sample source code files are provided to
enable you to develop the XA switches for other transaction messages.

The names of the switch load modules provided are:

Table 8. Essential code for CICS applications: XA initialization routine

C (source) C (exec) - add one of the following to your
XAD.Stanza

amqzscix.c amqzsc -
TXSeries for
AIX, Version 5.1,
amqzsc -
TXSeries for HP-UX, Version 5.1
amqzsc -
TXSeries for Sun Solaris, Version 5.1

amqzscin.c mqmc4swi -
TXSeries for
Windows, Version 5.1

Building libraries for use with TXSeries for Multiplatforms:

Use this information when building libraries for use with TXSeries for Multiplatforms.

Pre-built switch load files are shared libraries (called DLLs on the Windows system) that you can use with
CICS programs, which require a 2-phase commit transaction by using the XA protocol. The names of
these pre-built libraries are in the table Essential code for CICS applications: XA initialization routine.
Sample source code is also supplied in the following directories:

Table 9. Installation directories on Windows, UNIX and Linux operating systems

Platform Directory Source file

UNIX and Linux MQ_INSTALLATION_PATH/samp/ amqzscix.c

Windows MQ_INSTALLATION_PATH\Tools\c\
Samples

amqzscin.c

where MQ_INSTALLATION_PATH is the directory in which you installed IBM MQ.

To build the switch load file from the sample source, follow the instructions appropriate for your
operating system:

AIX
Issue the following command:

export MQM_HOME=/usr/mqm
echo "amqzscix" > tmp.exp
xlc_r $MQM_HOME/samp/amqzscix.c -I/usr/lpp/cics/include -I$MQM_HOME/inc -e amqzscix -bE:tmp.exp -bM:SRE

-o amqzsc /usr/lpp/cics/lib/regxa_swxa.o -L$MQM_HOME/lib -L/usr/lpp/cics/lib -lcicsrt -lEncina
-lEncServer -lpthreads -lsarpc -lmqmcics_r -lmqmxa_r -lmqzi_r -lmqmcs_r

rm tmp.exp

Solaris
Issue the following command:

/opt/SUNWspro/bin/cc -s -l/opt/encina/include amqzscix.c -G -o amqzscix -e
CICS_XA_Init -L MQ_INSTALLATION_PATH/lib -L/opt/encina/lib
-L/opt/dcelocal/lib /opt/cics/lib/reqxa_swxa.o
-lmqmcics -lmqmxa -lmqzi -lmqmcs -lmqmzse -lcicsrt -lEncina -lEncSfs -ldce
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HP-UX
Issue the following command:

cc -c -s -I/opt/encina/include MQ_INSTALLATION_PATH/samp/amqzscix.c -Aa +z -o amqzscix.o ld -b
-o amqzscix amqzscix.o /opt/cics/lib/regxa_swxa.o +e CICS_XA_Init \
-L MQ_INSTALLATION_PATH/lib -L/opt/encina/lib -L/opt/cics/lib
-lmqmxa_r -lmqzi_r -lmqmcs_r -lmqmzse -ldbm -lc -lm

Linux platforms
Issue the following command:

gcc -m32 -shared -fPIC -o amqzscix amqzscix.c
\-IMQ_INSTALLATION_PATH/inc -I CICS_INSTALLATION_PATH/include
\-LMQ_INSTALLATION_PATH/lib -Wl,-rpath=MQ_INSTALLATION_PATH/lib
\-Wl,-rpath=/usr/lib -Wl,-rpath-link,/usr/lib -Wl,--no-undefined
-Wl,--allow-shlib-undefined \-L CICS_LIB_PATH/regxa_swxa.o \-lpthread -ldl -lc
-shared -lmqzi_r -lmqmxa_r -lmqmcics_r -ldl -lc

Windows
Follow these steps:
1. Use the cl command to build amqzscin.obj by compiling at least the following variables:

cl.exe -c -I EncinaPath\include -I MQ_INSTALLATION_PATH\include -Gz -LD amqzscin.c

2. Create a module definition file named mqmc1415.def, which contains the following lines:
LIBRARY MQMC4SWI
EXPORTS
CICS_XA_Init

3. Use the lib command to build an export file and an import library by using at least the following
option:
lib -def:mqmc4swi.def -out:mqmc4swi.lib

If the lib command is successful then an mqmc4swi.exp file is also built.
4. Use the link command to build mqmc4swi.dll by using at least the following option:

link.exe -dll -nod -out:mqmc4swi.dll
amqzscin.obj CicsPath\lib\regxa_swxa.obj
mqmc4swi.exp mqmcics4.lib
CicsPath\lib\libcicsrt.lib
DcePath\lib\libdce.lib DcePath\lib\pthreads.lib
EncinaPath\lib\libEncina.lib
EncinaPath\lib\libEncServer.lib
msvcrt.lib kernel32.lib

IBM MQ XA support and Tuxedo:

IBM MQ on Windows, UNIX and Linux systems can block Tuxedo-coordinated XA applications
indefinitely in xa_start.

This can occur only when two or more processes coordinated by Tuxedo in a single global transaction
attempt to access IBM MQ using the same transaction branch ID (XID). If Tuxedo gives each process in
the global transaction a different XID to use with IBM MQ, this cannot occur.

To avoid the problem, configure each application in Tuxedo that accesses IBM MQ under a single global
transaction ID (gtrid), within its own Tuxedo server group. Processes in the same server group use the
same XID when accessing resource managers on behalf of a single gtrid, and are therefore vulnerable to
blocking in xa_start in IBM MQ. Processes in different server groups use separate XIDs when accessing
resource managers and so do not have to serialize their transaction work in IBM MQ.
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Enabling the CICS two-phase commit process:

To enable CICS to use a two-phase commit process to coordinate transactions that include MQI calls, add
a CICS XAD resource definition stanza entry to the CICS region. Note, this topic is not applicable to
z/OS.

Here is an example of adding an XAD stanza entry for IBM MQ for Windows, where Drive is the drive
where IBM MQ is installed (for example, D:).
cicsadd -cxad -rcics_region \

ResourceDescription="MQM XA Product Description" \
SwitchLoadFile="Drive:\Program Files\IBM\WebSphere MQ\bin\mqmc4swi.dll" \
XAOpen=queue_manager_name

For extended transactional clients, use the switch load file mqcc4swi.dll.

Here is an example of adding an XAD stanza entry for IBM MQ for UNIX and Linux systems, where
MQ_INSTALLATION_PATH represents the high-level directory in which IBM MQ is installed:
cicsadd -cxad -rcics_region \

ResourceDescription="MQM XA Product Description" \
SwitchLoadFile="MQ_INSTALLATION_PATH/lib/amqzsc" \
XAOpen=queue_manager_name

For extended transactional clients, use the switch load file amqczsc.

For information about using the cicsadd command, see the CICS Administration Reference, or CICS
Administration Guide for your platform.

Calls to IBM MQ can be included in a CICS transaction, and the IBM MQ resources will be committed or
rolled back as directed by CICS. This support is not available to client applications.

You must issue an MQCONN from your CICS transaction in order to access IBM MQ resources, followed by
a corresponding MQDISC on exit.

Enabling CICS user exits:

A CICS user exit point (normally referred to as a user exit ) is a place in a CICS module at which CICS can
transfer control to a program that you have written (a user exit program ), and at which CICS can resume
control when your exit program has finished its work.

Before using a CICS user exit, read the CICS Administration Guide for your platform.

Sample task termination exit:

IBM MQ supplies sample source code for a CICS task termination exit.

The sample source code is in the following directories:

Table 10. CICS task termination exits

Platform Directory Source file

UNIX and Linux systems MQ_INSTALLATION_PATH/samp amqzscgx.c

Windows MQ_INSTALLATION_PATH\Tools\c\
Samples

amqzscgn.c

MQ_INSTALLATION_PATH represents the high-level directory in which IBM MQ is installed.
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The build instructions for the sample task termination exit are contained in the comments in each source
file.

This exit is invoked by CICS at normal and abnormal task termination (after any sync point has been
taken). No recoverable work is permitted in the exit program.

These functions are only used in an IBM MQ and CICS context in which the CICS version supports the
XA interface. CICS refers to these libraries as programs or user exits.

CICS has a number of user exits and amqzscgx, if used, is defined and enabled on CICS as the Task
termination user exit (UE014015), that is, exit number 15.

When the task termination exit is called by CICS, CICS has already informed IBM MQ of the task's
termination state and IBM MQ has taken the appropriate action (commit or rollback). All the exit does is
to issue an MQDISC to clean up.

One purpose of installing and configuring your CICS system to use a task termination exit is to protect
your system against some of the consequences of faulty application code. For example, if your CICS
transaction ends abnormally without first calling MQDISC, and has no task termination exit installed,
then you might see (within around 10 seconds) a subsequent unrecoverable failure of the CICS region.
This is because IBM MQ health thread, which runs in the cicsas process, will not have been posted and
given time to clean up and return. The symptoms might be that the cicsas process ends immediately,
having written FFST reports to /var/mqm/errors or the equivalent location on Windows.

Using the Microsoft Transaction Server (COM+)
COM+ ( Microsoft Transaction Server) is designed to help users run business logic applications in a
typical middle tier server.

See Features that can be used only with the primary installation on Windows for important information.

COM+ divides work up into activities, which are typically short independent chunks of business logic,
such as transfer funds from account A to account B. COM+ relies heavily on object orientation and in
particular on COM; loosely a COM+ activity is represented by a COM (business) object.

COM+ is an integrated part of the operating system.

COM+ provides three services to the business object administrator, removing much of the worry from the
business object programmer:
v Transaction management
v Security
v Resource pooling

You usually use COM+ with front-end code that is a COM client to the objects held within COM+, and
back-end services such as a database, with IBM MQ bridging between the COM+ business object and the
back-end.

The front-end code can be a stand-alone program, or an Active Server Page (ASP) hosted by the
Microsoft Internet Information Server (IIS). The frontend code can be on the same computer as COM+
and its business objects, with connection through COM. Alternatively, the frontend code can be on a
different computer, with connection through DCOM. You can use different clients to access the same
COM+ business object in different situations.

The backend code can be on the same computer as COM+ and its business objects, or on a different
computer with connection through any of the IBM MQ supported protocols.
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Expiring global units of work
The queue manager can be configured to expire global units of work after a pre-configured interval of
inactivity.

 
To enable this behavior, set the following environment variables:

v AMQ_TRANSACTION_EXPIRY_RESCAN=rescan interval in milliseconds

v AMQ_XA_TRANSACTION_EXPIRY=timeout interval in milliseconds

Attention: The environment variables only affect transactions that are in Idle state in table 6-4 of the XA
Specification, which is available from Publications at The OPEN Group.

That is, transactions that are not associated on any application thread, but for which the external
Transaction Manager software has not yet called the xa_prepare function call.

 
External transaction managers keep only a log of transactions that are prepared,

committed, or rolled back. If the external transaction manager goes down for any reason, on its return it
drives prepared, committed, and rolled back transactions to completion but any active transactions that
have yet to be prepared become orphaned. To avoid this, set the AMQ_XA_TRANSACTION_EXPIRY to allow for
the expected interval between an application making MQI transactional API calls and completing the
transaction, having carried out transactional work on other resource managers.

 
To ensure a timely cleanup after the AMQ_XA_TRANSACTION_EXPIRY expires, set the

AMQ_TRANSACTION_EXPIRY_RESCAN value to a lower value than the AMQ_XA_TRANSACTION_EXPIRY interval,
ideally so that the rescan occurs more than once within the AMQ_XA_TRANSACTION_EXPIRY interval.

Unit of recovery disposition
IBM MQ for z/OS provides unit of recovery dispositions. This feature allows you to configure whether
the second phase of 2-phase commit transactions can be driven, for example, during recovery, when
connected to another queue manager within the same queue-sharing group (QSG).

IBM MQ for z/OS V7.0.1 and later supports the unit of recovery disposition.

Unit of recovery disposition
The unit of recovery disposition is related to an application's connection and subsequently any
transactions that it starts. There are two possible unit of recovery dispositions.
v A GROUP unit of recovery disposition identifies that a transactional application is logically

connected to the queue-sharing group and does not have an affinity to any specific queue
manager. Any 2-phase commit transactions that it starts that have completed phase-1 of the
commit process, that is, they are in doubt, can be inquired and resolved, when connected to
any queue manager within the QSG. In a recovery scenario this means that the transaction
coordinator does not have to reconnect to the same queue manager, which might be
unavailable.

v A QMGR unit of recovery disposition identifies that an application has a direct affinity to the
queue manager to which it is connected and any transactions that it starts also have this
disposition.
In a recovery scenario the transaction coordinator must reconnect to the same queue manager
to inquire, and resolve, any in-doubt transactions, irrespective of whether the queue manager
belongs to a queue-sharing group.

z/OS

 
See Unit of recovery disposition for details how to implement this feature.
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Security scenarios
A set of scenarios that demonstrate applying security to different configurations.

The available security scenarios are described in the following subtopics:
Related information:

z/OS Setting up security on z/OS

Security scenario: two queue managers on z/OS
In this scenario, an application uses the MQPUT1 call to put messages to queues on queue manager QM1.
Some of the messages are then forwarded to queues on QM2, using TCP and LU 6.2 channels. The TCP
channels can either use SSL/TLS or not. The application could be a batch application or a CICS
application, and the messages are put using the MQPMO_SET_ALL_CONTEXT option.

This is illustrated in Figure 15.

The following assumptions are made about the queue managers:
v All the required IBM MQ definitions have been predefined or have been made through the CSQINP2

data set processed at queue manager startup.
If they have not, you need the appropriate access authority to the commands needed to define these
objects.

v All the RACF® profiles required have been defined and appropriate access authorities have been
granted, before the queue manager and channel initiators started.
If they have not, you need the appropriate authority to issue the RACF commands required to define
all the profiles needed and grant the appropriate access authorities to those profiles. You also need the
appropriate authority to issue the MQSC security commands to start using the new security profiles.

v All digital certificates required have been created and connected to key rings. The digital certificate
sent by QM1 as part of the SSL/TLS handshake is recognized by RACF on QM2's system, either
because it is also installed in that RACF profile, or because a matching Certificate Name File (CNF)
filter exists.

LQ1

RQA

RQB

RQC

QM1.TO.QM2.TCP

QM1.TO.QM2.LU62

QM1.TO.QM2.SSL

TCP

LU 6.2
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MQPUT1

MQPUT1

MQPUT1
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Figure 15. Example security scenario
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Related information:

z/OS Setting up security on z/OS

Security switch settings for two queue manager scenario
Switch settings and RACF profiles.

The following security switches are set for both queue managers:
v Subsystem security on
v Queue security on
v Alternate user security on
v Context security on
v Process security off
v Namelist security off
v Topic security off
v Connection security on
v Command security on
v Command resource security on

The following profiles are defined in the MQADMIN class to turn off process, namelist and topicsecurity:
QM1.NO.PROCESS.CHECKS
QM1.NO.NLIST.CHECKS
QM1.NO.TOPIC.CHECKS
QM2.NO.PROCESS.CHECKS
QM2.NO.NLIST.CHECKS
QM2.NO.TOPIC.CHECKS

Queue manager QM1 in two queue manager scenario
Queues and channels for QM1.

The following queues are defined on queue manager QM1:

LQ1 A local queue.

RQA A remote queue definition, with the following attributes:
v RNAME(LQA)
v RQMNAME(QM2)
v XMITQ(QM1.TO.QM2.TCP)

RQB A remote queue definition, with the following attributes:
v RNAME(LQB)
v RQMNAME(QM2)
v XMITQ(QM1.TO.QM2.LU62)

RQC A remote queue definition, with the following attributes:
v RNAME(LQC)
v RQMNAME(QM2)
v XMITQ(QM1.TO.QM2.TLS)

QM1.TO.QM2.TCP
A transmission queue.

QM1.TO.QM2.LU62
A transmission queue.
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QM1.TO.QM2.TLS
A transmission queue.

The following channels are defined on QM1:

QM1.TO.QM2.TCP
A sender channel definition, with the following attributes:
v CHLTYPE(SDR)
v TRPTYPE(TCP)
v XMITQ(QM1.TO.QM2.TCP)
v CONNAME(QM2TCP)

QM1.TO.QM2.LU62
A sender channel definition, with the following attributes:
v CHLTYPE(SDR)
v TRPTYPE(LU62)
v XMITQ(QM1.TO.QM2.LU62)
v CONNAME(QM2LU62)

(See Security considerations for the channel initiator on z/OS for information about setting up
APPC security.)

QM1.TO.QM2.TLS
A sender channel definition, with the following attributes:
v CHLTYPE(SDR)
v TRPTYPE(TCP)
v XMITQ(QM1.TO.QM2.TLS)
v CONNAME(QM2TCP)
v SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA256)

Queue manager QM2 in two queue manager scenario
Queues and channels for QM2.

The following queues have been defined on queue manager QM2:

LQA A local queue.

LQB A local queue.

LQC A local queue.

DLQ A local queue that is used as the dead-letter queue.

The following channels have been defined on QM2:

QM1.TO.QM2.TCP
A receiver channel definition, with the following attributes:
v CHLTYPE(RCVR)
v TRPTYPE(TCP)
v PUTAUT(CTX)
v MCAUSER(MCATCP)

QM1.TO.QM2.LU62
A receiver channel definition, with the following attributes:
v CHLTYPE(RCVR)
v TRPTYPE(LU62)
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v PUTAUT(CTX)
v MCAUSER(MCALU62)

(See Security considerations for the channel initiator on z/OS for information about setting up
APPC security.)

QM1.TO.QM2.TLS
A receiver channel definition, with the following attributes:
v CHLTYPE(RCVR)
v TRPTYPE(TCP)
v PUTAUT(CTX)
v MCAUSER(MCASSL)
v SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA256)

User IDs used in two queue manager scenario
Explanation of the user IDs in the scenario.

The following user IDs are used:

BATCHID
Batch application (Job or TSO ID)

MSGUSR
UserIdentifier in MQMD (context user ID)

MOVER1
QM1 channel initiator address space user ID

MOVER2
QM2 channel initiator address space user ID

MCATCP
MCAUSER specified on the TCP/IP without SSL/TLS receiver channel definition

MCALU62
MCAUSER specified on the LU 6.2 receiver channel definition

MCASSL
MCAUSER specified on the TCP/IP with SSL/TLS receiver channel definition

CICSAD1
CICS address space ID

CICSTX1
CICS task user ID

CERTID
The user ID associated by RACF with the flowed certificate.
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Security profiles and accesses required for the two queue manager scenario
Information about the security profiles and accesses required for either a batch or CICS implementation
of the two queue manager scenario.

The following table shows the security profiles that are required to enable the two queue manager
scenario to work. Additional security profiles are also needed, depending on whether you are doing a
batch or a CICS implementation of the scenario. For further information see “Security profiles required
for a batch application” on page 85 and “Security profiles required for a CICS application” on page 87.

Table 11. Security profiles for the example scenario.

The four columns in this table show the class, the profile, the user ID, and access for the two queue manager
scenario.

Class Profile User ID Access

MQCONN QM1.CHIN MOVER1 READ

MQADMIN QM1.RESLEVEL BATCHID
CICSAD1
MOVER1

NONE

MQADMIN QM1.CONTEXT.** MOVER1 CONTROL

MQQUEUE QM1.SYSTEM.COMMAND.INPUT MOVER1 UPDATE

MQQUEUE QM1.SYSTEM.CHANNEL.SYNCQ MOVER1 UPDATE

MQQUEUE QM1.SYSTEM.CHANNEL.INITQ MOVER1 UPDATE

MQQUEUE QM1.SYSTEM.COMMAND.REPLY.MODEL MOVER1 UPDATE

MQQUEUE QM1.SYSTEM.ADMIN.CHANNEL.EVENT MOVER1 UPDATE

MQQUEUE QM1.QM1.TO.QM2.TCP MOVER1 ALTER

MQQUEUE QM1.QM1.TO.QM2.LU62 MOVER1 ALTER

MQQUEUE QM1.QM1.TO.QM2.TLS MOVER1 ALTER

MQCONN QM2.CHIN MOVER2 READ

MQADMIN QM2.RESLEVEL MOVER2 NONE

MQADMIN QM2.CONTEXT.** MOVER2 CONTROL

MQQUEUE QM2.SYSTEM.COMMAND.INPUT MOVER2 UPDATE

MQQUEUE QM2.SYSTEM.CHANNEL.SYNCQ MOVER2 UPDATE

MQQUEUE QM2.SYSTEM.CHANNEL.INITQ MOVER2 UPDATE

MQQUEUE QM2.SYSTEM.COMMAND.REPLY.MODEL MOVER2 UPDATE

MQQUEUE QM2.SYSTEM.ADMIN.CHANNEL.EVENT MOVER2 UPDATE

MQQUEUE QM2.DLQ MOVER2 UPDATE
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Security profiles required for a batch application:

Additional security profiles required for a batch implementation of the two queue manager scenario.

The batch application runs under user ID BATCHID on QM1. It connects to queue manager QM1 and
puts messages to the following queues:
v LQ1
v RQA
v RQB
v RQC

It uses the MQPMO_SET_ALL_CONTEXT option. The alternate user ID found in the UserIdentifier
field of the message descriptor (MQMD) is MSGUSR.

The following profiles are required on queue manager QM1:

Table 12. Sample security profiles for the batch application on queue manager QM1

Class Profile User ID Access

MQCONN QM1.BATCH BATCHID READ

MQADMIN QM1.CONTEXT.** BATCHID CONTROL

MQQUEUE QM1.LQ1 BATCHID UPDATE

MQQUEUE QM1.RQA BATCHID UPDATE

MQQUEUE QM1.RQB BATCHID UPDATE

MQQUEUE QM1.RQC BATCHID UPDATE

The following profiles are required on queue manager QM2 for messages put to queue RQA on queue
manager QM1 (for the TCP/IP channel not using TLS):

Table 13. Sample security profiles for queue manager QM2 using TCP/IP and not TLS

Class Profile User ID Access

MQADMIN QM2.ALTERNATE.USER.MSGUSR MCATCP MOVER2 UPDATE

MQADMIN QM2.CONTEXT.** MCATCP MOVER2 CONTROL

MQQUEUE QM2.LQA MOVER2 MSGUSR UPDATE

MQQUEUE QM2.DLQ MOVER2 MSGUSR UPDATE

Notes:

1. The user ID passed in the MQMD of the message is used as the user ID for the MQPUT1 on queue
manager QM2 because the receiver channel was defined with PUTAUT(CTX) and
MCAUSER(MCATCP).

2. The MCAUSER field of the receiver channel definition is set to MCATCP; this user ID is used in
addition to the channel initiator address space user ID for the checks carried out against the alternate
user ID and context profile.

3. The MOVER2 user ID and the UserIdentifier in the message descriptor (MQMD) are used for the
resource checks against the queue.

4. The MOVER2 and MSGUSR user IDs both need access to the dead-letter queue so that messages that
cannot be put to the destination queue can be sent there.

5. Two user IDs are checked on all three checks performed because RESLEVEL is set to NONE.
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The following profiles are required on queue manager QM2 for messages put to queue RQB on queue
manager QM1 (for the LU 6.2 channel):

Table 14. Sample security profiles for queue manager QM2 using LU 6.2

Class Profile User ID Access

MQADMIN QM2.ALTERNATE.USER.MSGUSR MCALU62 MOVER1 UPDATE

MQADMIN QM2.CONTEXT.** MCALU62 MOVER1 CONTROL

MQQUEUE QM2.LQB MOVER1 MSGUSR UPDATE

MQQUEUE QM2.DLQ MOVER1 MSGUSR UPDATE

Notes:

1. The user ID passed in the MQMD of the message is used as the user ID for the MQPUT1 on queue
manager QM2 because the receiver channel was defined with PUTAUT(CTX) and
MCAUSER(MCALU62).

2. The MCA user ID is set to the value of the MCAUSER field of the receiver channel definition
(MCALU62).

3. Because LU 6.2 supports security on the communications system for the channel, the user ID received
from the network is used as the channel user ID (MOVER1).

4. Two user IDs are checked on all three checks performed because RESLEVEL is set to NONE.
5. MCALU62 and MOVER1 are used for the checks performed against the alternate user ID and Context

profiles, and MSGUSR and MOVER1 are used for the checks against the queue profile.
6. The MOVER1 and MSGUSR user IDs both need access to the dead-letter queue so that messages that

cannot be put to the destination queue can be sent there.

The following profiles are required on queue manager QM2 for messages put to queue RQC on queue
manager QM1 (for the TCP/IP channel using TLS):

Table 15. Sample security profiles for queue manager QM2 using TCP/IP and TLS

Class Profile User ID Access

MQADMIN QM2.ALTERNATE.USER.MSGUSR MCASSL CERTID UPDATE

MQADMIN QM2.CONTEXT.** MCASSL CERTID CONTROL

MQQUEUE QM2.LQC CERTID MSGUSR UPDATE

MQQUEUE QM2.DLQ CERTID
MSGUSR

UPDATE

Notes:

1. The user ID passed in the MQMD of the message is used as the user ID for the MQPUT1 on queue
manager QM2 because the receiver channel was defined with PUTAUT(CTX) and
MCAUSER(MCASSL).

2. The MCA user ID is set to the value of the MCAUSER field of the receiver channel definition
(MCASSL).

3. Because the certificate flowed by the channel from QM1 as part of the TLS handshake might be
installed on QM2's system, or might match a certificate name filter on QM2's system, the user ID
found during that matching is used as the channel user ID (CERTID).

4. Two user IDs are checked on all three checks performed because RESLEVEL is set to NONE.
5. MCASSL and CERTID are used for the checks performed against the alternate user ID and Context

profiles, and MSGUSR and MOVER1 are used for the checks against the queue profile.
6. The CERTID and MSGUSR user IDs both need access to the dead-letter queue so that messages that

cannot be put to the destination queue can be sent there.
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Security profiles required for a CICS application:

Additional security profiles required for a CICS implementation of the two queue manager scenario.

The CICS application uses a CICS address space user ID of CICSAD1 and a CICS task user ID of
CICSTX1. The security profiles required on queue manager QM1 are different from those profiles
required for the batch application. The profiles required on queue manager QM2 are the same as for the
batch application.

The following profiles are required on queue manager QM1:

Table 16. Sample security profiles for the CICS application on queue manager QM1

Class Profile User ID Access

MQCONN QM1.CICS CICSAD1 READ

MQADMIN QM1.CONTEXT.** CICSAD1 CICSTX1 CONTROL

MQQUEUE QM1.LQ1 CICSAD1 CICSTX1 UPDATE

MQQUEUE QM1.RQA CICSAD1 CICSTX1 UPDATE

MQQUEUE QM1.RQB CICSAD1 CICSTX1 UPDATE

Security scenario: queue-sharing group on z/OS
In this scenario, an application uses the MQPUT1 call to put messages to queues on queue manager QM1.
Some of the messages are then forwarded to queues on QM2, using TCP and LU 6.2 channels. The
application is a batch application, and the messages are put using the MQPMO_SET_ALL_CONTEXT
option.

This is illustrated in Figure 15 on page 80.

The following assumptions are made about the queue managers:
v All the required IBM MQ definitions have been predefined or have been made through the CSQINP2

data set processed at queue manager startup.
If they have not, you need the appropriate access authority to the commands needed to define these
objects.

v All the RACF profiles required have been defined and appropriate access authorities have been
granted, before the queue manager and channel initiators started.
If they have not, you need the appropriate authority to issue the RACF commands required to define
all the profiles needed and grant the appropriate access authorities to those profiles. You also need the
appropriate authority to issue the MQSC security commands to start using the new security profiles.
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Related information:

z/OS Setting up security on z/OS

Security switch settings for queue-sharing group scenario
Switch settings and RACF profiles.

The following security switches are set for the queue-sharing group:
v Subsystem security on
v Queue-sharing group security on
v Queue manager security off
v Queue security on
v Alternate user security on
v Context security on
v Process security off
v Namelist security off
v Topic security off
v Connection security on
v Command security on
v Command resource security on

The following profiles are defined in the MQADMIN class to turn process, namelist, topic and queue
manager level security off:

Queue manager QM1 in queue-sharing group scenario
Queues and channels for QM1.

The following queues are defined on queue manager QM1:

LQ1 A local queue.

RQA A remote queue definition, with the following attributes:
v RNAME(LQA)
v RQMNAME(QM2)
v XMITQ(QM1.TO.QM2.TCP)

RQB A remote queue definition, with the following attributes:
v RNAME(LQB)
v RQMNAME(QM2)
v XMITQ(QM1.TO.QM2.LU62)

QM1.TO.QM2.TCP
A transmission queue.

QM1.TO.QM2.LU62
A transmission queue.

The following channels are defined on QM1:

QSGA.NO.PROCESS.CHECKS
QSGA.NO.NLIST.CHECKS
QSGA.NO.TOPIC.CHECKS
QSGA.NO.QMGR.CHECKS
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QM1.TO.QM2.TCP
A sender channel definition, with the following attributes:
v CHLTYPE(SDR)
v TRPTYPE(TCP)
v XMITQ(QM1.TO.QM2.TCP)
v CONNAME(QM2TCP)

QM1.TO.QM2.LU62
A sender channel definition, with the following attributes:
v CHLTYPE(SDR)
v TRPTYPE(LU62)
v XMITQ(QM1.TO.QM2.LU62)
v CONNAME(QM2LU62)

(See Security considerations for the channel initiator on z/OS for information about setting up
APPC security.)

Queue manager QM2 in queue-sharing group scenario
Queues and channels for QM2.

The following queues have been defined on queue manager QM2:

LQA A local queue.

LQB A local queue.

DLQ A local queue that is used as the dead-letter queue.

The following channels have been defined on QM2:

QM1.TO.QM2.TCP
A receiver channel definition, with the following attributes:
v CHLTYPE(RCVR)
v TRPTYPE(TCP)
v PUTAUT(CTX)
v MCAUSER(MCATCP)

QM1.TO.QM2.LU62
A receiver channel definition, with the following attributes:
v CHLTYPE(RCVR)
v TRPTYPE(LU62)
v PUTAUT(CTX)
v MCAUSER(MCALU62)

(See Security considerations for the channel initiator on z/OS for information about setting up
APPC security.)
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User IDs used in queue-sharing group scenario
Explanation of the user IDs in the scenario.

The following user IDs are used:

BATCHID
Batch application (Job or TSO ID)

MSGUSR
UserIdentifier in MQMD (context user ID)

MOVER1
QM1 channel initiator address space user ID

MOVER2
QM2 channel initiator address space user ID

MCATCP
MCAUSER specified on the TCP/IP receiver channel definition

MCALU62
MCAUSER specified on the LU 6.2 receiver channel definition

Security profiles and accesses required for queue-sharing group scenario
Security profiles and accesses for either a batch or CICS implementation of the queue-sharing group
scenario.

The following table shows the security profiles that are required to enable the queue-sharing group
scenario to work. A batch implementation of this scenario also requires the additional security profiles
that are described in “Security profiles required for a batch application” on page 91.

Table 17. Security profiles for the example scenario.

The four columns in this table show the class, the profile, the user ID, and access for the queue-sharing group
scenario.

Class Profile User ID Access

MQCONN QSGA.CHIN MOVER1
MOVER2

READ

MQADMIN QSGA.RESLEVEL BATCHID
MOVER1
MOVER2

NONE

MQADMIN QSGA.CONTEXT.** MOVER1
MOVER2

CONTROL

MQQUEUE QSGA.SYSTEM.COMMAND.INPUT MOVER1
MOVER2

UPDATE

MQQUEUE QSGA.SYSTEM.CHANNEL.SYNCQ MOVER1
MOVER

UPDATE

MQQUEUE QSGA.SYSTEM.CHANNEL.INITQ MOVER1
MOVER2

UPDATE

MQQUEUE QSGA.SYSTEM.COMMAND.REPLY.MODEL MOVER1
MOVER2

UPDATE

MQQUEUE QSGA.SYSTEM.ADMIN.CHANNEL.EVENT MOVER1
MOVER2

UPDATE

MQQUEUE QSGA.SYSTEM.QSG.CHANNEL.SYNCQ MOVER1
MOVER2

UPDATE
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Table 17. Security profiles for the example scenario (continued).

The four columns in this table show the class, the profile, the user ID, and access for the queue-sharing group
scenario.

Class Profile User ID Access

MQQUEUE QSGA.SYSTEM.QSG.TRANSMIT.QUEUE MOVER1
MOVER2

UPDATE

MQQUEUE QSGA.QM1.TO.QM2.TCP MOVER1 ALTER

MQQUEUE QSGA.QM1.TO.QM2.LU62 MOVER1 ALTER

MQQUEUE QSGA.DLQ MOVER2 UPDATE

Security profiles required for a batch application:

Additional security profiles required for a batch implementation of the queue-sharing group scenario.

The batch application runs under user ID BATCHID on QM1. It connects to queue manager QM1 and
puts messages to the following queues:
v LQ1
v RQA
v RQB

It uses the MQPMO_SET_ALL_CONTEXT option. The user ID found in the UserIdentifier field of the
message descriptor (MQMD) is MSGUSR.

The following profiles are required on queue manager QM1:

Table 18. Sample security profiles for the batch application on queue manager QM1

Class Profile User ID Access

MQCONN QSGA.BATCH BATCHID READ

MQADMIN QSGA.CONTEXT.** BATCHID CONTROL

MQQUEUE QSGA.LQ1 BATCHID UPDATE

MQQUEUE QSGA.RQA BATCHID UPDATE

MQQUEUE QSGA.RQB BATCHID UPDATE

The following profiles are required on queue manager QM2 for messages put to queue RQA on queue
manager QM1 (for the TCP/IP channel):

Table 19. Sample security profiles for queue manager QM2 using TCP/IP

Class Profile User ID Access

MQADMIN QSGA.ALTERNATE.USER.MSGUSR MCATCP MOVER2 UPDATE

MQADMIN QSGA.CONTEXT.** MCATCP MOVER2 CONTROL

MQQUEUE QSGA.LQA MOVER2 MSGUSR UPDATE

MQQUEUE QSGA.DLQ MOVER2 MSGUSR UPDATE

Notes:

1. The user ID passed in the MQMD of the message is used as the user ID for the MQPUT1 on queue
manager QM2 because the receiver channel was defined with PUTAUT(CTX) and
MCAUSER(MCATCP).
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2. The MCAUSER field of the receiver channel definition is set to MCATCP; this user ID is used in
addition to the channel initiator address space user ID for the checks carried out against the alternate
user ID and context profile.

3. The MOVER2 user ID and the UserIdentifier in the message descriptor (MQMD) are used for the
resource checks against the queue.

4. The MOVER2 and MSGUSR user IDs both need access to the dead-letter queue so that messages that
cannot be put to the destination queue can be sent there.

5. Two user IDs are checked on all three checks performed because RESLEVEL is set to NONE.

The following profiles are required on queue manager QM2 for messages put to queue RQB on queue
manager QM1 (for the LU 6.2 channel):

Table 20. Sample security profiles for queue manager QM2 using LU 6.2

Class Profile User ID Access

MQADMIN QSGA.ALTERNATE.USER.MSGUSR MCALU62
MOVER1

UPDATE

MQADMIN QSGA.CONTEXT.** MCALU62
MOVER1

CONTROL

MQQUEUE QSGA.LQB MOVER1
MSGUSR

UPDATE

MQQUEUE QSGA.DLQ MOVER1
MSGUSR

UPDATE

Notes:

1. The user ID passed in the MQMD of the message is used as the user ID for the MQPUT1 on queue
manager QM2 because the receiver channel was defined with PUTAUT(CTX) and
MCAUSER(MCALU62).

2. The MCA user ID is set to the value of the MCAUSER field of the receiver channel definition
(MCALU62).

3. Because LU 6.2 supports security on the communications system for the channel, the user ID received
from the network is used as the channel user ID (MOVER1).

4. Two user IDs are checked on all three checks performed because RESLEVEL is set to NONE.
5. MCALU62 and MOVER1 are used for the checks performed against the alternate user ID and Context

profiles, and MSGUSR and MOVER1 are used for the checks against the queue profile.
6. The MOVER1 and MSGUSR user IDs both need access to the dead-letter queue so that messages that

cannot be put to the destination queue can be sent there.
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Connecting two queue managers using SSL/TLS
Secure communications that use the TLS cryptographic security protocols involve setting up the
communication channels and managing the digital certificates that you will use for authentication.

To set up your SSL/TLS installation you must define your channels to use TLS. You must also obtain and
manage your digital certificates. On a test system, you can use self-signed certificates or certificates issued
by a local certificate authority (CA). On a production system, do not use self-signed certificates.

For full information about creating and managing certificates, see the following topics:

v Working with SSL or TLS on IBM i

v Working with SSL or TLS on UNIX, Linux, and Windows systems

v z/OS Working with SSL or TLS on z/OS

This collection of topics introduces the tasks involved in setting up SSL/TLS communications, and
provides step-by-step guidance on completing those tasks.

You might also want to test SSL/TLS client authentication, which are an optional part of the protocols.
During the SSL/TLS handshake, the SSL/TLS client always obtains and validates a digital certificate from
the server. With the IBM MQ implementation, the SSL/TLS server always requests a certificate from the
client.

Notes:

1. In this context, an SSL/TLS client refers to the connection initiating the handshake.

2. z/OS When a z/OS queue manager is acting in the role of an SSL/TLS client, the queue manager
sends only a certificate.

The SSL/TLS client sends a certificate only if it can find a certificate with a matching label. See Digital
certificate labels for details.

The SSL/TLS server always validates the client certificate if one is sent. If the client does not send a
certificate, authentication fails only if the end of the channel that is acting as the SSL/TLS server is
defined with either the SSLCAUTH parameter set to REQUIRED or an SSLPEER parameter has a value set. For
more information about connecting a queue manager anonymously, that is, when the SSL/TLS client does
not send a certificate, see “Connecting two queue managers using one-way authentication” on page 98.

Using self-signed certificates for mutual authentication of two queue managers
Follow these sample instructions to implement mutual authentication between two queue managers,
using self-signed TLS certificates.

About this task

Scenario:
v You have two queue managers, QM1 and QM2, which need to communicate securely. You require

mutual authentication to be carried out between QM1 and QM2.
v You have decided to test your secure communication using self-signed certificates.

The resulting configuration looks like this:
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In Figure 16, the key repository for QM1 contains the certificate for QM1 and the public certificate from
QM2. The key repository for QM2 contains the certificate for QM2 and the public certificate from QM1.

Procedure
1. Prepare the key repository on each queue manager, according to operating system:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
2. Create a self-signed certificate for each queue manager:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
3. Extract a copy of each certificate:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
4. Transfer the public part of the QM1 certificate to the QM2 system and vice versa, using a utility such

as FTP z/OS , as described in Exchanging self-signed certificates.
5. Add the partner certificate to the key repository for each queue manager:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
6. On QM1, define a sender channel and associated transmission queue, by issuing commands like the

following example:
DEFINE CHANNEL(QM1.TO.QM2) CHLTYPE(SDR) TRPTYPE(TCP) CONNAME(QM1.MACH.COM) XMITQ(QM2)
SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA) DESCR(’Sender channel using TLS from QM1 to QM2’)

DEFINE QLOCAL(QM2) USAGE(XMITQ)

This example uses CipherSpec TLS_RSA. The CipherSpecs at each end of the channel must be the
same.

7. On QM2, define a receiver channel, by issuing a command like the following example:
DEFINE CHANNEL(QM1.TO.QM2) CHLTYPE(RCVR) TRPTYPE(TCP) SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA)
SSLCAUTH(REQUIRED) DESCR(’Receiver channel using TLS from QM1 to QM2’)

The channel must have the same name as the sender channel you defined in Step 6, and use the same
CipherSpec.

transmission
queuekey repository

QM1.TO.QM2

key repository

QM1's certificate QM2's certificate

QM2's certificate QM1's certificate

QM1 QM2

QM2

Figure 16. Configuration resulting from this task
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8. Start the channel z/OS , as described in Starting the sender channel .

Results

Key repositories and channels are created as illustrated in Figure 16 on page 94

What to do next

Check that the task has been completed successfully by using DISPLAY commands. If the task was
successful, the resulting output is similar to that shown in the following examples.

From queue manager QM1, enter the following command:
DISPLAY CHS(QM1.TO.QM2) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(QM1.TO.QM2) SSLPEER SSLCERTI

4 : DISPLAY CHSTATUS(QM1.TO.QM2) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(QM1.TO.QM2) CHLTYPE(SDR)
CONNAME(9.20.25.40) CURRENT
RQMNAME(QM2)
SSLCERTI("CN=QM2,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5E:02,CN=QM2,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
STATUS(RUNNING) SUBSTATE(MQGET)
XMITQ(QM2)

From queue manager QM2, enter the following command:
DISPLAY CHS(QM1.TO.QM2) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(QM1.TO.QM2) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(QM1.TO.QM2) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(QM2.TO.QM1) CHLTYPE(RCVR)
CONNAME(9.20.35.92) CURRENT
RQMNAME(QM1)
SSLCERTI("CN=QM1,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5F:38,CN=QM1,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
STATUS(RUNNING) SUBSTATE(RECEIVE)
XMITQ( )

In each case, the value of SSLPEER must match that of the DN in the partner certificate that was created
in Step 2 on page 94. The issuers name matches the peer name because the certificate is self-signed .

SSLPEER is optional. If it is specified, its value must be set so that the DN in the partner certificate
(created in Step 2 on page 94) is allowed. For more information about the use of SSLPEER, see IBM MQ
rules for SSLPEER values.
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Using CA-signed certificates for mutual authentication of two queue managers
Follow these sample instructions to implement mutual authentication between two queue managers,
using CA-signed TLS certificates.

About this task

Scenario:
v You have two queue managers called QM1 and QM2, which need to communicate securely. You

require mutual authentication to be carried out between QM1 and QM2.
v In the future you are planning to use this network in a production environment, and therefore you

have decided to use CA-signed certificates from the beginning.

The resulting configuration looks like this:

In Figure 17, the key repository for QM1 contains QM1's certificate and the CA certificate. The key
repository for QM2 contains QM2's certificate and the CA certificate.

In this example both QM1's certificate and QM2's certificate were issued by the same CA. If QM1's
certificate and QM2's certificate were issued by different CAs then the key repositories for QM1 and QM2
must contain both CA certificates.

Procedure
1. Prepare the key repository on each queue manager, according to the operating system, or systems,

your enterprise uses:

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
2. Request a CA-signed certificate for each queue manager. You might use different CAs for the two

queue managers.

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
3. Add the Certificate Authority certificate to the key repository for each queue manager: If the Queue

managers are using different Certificate Authorities then the CA certificate for each Certificate
Authority must be added to both key repositories.

transmission
queuekey repository

TO.QMB

key repository

QMA's certificate QMB's certificate

CA certificate CA certificate

QMA QMB

QMB

Figure 17. Configuration resulting from this task
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v Do not perform this step on IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
4. Add the CA-signed certificate to the key repository for each queue manager:

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
5. On QM1, define a sender channel and associated transmission queue by issuing commands like the

following example:
DEFINE CHANNEL(TO.QM2) CHLTYPE(SDR) TRPTYPE(TCP)
CONNAME(QM2.MACH.COM) XMITQ(QM2) SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA)
DESCR(’Sender channel using TLS from QM1 to QM2’)

DEFINE QLOCAL(QM2) USAGE(XMITQ)

This example uses CipherSpec TLS_RSA_WITH_AES_128_CBC_SHA. The CipherSpecs at each end of
the channel must be the same.

6. On QM2, define a receiver channel by issuing a command like the following example:
DEFINE CHANNEL(TO.QM2) CHLTYPE(RCVR) TRPTYPE(TCP)
SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA) SSLCAUTH(REQUIRED)
DESCR(’Receiver channel using TLS to QM2’)

The channel must have the same name as the sender channel you defined in Step 5, and use the same
CipherSpec.

7. Start the channel: z/OS

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.

Results

Key repositories and channels are created as illustrated in Figure 17 on page 96.

What to do next

Check that the task has been completed successfully by using DISPLAY commands. If the task was
successful, the resulting output is like that shown in the following examples.

From queue manager QM1, enter the following command:
DISPLAY CHS(TO.QM2) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI

4 : DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(TO.QM2) CHLTYPE(SDR)
CONNAME(192.0.0.2) CURRENT
RQMNAME(QM2)
SSLCERTI("CN=<Division> CA,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5F:38,CN=QM2,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
STATUS(RUNNING) SUBSTATE(MQGET)
XMITQ(QM2)
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From the queue manager QM2, enter the following command:
DISPLAY CHS(TO.QM2) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(TO.QM2) CHLTYPE(RCVR)
CONNAME(192.0.0.1) CURRENT
RQMNAME(QM1)
SSLCERTI("CN=<Division> CA,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5F:38,CN=QM1,OU=<Department>,O=<Organization>,ST=<State>,C=<Country>")
STATUS(RUNNING) SUBSTATE(RECEIVE)
XMITQ( )

In each case, the value of SSLPEER must match that of the Distinguished Name (DN) in the partner
certificate that was created in Step 2 on page 96. The issuer name matches the subject DN of the CA
certificate that signed the personal certificate added in Step 4 on page 97.

Connecting two queue managers using one-way authentication
Follow these sample instructions to modify a system with mutual authentication to allow a queue
manager to connect using one-way authentication to another; that is, when the SSL/TLS client does not
send a certificate.

About this task

Scenario:
v Your two queue managers (QM1 and QM2) have been set up as in “Using CA-signed certificates for

mutual authentication of two queue managers” on page 96.
v You want to change QM1 so that it connects using one-way authentication to QM2.

The resulting configuration looks like this:

Procedure
1. Remove the personal certificate of QM1 from its key repository:

v Removing a certificate on IBM i systems.

v Removing a certificate on UNIX, Linux, and Windows.

transmission
queuekey repository

TO.QMB

SSLCAUTH (optional)

key repository

CA certificate QMB's certificate

CA certificate

QMA QMB

QMB

Figure 18. Queue managers allowing one-way authentication
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v z/OS Removing a certificate on z/OS systems. Perform this step twice, to remove both the
personal certificate for QMA, and the default certificate.

For details of how certificates are labeled, see Digital certificate labels.
2. Optional: On QM1, if any SSL/TLS channels have run previously, refresh the SSL/TLS environment ,

as described in Refreshing the TLS environment.
3. Allow anonymous connections on the receiver , as described in Allowing anonymous connections on

a receiver channel .
Key repositories and channels are changed as illustrated in Figure 18 on page 98

4. If the sender channel was not running, start it.

Note: If the sender channel was running and you issued the REFRESH SECURITY TYPE(SSL)
command (in step 2), the channel restarts automatically.
At the server end of the channel, the presence of the peer name parameter value on the channel status
display indicates that a client certificate has flowed.

5. Verify that the task has been completed successfully by issuing some DISPLAY commands. If the task
was successful, the resulting output is similar to that shown in the following examples:
v From the QM1 queue manager, enter the following command:

DISPLAY CHS(TO.QM2) SSLPEER SSLCERTI

The resulting output will be similar to the following example:
DISPLAY CHSTATUS(TO.QMB) SSLPEER SSLCERTI

4 : DISPLAY CHSTATUS(TO.QMB) SSLPEER
AMQ8417: Display Channel Status details.

CHANNEL(TO.QM2) CHLTYPE(SDR)
CONNAME(192.0.0.1) CURRENT
RQMNAME(QM2)
SSLCERTI("CN=IBM MQ CA,OU=IBM MQ Devt,O=IBM,ST=Hampshire,C=UK")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5F:38,CN=QMB,OU=IBM MQ Development,O=IBM,ST=Hampshire,C=UK")
STATUS(RUNNING) SUBSTATE(MQGET)
XMITQ(QM2)

v From the QM2 queue manager, enter the following command:
DISPLAY CHS(TO.QM2) SSLPEER SSLCERTI

The resulting output will be similar to the following example:
DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(TO.QM2) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(TO.QM2) CHLTYPE(RCVR)
CONNAME(192.0.0.2) CURRENT
RQMNAME(QMA) SSLCERTI( )
SSLPEER( ) STATUS(RUNNING)
SUBSTATE(RECEIVE) XMITQ( )

On QM2, the SSLPEER field is empty, showing that QM1 did not send a certificate. On QM1, the
value of SSLPEER matches that of the DN in QM2's personal certificate.
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Connecting a client to a queue manager securely
Secure communications that use the TLS cryptographic security protocols involve setting up the
communication channels and managing the digital certificates that you will use for authentication.

To set up your SSL/TLS installation you must define your channels to use TLS. You must also obtain and
manage your digital certificates. On a test system, you can use self-signed certificates or certificates issued
by a local certificate authority (CA). On a production system, do not use self-signed certificates.

For full information about creating and managing certificates, see the following topics:

v Working with SSL or TLS on IBM i

v Working with SSL or TLS on UNIX, Linux, and Windows systems

v z/OS Working with SSL or TLS on z/OS

This collection of topics introduces the tasks involved in setting up SSL/TLS communications, and
provides step-by-step guidance on completing those tasks.

You might also want to test SSL/TLS client authentication, which are an optional part of the protocols.
During the SSL/TLS handshake, the SSL/TLS client always obtains and validates a digital certificate from
the server. With the IBM MQ implementation, the SSL/TLS server always requests a certificate from the
client.

On IBM i, UNIX, Linux, and Windows systems, the SSL/TLS client sends a certificate only
if it has one labeled in the correct IBM MQ format, which is either ibmwebspheremq followed by your
logon user ID in lowercase, or the value of the CERTLABL attribute. See Digital certificate labels.

The SSL/TLS server always validates the client certificate if one is sent. If the client does not send a
certificate, authentication fails only if the end of the channel that is acting as the SSL/TLS server is
defined with either the SSLCAUTH parameter set to REQUIRED or an SSLPEER parameter value set. For
more information about connecting a queue manager anonymously, see “Connecting a client to a queue
manager anonymously” on page 104.
Related concepts:
TLS CipherSpecs and CipherSuites in IBM MQ classes for Java 
TLS CipherSpecs and CipherSuites in IBM MQ classes for JMS 
Related information:
Using certificates for the managed .NET client

Using self-signed certificates for mutual authentication of a client and queue
manager
Follow these sample instructions to implement mutual authentication between a client and a queue
manager, by using self-signed TLS certificates.

About this task

Scenario:
v You have a client, C1, and a queue manager, QM1, which need to communicate securely. You require

mutual authentication to be carried out between C1 and QM1.
v You have decided to test your secure communication by using self-signed certificates.

DCM on IBM i does not support self-signed certificates, so this task is not applicable on IBM i systems.

The resulting configuration looks like this:
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In Figure 19, the key repository for QM1 contains the certificate for QM1 and the public certificate from
C1. The key repository for C1 contains the certificate for C1 and the public certificate from QM1.

Procedure
1. Prepare the key repository on the client and queue manager, according to operating system:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
2. Create self-signed certificates for the client and queue manager:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
3. Extract a copy of each certificate:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
4. Transfer the public part of the C1 certificate to the QM1 system and vice versa, using a utility such as

FTP z/OS , as described in Exchanging self-signed certificates .
5. Add the partner certificate to the key repository for the client and queue manager:
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems.
6. Define a client-connection channel in either of the following ways:
v Using the MQCONNX call with the MQSCO structure on C1, as described in Creating a

client-connection channel on the IBM MQ MQI client.
v Using a client channel definition table, as described in Creating server-connection and

client-connection definitions on the server.
7. On QM1, define a server-connection channel, by issuing a command like the following example:

DEFINE CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN) TRPTYPE(TCP) SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA)
SSLCAUTH(REQUIRED) DESCR(’Receiver channel using TLS from C1 to QM1’)

The channel must have the same name as the client-connection channel you defined in step 6, and use
the same CipherSpec.

Figure 19. Configuration resulting from this task
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Results

Key repositories and channels are created as illustrated in Figure 19 on page 101.

What to do next

Check that the task has been completed successfully by using DISPLAY commands. If the task was
successful, the resulting output is similar to that shown in the following example.

From queue manager QM1, enter the following command:
DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN)
CONNAME(192.0.0.1) CURRENT
SSLCERTI("CN=QM1,OU=IBM MQ Development,O=IBM,ST=Hampshire,C=UK")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5E:02,CN=QM2,OU=IBM MQ Development,O=IBM,ST=Hampshire,C=UK")
STATUS(RUNNING) SUBSTATE(RECEIVE)

It is optional to set the SSLPEER filter attribute of the channel definitions. If the channel definition
SSLPEER is set, its value must match the subject DN in the partner certificate that was created in Step 2.
After a successful connection, the SSLPEER field in the DISPLAY CHSTATUS output shows the subject
DN of the remote client certificate.

Using CA-signed certificates for mutual authentication of a client and queue
manager
Follow these sample instructions to implement mutual authentication between a client and a queue
manager, by using CA-signed TLS certificates.

About this task

Scenario:
v You have a client, C1, and a queue manager, QM1, which need to communicate securely. You require

mutual authentication to be carried out between C1 and QM1.
v In the future you are planning to use this network in a production environment, and therefore you

have decided to use CA-signed certificates from the beginning.

The resulting configuration looks like this:
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In Figure 20, the key repository for C1 contains certificate for C1 and the CA certificate. The key
repository for QM1 contains the certificate for QM1 and the CA certificate. In this example both C1's
certificate and QM1's certificate were issued by the same CA. If C1's certificate and QM1's certificate were
issued by different CAs then the key repositories for C1 and QM1 must contain both CA certificates.

Procedure
1. Prepare the key repository on the client and queue manager, according to operating system:

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
2. Request a CA-signed certificate for the client and queue manager. You might use different CAs for the

client and queue manager.

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
3. Add the certificate authority certificate to the key repository for the client and queue manager. If the

client and queue manager are using different Certificate Authorities then the CA certificate for each
Certificate Authority must be added to both key repositories.

v Do not perform this step on IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
4. Add the CA-signed certificate to the key repository for the client and queue manager:

v On IBM i systems.
v On UNIX, Linux, and Windows systems.

v z/OS On z/OS systems (queue manager only).
5. Define a client-connection channel in either of the following ways:
v Using the MQCONNX call with the MQSCO structure on C1, as described in Creating a

client-connection channel on the IBM MQ MQI client.

Figure 20. Configuration resulting from this task
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v Using a client channel definition table, as described in Creating server-connection and
client-connection definitions on the server.

6. On QM1, define a server-connection channel by issuing a command like the following example:
DEFINE CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN) TRPTYPE(TCP)
SSLCIPH(TLS_RSA_WITH_AES_128_CBC_SHA) SSLCAUTH(REQUIRED)
DESCR(’Receiver channel using TLS from C1 to QM1’)

The channel must have the same name as the client-connection channel you defined in step 6, and use
the same CipherSpec.

Results

Key repositories and channels are created as illustrated in Figure 20 on page 103.

What to do next

Check that the task has been completed successfully by using DISPLAY commands. If the task was
successful, the resulting output is like that shown in the following example.

From the queue manager QM1, enter the following command:
DISPLAY CHSTATUS(TO.QMB) SSLPEER SSLCERTI

The resulting output is like the following example:
DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN)
CONNAME(192.0.0.1) CURRENT
SSLCERTI("CN=IBM MQ CA,OU=IBM MQ Devt,O=IBM,ST=Hampshire,C=UK")
SSLPEER("SERIALNUMBER=4C:D0:49:D5:02:5F:38,CN=QMA,OU=IBM MQ Development,O=IBM,ST=Hampshire,C=UK")
STATUS(RUNNING) SUBSTATE(RECEIVE)

The SSLPEER field in the DISPLAY CHSTATUS output shows the subject DN of the remote client
certificate that was created in Step 2. The issuer name matches the subject DN of the CA certificate that
signed the personal certificate added in Step 4.

Connecting a client to a queue manager anonymously
Follow these sample instructions to modify a system with mutual authentication to allow a queue
manager to connect anonymously to another.

About this task

Scenario:
v Your queue manager and client (QM1 and C1) have been set up as in “Using CA-signed certificates for

mutual authentication of a client and queue manager” on page 102.
v You want to change C1 so that it connects anonymously to QM1.

The resulting configuration looks like this:
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Procedure
1. Remove the personal certificate from the key repository for C1, according to operating system:

v IBM i systems.

v UNIX, Linux, and Windows systems.

The certificate label is either ibmwebspheremq followed by your logon user ID in lowercase, or the
value of the CERTLABL attribute. See Digital certificate labels.

2. Restart the client application, or cause the client application to close and reopen all SSL/TLS
connections.

3. Allow anonymous connections on the queue manager, by issuing the following command:
ALTER CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN) SSLCAUTH(OPTIONAL)

Results

Key repositories and channels are changed as illustrated in Figure 21

What to do next

At the server end of the channel, the presence of the peer name parameter value on the channel status
display indicates that a client certificate has flowed.

Verify that the task has been completed successfully by issuing some DISPLAY commands. If the task
was successful, the resulting output is similar to that shown in the following example:

From queue manager QM1, enter the following command:
DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI

The resulting output will be similar to the following example:
DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI

5 : DISPLAY CHSTATUS(C1.TO.QM1) SSLPEER SSLCERTI
AMQ8417: Display Channel Status details.

CHANNEL(C1.TO.QM1) CHLTYPE(SVRCONN)
CONNAME(192.0.0.1) CURRENT
SSLCERTI( ) SSLPEER( )
STATUS(RUNNING) SUBSTATE(RECEIVE)

The SSLCERTI and SSLPEER fields are empty, showing that C1 did not send a certificate.

Figure 21. Client and queue manager allowing anonymous connection
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Migrating on Windows
Starting with an existing IBM MQ Version 8.0 installation, this scenario leads you through the key tasks
required to upgrade and migrate data to IBM MQ Version 9.0. Both versions are installed on the same
Windows environment.

Planning the solution
Review the topics in this section to understand what is covered in this scenario, the reasons why a
business might want to follow the scenario, and an overview of the solution proposed by the scenario.
Related information:
Planning your installation

Assumptions
This scenario makes several assumptions about the system that you are using to set up and work with
the sample IT configuration. These assumptions include the operating system and version of the products
that you are using, and whether or not you have security configured for IBM MQ.

This scenario assumes the following points:
v You are using one computer with a Windows operating system for this scenario, on which you will

install both the initial IBM MQ Version 8.0 configuration and then IBM MQ Version 9.0.

Note: Clustering is not described in this scenario. Instructions are provided for installing a sample IBM
MQ single server configuration which you can use as a starting point for trying out the scenario in the
same way as it was originally developed.

v You are using the following versions of IBM MQ:
– For the initial sample configuration, you are using IBM MQ Version 8.0. This scenario was

developed using IBM MQ Version 8.0.0, Fix Pack 5.
– For the post-migration configuration, you are using IBM MQ Version 9.0. This scenario was

developed using IBM MQ Version 9.0.0.
v This scenario does not describe the security configuration for IBM MQ. If you do have security

configured you should still be able to complete the scenario.
v You can use the Windows command prompt, and the graphical user interface IBM MQ Explorer, to

complete the tasks described in this scenario.
Related information:
Migration paths

Business overview
A company wants to migrate the existing IBM MQ Version 8.0 IT configuration on a Windows operating
system, to IBM MQ Version 9.0.

The company decides to migrate their business solution to IBM MQ Version 9.0 to gain business value
including:
v Using new and updated functionality available in IBM MQ Version 9.0.
v Exploring the new type of release available from IBM MQ Version 9.0; Continuous Delivery Release

(CDR).
v Benefiting from LDAP authorisation on Windows platforms.
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Related information:
New family features
New features for Multiplatforms
IBM MQ release types

IBM MQ FAQ for Long Term Support and Continuous Delivery releases

Choosing a migration path
When you are migrating between IBM MQ Version 8.0 and Version 9.0, there are several migration paths
you can take.

This topic gives an overview of the following migration paths:
v Single-stage path, also known as Stand-alone, migration
v Side-by-side migration path
v Multi-stage migration path

Note: This scenario describes only the Single-stage and Side-by-side migration methods.

Consider the advantages and limitations of each path to determine which best suits your requirements:

Single-stage migration

In single-stage migration, the installation of the latest version of the product replaces an earlier
version in the same installation location.

The advantage of single-stage migration is that it changes the configuration of a queue manager
on the earlier version as little as possible. Existing applications switch from loading the libraries
from the earlier version, to loading the libraries of the latest version, automatically. Using this
approach, your system will be unavailable for the entire process.

Side-by-side migration

In side-by-side migration, you install the latest version of IBM MQ alongside queue managers
that continue to be associated with the earlier version.

When you are ready, you migrate the queue managers, and applications to the latest version.

With this approach, because you uninstall the earlier version before starting any queue managers,
you can assign an installation of the latest version to be the primary installation.

See Choosing a primary installation for further information.

Multi-stage migration

In multi-stage migration, you install the latest version of the product alongside running queue
managers that continue to be associated with the earlier version. You can create queue managers
and run new applications using the latest version installation. When you are ready to start
migrating queue managers and applications from the earlier, you can do so, one-by-one. When
migration to the latest version is complete, uninstall the earlier version, and make the latest
version installation the primary installation.

With the multi-stage approach, until you uninstall the earlier version, you must configure an
environment to run applications that connect to a queue manager to the latest version. You must
also provide a path to run IBM MQ commands. Both these tasks are accomplished with the
setmqenv command.

Scenarios 107

http://www-01.ibm.com/support/docview.wss?uid=swg27047919


Related information:
Overview of migration concepts and methods
Single-stage migration to the latest version
Side-by-side migration to the latest version
Multi-stage migration to the latest version
List of changes that affect migration

Technical solution
This scenario describes two methods of migrating from an earlier version of IBM MQ to a later version,
where both versions run on a Windows operating system and are on the same server.

Overview: Initial IT configuration:

A company uses an existing IT configuration provided by IBM MQ Version 8.0 installed on a server with
a Windows operating system. This scenario describes migrating the initial IT configuration to an
equivalent IT configuration provided by IBM MQ Version 9.0 on the same server.

The initial IT configuration includes several components that an administrator configures or uses, as
shown in Figure 22 on page 109:
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JMS application
A stand-alone application that business users interact with, for example to register an order. The
application uses the Java Message Service (JMS) for asynchronous messaging.
v JMS is the Java EE messaging standard that is widely supported. JMS-based applications are

therefore portable across many messaging products.
v JMS provides a level of abstraction from the details of the messaging layer, simplifying the

application development process.
v JMS provides asynchronous communication, enabling applications to run without having to

wait for a reply, unlike tightly coupled systems such as remote procedure call (RPC).
v Applications that use JMS do not directly specify details to access resources. Instead, they look

up and use administered JMS objects such as a connection factory and a destination.

Queue Q1

< ... >

Users

JNDI namespace
(administered objects)

Application hub

JMS application
(stand-alone)

MQ Explorer
Initial context
(JNDI root)

IBM MQ

Legend

Connection factory
<Queue manager sampleQM>

Destination
(queue Q1)

Queue manager
sampleQM

New component
Component to
integrate with

Configuration
property

Figure 22. Initial IT configuration. The initial IT configuration includes an initial context, added for IBM MQ Explorer to
connect to the root of the JNDI namespace. The JNDI namespace includes a connection factory, added for the sample
JMS application to use to connect to IBM MQ, and a destination, added for the sample JMS application to connect to
the IBM MQ queue. That IBM MQ queue has also been added into the initial IT configuration for use by the sample
JMS application.
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For some situations, other messaging standards might be more suitable than JMS. For example
IBM Message Service Clients for C, C++ and .NET, also known as XMS, are APIs that provide
similar benefits to JMS for non-Java applications. XMS is therefore more suitable if you are using
the .NET platform, or you want to integrate existing C++ applications with newer Java EE
applications.

The application uses point-to-point messaging to send messages to a queue in the infrastructure
and processes reply messages, to provide the business user with an appropriate response.
In this messaging model, an application sends a message to a queue, and another application
receives the message from the queue and acknowledges receipt of the message. This model is the
simplest form of messaging because it involves only two endpoints. This model is also the most
appropriate for the scenario sample application: a single client requests information from a single
server.
In the alternative messaging model, publish/subscribe, a publisher publishes a message to a
message topic. Subscribers subscribe to the topic to receive messages. The publisher and
subscriber do not have any information about each other, and the message is received by zero or
more recipients.

Queue manager sampleQM
The IBM MQ queue manager that provides the initial messaging infrastructure. It hosts the queue
that the JMS application works with.

Q1 [Message queue]
The IBM MQ queue that the JMS application sends messages to.

JNDI namespace
A Java Naming Directory Interface JNDI namespace is used to hold JMS administered objects,
which applications can use to connect to IBM MQ and access destinations to send or receive
messages.

JNDI is part of Java EE, and provides a standard way for applications to access various types of
naming and directory services, for the retrieval of application components. For example, you can
use JNDI to access a naming service on a file system to retrieve the location of a printer object, or
to access a directory service on an LDAP server to retrieve a user object which contains ID and
password information. JNDI therefore enhances the portability of JMS-based applications, and
makes it easier to integrate those applications with each other and into existing systems. For JMS
messaging, you use JNDI to store objects that represent the target destination of a message, or the
connection factory that creates the connection between your application and its messaging
destination.

Any application or process with access to the JNDI namespace can use the same administered
objects. The properties of the administered objects can be changed in JNDI, with all the
applications or processes able to benefit from those same changes.

Initial context
An initial context defines the root of the JNDI namespace. To use IBM MQ Explorer to
create and configure administered objects, you first add an initial context that defines the
root of the JNDI namespace. Similarly, a JMS application first obtains an initial context,
before it can retrieve administered objects from the JNDI namespace.

Connection factory, myCF
A JMS connection factory object defines a set of standard configuration properties for
connections. An application uses a connection factory to create a connection to IBM MQ.

Destination, myQueue
A JMS destination can be a topic or a queue. In this scenario, the destination is a queue,
and identifies the IBM MQ queue that applications send messages to, or from which an
application receives messages, or both. An application looks up the destination in the
JNDI namespace to create a connection to the IBM MQ queue.
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Overview: The delivered logical topology:

The company has migrated from IBM MQ Version 8.0 to IBM MQ Version 9.0.

The IT configuration following the migration is unchanged, as shown in Figure 23. The queue manager
and sample application are migrated, and the business can benefit from the new functionality in the latest
version of IBM MQ.

Queue Q1

< ... >
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JNDI namespace
(administered objects)

Application hub

JMS application
(stand-alone)

MQ Explorer
Initial context
(JNDI root)

IBM MQ
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Connection factory
<Queue manager sampleQM>
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Figure 23. Delivered IT configuration. The delivered IT configuration includes an initial context, added for IBM MQ
Explorer to connect to the root of the JNDI namespace. The JNDI namespace includes a connection factory, added for
the sample JMS application to use to connect to IBM MQ, and a destination, added for the sample JMS application to
connect to the IBM MQ queue. That IBM MQ queue has also been added into the delivered IT configuration for use by
the sample JMS application.
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Implementing the solution using the graphical user interface
Implementing the solution in this scenario involves using the graphical user interface to migrate from an
earlier release of IBM MQ, running on a Windows operating system, to a later release, also running on a
Windows operating system, then verifying that the queue managers and queues have been successfully
migrated to the later release.

Before you begin

If you want to try out the scenario, first follow the instructions to set up a copy of the sample messaging
infrastructure as described in “Creating a sample initial IT configuration” on page 113. This sample
configuration is based on IBM MQ Version 8.0.

About this task

The migration process described in this scenario shows migrating a queue manager from IBM MQ
Version 8.0 to IBM MQ Version 9.0.

The scenario includes two options for the migration method. You can choose to try out one or the other
of these options, or both.

Option 1: Single-stage migration

In single-stage migration, the installation of the later version of the product replaces an earlier
version in the same installation location.

The advantage of single-stage migration is that it changes the configuration of a queue manager
on the earlier version as little as possible. Existing applications switch from loading the libraries
from the earlier version, to loading the libraries of the latest version, automatically. Using this
approach, your system will be unavailable for the entire process.

Option 2: Side-by-side migration

In side-by-side migration, you install the later version of IBM MQ alongside an earlier version.
The queue managers continue to be associated with the earlier version until you are ready to
migrate them to the later version.

With the side-by-side approach, because you uninstall the earlier version before starting any
migrated queue managers in the later version, you can assign the installation of the later version
to be the primary installation.

Procedure
1. Create a sample initial IT configuration to use as a starting point for the scenario as described in

“Creating a sample initial IT configuration” on page 113.
2. Select the method that you are going to use to migrate the product then follow the instructions for

your chosen option:
v “Option 1: Single-stage migration” on page 122
v “Option 2: Side-by-side migration” on page 129
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Related information:
UNIX, Linux, and Windows: Single-stage migration from Version 7.0.1, or later, to the latest version
UNIX, Linux, and Windows: Side-by-side migration from Version 7.0.1, or later, to the latest version
Migrating a queue manager from a previous version to the latest version on Windows
Choosing a primary installation

Creating a sample initial IT configuration
This scenario was developed using a sample initial (IT) configuration. Follow the instructions to set up
this sample configuration to try out the scenario in the same way as it was originally developed.

About this task

The initial IT configuration for this scenario, which is described in “Overview: Initial IT configuration” on
page 108, includes an initial context, added for the IBM MQ Explorer to connect to the root of the JNDI
namespace. The JNDI namespace includes a connection factory, added for the sample JMS application to
use to connect to IBM MQ, and a destination, added for the sample JMS application to connect to the
IBM MQ queue. That IBM MQ queue has also been added into the initial IT configuration and is used by
the sample JMS application.

Procedure
1. Install IBM MQ Version 8.0 and verify your installation.
2. Configure the JNDI namespace and administered objects.
3. Verify the sample IT configuration.

Installing IBM MQ Version 8.0 by using the launchpad:

Use the installation launchpad and wizards to install IBM MQ Version 8.0 on Windows, and verify your
installation by using the Postcard application.

Before you begin

Before starting this task, complete the following checks:
v You must have local administrator authority when you are installing.
v Ensure that the machine name does not contain any spaces.
v Ensure that you have sufficient disk space, 1005 MB for the server, to fully install IBM MQ for

Windows.

For this scenario, it is not necessary to determine whether you need to define Windows domain user ID's
for any IBM MQ users, as this requirement is outside the scope of this scenario. See Creating an Active
Directory and DNS domain for IBM MQ for more information.

Before you install IBM MQ, check that your system meets the hardware and software requirements. For
the latest details of hardware and software requirements, see System Requirements for IBM MQ.

About this task

This task describes the basic steps for installing IBM MQ Version 8.0 on a Windows operating system.

The sample IT configuration described in this scenario was tested using IBM MQ Version 8.0.0.5 on a
Windows 7 Professional 64-bit (SP 1) operating system.

The installation programs contain links to further information. The installation process has the following
parts:
1. Start the installation process.
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2. Use the Installation Launchpad to check and install software requirements, specify network
information, and start the IBM MQ installation wizard.

3. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
4. Use the Prepare IBM MQ wizard to start the IBM MQ service.
5. Optionally, use the Default Configuration wizard to create a default configuration and associated

objects for verifying the installation by using the Postcard application that is supplied with IBM MQ.
6. If you completed step 4, use the Postcard application to verify your installation.

Procedure

1. You can start the installation process in one of two ways:
v In Windows Explorer, navigate to the temporary folder into which you downloaded the installation

image and double-click setup.exe, or
v Insert the IBM MQ for Windows Server DVD into the DVD drive. If autorun is enabled, the

installation process starts. Otherwise, double-click the Setup icon in the root folder of the DVD to
start the installation process.

The installation launchpad is started.
2. Using the launchpad, review and, if necessary, modify the software requirements and network

configuration.
a. Click the Software Requirements button to display the Software Requirements tab.
b. Check that the software requirements have been met and that the entry for the requirement

displays a green tick with the words OK . Make any indicated corrections.

Note: To see more details about any requirement, click the plus (+) button.
c. Click the Network Configuration button to display the Network Configuration tab.
d. Click the No radio button.

Note: This scenario assumes that you do not need to configure a domain user ID for IBM MQ. For
more information regarding configuring IBM MQ for Windows domain users, click the More
information button.

e. On the IBM MQ Installation tab of the Launchpad, select the installation language, and then click
the Launch IBM MQ Installer button to start the IBM MQ installation wizard.

You have completed your review IBM MQ of the installation requirements, have made any required
modifications, and have started the IBM MQ installation wizard.

3. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
a. In the Prepare IBM MQ wizard, read the License Agreement and select the I accept the terms in

the license agreement check box, then click Next.
b. Click Typical, and then click Next.
c. On the Ready to Install IBM MQ page, review the installation information and click Install.

Note: the following details:
v Installation Name
v Top-level folder for Program Files
v Top-level folder for Data Files

The following features will be installed:
v IBM MQ Server
v IBM MQ: a graphical interface for administering and monitoring IBM MQ resources
v Java™ and .NET Messaging and Web Services
v IBM MQ Development Toolkit
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The installation process begins. Depending on your system, the installation process can take
several minutes.
At the end of the installation process, the IBM MQ Setup window displays the message
Installation Wizard Completed Successfully .

d. Click Finish.

You have successfully installed IBM MQ. The Prepare IBM MQ wizard starts automatically, displaying
the Welcome to the Prepare IBM MQ Wizard page.

4. Use the Prepare MQ wizard to start the IBM MQ service.
a. On the Welcome to the Prepare IBM MQ Wizard, select Next. The Prepare IBM MQ Wizard

displays the message Status: Checking IBM MQ Configuration and a progress bar. When the
process is complete the IBM MQ Network Configuration page is displayed.

b. On the IBM MQ Network Configuration page of the Prepare IBM MQ Wizard, select No.
c. Click Next. The Prepare IBM MQ Wizard displays a message Status: starting the IBM MQ

Service , and a progress bar. When the process is complete the wizard displays the Completing
the Prepare IBM MQ Wizard.

d. Select Launch IBM MQ Explorer and choose whether to start Notepad to view the release notes,
and then click Finish. IBM MQ Explorer starts.

You have installed IBM MQ, and you have started the IBM MQ Explorer.

Results

IBM MQ is installed on your computer and, optionally, the installation has been verified using the
Postcard application.

What to do next

You are ready to create the administered objects used in this scenario as described in “Configuring the
JNDI namespace and administered objects.”
Related information:
Disc space requirements
Hardware and software requirements on Windows systems
Introduction to IBM MQ
Installing an IBM MQ server on Windows
Configuring an IBM MQ server

Configuring the JNDI namespace and administered objects:

Define an initial context for the JNDI namespace in IBM MQ Explorer, then, in the namespace, define the
administered objects that the sample application can use.

About this task

In this task, you create the following objects in IBM MQ.
v A JNDI namespace located in a local file system. A file system is used, because it is the simplest JNDI

mechanism for a sample scenario.
The JNDI namespace can be on a file system, Lightweight Directory Access Protocol (LDAP) server, or
on another JNDI implementation. If you want to use a JNDI namespace on an LDAP server or another
JNDI implementation, you must configure the JNDI namespace and modify the sample application to
reference the JNDI namespace, as required by the implementation.

v Administered objects in the JNDI namespace. The JMS application can look up the administered objects
to connect to IBM MQ and access IBM MQ destinations with which to send or receive messages.
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Figure 24. Objects created in IBM MQ
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Procedure

1. Start IBM MQ Explorer, if it is not already started, by clicking Start > All Programs > IBM MQ >
IBM MQ Explorer. If IBM MQ Explorer is running and displaying the Welcome page, close the
Welcome page to start administering IBM MQ objects.

2. Create a queue manager to use for the sample application.
a. Right click Queue Managers and select New > Queue Manager.... The Create Queue Manager

wizard starts.
b. In the Queue manager name field type sampleQM. You can choose a different name for the queue

manager, but you must remember to use it in later configuration steps, in place of sampleQM.

Note: The name must have no more 48 characters, from the following set:
v Uppercase or lowercase characters (A-Z a-z)
v Numeric characters (0-9)
v Period (.)
v Forward slash (/)
v Underscore (_)
v Percent sign (%)

Names are case-sensitive. Objects of the same type must have different names. For example two
queues cannot have the same name, but a queue manager and a queue can.

c. In the Dead-letter queue field type SYSTEM.DEAD.LETTER.QUEUE. This field is the name of the
dead-letter queue that is automatically created when you create the queue manager. A dead-letter
queue stores messages that cannot be delivered to their correct destination, for example because
the queue is full. All queue managers should have an associated dead-letter queue.

d. Leave the other fields empty and click Finish, or if that button is disabled, click Next. The Finish
button is disabled if the port number conflicts with an existing queue manager, for example the
queue manager that is created as part of the default configuration. You must continue through the
wizard to change the default port number.

e. If you clicked Next, continue to accept the defaults and click Next on each page until you get to
the final page of the wizard, when the Finish button becomes available. Change the specified port
number, for example to 1415, and click Finish.

IBM MQ displays a dialog window while the queue manager is created and started.
3. Add an initial context for the JNDI namespace then connect IBM MQ Explorer to that context Before

you can use IBM MQ Explorer to create and configure JMS administered objects, you must add an
initial context to define the root of the JNDI namespace in which the administered objects are stored.
Whenever you want to use IBM MQ Explorer to create or manage administered objects in the JNDI
namespace, you must connect IBM MQ Explorer to the initial context of the JNDI namespace.
a. In the IBM MQ Explorer - Navigator pane, right-click JMS Administered Objects, then select Add

Initial Context.... This action displays the “Connection details” page.
b. Under “Where is the JNDI namespace located?”, select the File system check box.
c. In the Bindings directory field, type C:\JNDI-Directory. This value matches the JNDI namespace

location specified in the sample JMS application. If you must specify a different JNDI directory,
you must modify the application to match. If the directory does not exist on your system the
window displays the message Specified location does not exist or is not readable . Click
Browse... to open a file system window, navigate to Local Disk (C:), then click Make New Folder
to create the JNDI-Directory folder. Click OK.
Click Next.

d. On the User preferences page, leave the default settings.
v Context nickname: The location of the JNDI namespace will be used as the nickname to display

the initial context in IBM MQ Explorer.
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v Connect immediately on finish: This option connects IBM MQ Explorer to the JNDI namespace
when you finish creating the initial context, so that you can create administered objects
immediately.

v Automatically reconnect to context on startup: This option is not selected, because usually you
do not need IBM MQ Explorer to automatically reconnect to the initial context every time that
you close and reopen IBM MQ Explorer.

If you routinely use IBM MQ Explorer to create or manage administered objects in the JNDI
namespace, you can select the Automatically reconnect to context on startup check box to cause
IBM MQ Explorer to automatically reconnect to the initial context whenever IBM MQ Explorer is
started. This option saves you having to manually connect IBM MQ Explorer to the initial context.
Click Finish to create and display the initial context.

4. Create a connection factory administered object. A connection factory administered object defines a set
of standard configuration properties for connections. An application uses a connection factory to
create a connection to IBM MQ.
a. In the IBM MQ Explorer - Navigator pane, expand JMS Administered Objects, then expand the

initial context, labeled file:/C:/JNDI-Directory/.
b. Right-click Connection Factories, then select New > Connection Factory.... This action displays the

New Connection Factory wizard
c. In the Name field, type myCF The sample JMS application contains code that looks up a connection

factory with the name myCF. If you must use a different name, you must modify the application to
match.
IBM MQ is used for the messaging provider, because the sample application uses point-to-point
messaging.
Click Next.

d. Leave the type of connection factory as Connection Factory, because this option is the most
flexible for general JMS use. A domain-independent connection factory enables JMS applications to
use both point-to-point messaging and publish/subscribe messaging, especially if you want the
JMS application to perform both types of messaging under the same transaction. If a JMS
application is intended to use only point-to-point messaging or only publish/subscribe messaging,
you can select the specific messaging domain when you create the connection factory and a
domain-specific (queue or topic) connection factory is created.

e. Leave the support for XA transactions as cleared. The sample application does not use
XA-compliant transactions. IBM MQ JMS supports XA-compliant transactions in bindings mode. If
you want the sample application to use XA-compliant transactions, you must modify the sample
application.
Click Next.

f. Leave the transport as Bindings. The sample JMS application that uses the connection factory runs
on the same computer as the queue manager, so can use Bindings mode transport. This option
means that the JMS application connects directly to the queue manager, and offers a performance
advantage over the alternative client mode.
Click Next, then Next again.

g. On the Change properties page, select Connection from the menu on the left, then in the
Connection pane select sampleQM as the Base queue manager. The base queue manager is the
queue manager that the application will connect to. Leave this value blank if you want the
application to be able to connect to more than one queue manager.

h. Click Finish. IBM MQ displays a dialog window to show that the object was created successfully.
Click OK to close the dialog window.

5. Create a destination administered object. A destination administered object identifies the IBM MQ
queue that applications send messages to, or from which an application receives messages, or both.
An application looks up the destination in the JNDI namespace to create a connection to the IBM MQ
queue. In publish/subscribe messaging, the destination identifies a topic rather than a queue.
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a. In the IBM MQ Explorer - Navigator pane, expand JMS Administered Objects, then expand the
initial context, labeled file:/C:/JNDI-Directory/.

b. Right-click Destinations, then select New > Destination.... The New Destination wizard is
displayed.

c. In the Name field, type myQueue. Leave the Type as Queue. The sample JMS application contains
code that looks up a destination with the name myQueue. The sample JMS application uses
point-to-point messaging, so requires a destination of type queue. Destinations of type topic are
used for publish/subscribe messaging.

d. Select the Start wizard to create a matching MQ Queue check box. The destination object needs a
matching IBM MQ queue, and it is convenient to use IBM MQ Explorer to create both together.
When you complete the New Destination wizard, the Create an MQ Queue wizard opens, with
many of the destination details mapped to the IBM MQ queue.
Click Next.
Click Next again.

e. On the “Change properties” page, click Select... next to Queue manager. Select the sampleQM
queue manager that you created earlier then click OK.

f. Specify Q1 as the name of the IBM MQ queue. You can choose a different name for the queue, but
you must remember to use it in later configuration steps, in place of Q1.

Note: The name must have no more 48 characters, from the following set:
v Uppercase or lowercase characters (A-Z a-z)
v Numeric characters (0-9)
v Period (.)
v Forward slash (/)
v Underscore (_)
v Percent sign (%)

Names are case-sensitive. Objects of the same type must have different names. For example two
queues cannot have the same name, but a queue manager and a queue can.

g. Click Finish. The Create an MQ Queue wizard starts.
If the wizard does not start, you might not have selected the Start wizard to create a matching
MQ Queue check box in an earlier step. In the IBM MQ Explorer - Navigator pane, expand the
sampleQM queue manager, right click Queues, then select New > Local Queue....

6. Create a matching IBM MQ queue. The destination administered object created earlier represents an
IBM MQ queue. This queue is where the JMS messages are stored.
a. Click Next to accept the sampleQM queue manager that you specified earlier.
b. Click Next.
c. Click Finish to create the IBM MQ queue using the information from the destination administered

object that you created earlier. IBM MQ displays a dialog window with the message that the object
was created successfully.

The new queue is now visible in the Queues section under the queue manager.

Results

You have now created the IBM MQ objects that are required to use the sample JMS application.

What to do next

You are now ready to verify that you have configured IBM MQ correctly for use with the sample
application as described in “Configuring the JNDI namespace and administered objects” on page 115.
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Verifying the sample IT configuration:

Run the sample stand-alone JMS application to send and receive messages through IBM MQ, and verify
that you have configured IBM MQ correctly for use with the sample application.

Before you begin

Download the sample application package. Click the following link and save the file to the computer on
which you are installing IBM MQ: sampleJMSApp.zip, then extract the contents. The package contains a
sample JMS application .jar file and batch files for running the application.
v The sample sampleJMSApp.jar file and the .cmd files must be in the same directory.
v The .cmd files use environment variables to set the class path for running the JMS application. When

running the JMS application, if you see a Java java.lang.NoClassDefFoundError, you might need to
adjust the class path line in the command file.

About this task

The JMS application comprises a requester client, which sends the initial message, and a responder client,
which receives the message and sends a reply. The supplied batch files perform the following actions:
v runresponder.cmd opens a command prompt window in which the responder client starts then waits

for a message.
v runrequester.cmd opens a separate command prompt window in which the requester client starts then

sends a request message and receives a reply.

With two command prompt windows, you can see the actions of the requester and responder separately
and more clearly.

Procedure

1. Double-click the runresponder.cmd file. In the command prompt window, labeled Responder window,
the responder client starts then waits for a message.
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

2. Double-click the runrequester.cmd file. In the Requester window, observe the requester messages. In
the Responder window, observe the updated responder messages; the message it received (from the
requester client) and the reply message that it sent.

Results

In the command prompt window, labeled Requester window, the requester client shows the connection
status, the message it sent, then the reply message that it received from the responder client:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Connection created.

> Sending stock request for ’BakedBeans’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902 for ’B
akedBeans - 15 tins in stock’

> Closing connection to QueueManager.
> Closed Connection.
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--------------------------------------------------------
In this window, observe the messages sent through IBM MQ:
- The request message sent
- The reply message received
-----
When ready, press any key to close this window
Press any key to continue . . .

In the Responder window, observe the updated responder messages; the message it received (from the
requester client) and the reply message that it sent:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02 for ’B
akedBeans’

> Sending Reply Message ’BakedBeans - 15 tins in stock’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902

> Closing connection to QueueManager.
> Closed connection.
--------------------------------------------------------
In this window, observe the updated responder messages
- The request message received (from the requester)
- The reply message sent
-----
When ready, press any key to close this window
Press any key to continue . . .

The messages shown in the two command windows verify that the requester and responder clients of the
sample application can communicate with each other through IBM MQ.

What to do next

You are now ready to start migrating your sample IBM MQ Version 8.0 installation to a later release of
IBM MQ using one of the following two migration options:
v To migrate using the single-stage migration method, follow the instructions in “Option 1: Single-stage

migration” on page 122.
v To migrate using the side-by-side migration method, follow the instructions in “Option 2: Side-by-side

migration” on page 129.
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Option 1: Single-stage migration
Option 1 of this scenario shows how to migrate from an earlier to a later version of IBM MQ when using
the single-stage migration method. With a single-stage migration, the installation of a later version of IBM
MQ replaces an earlier version in the same installation location.

Before you begin

The starting point for this scenario is the initial IBM MQ Version 8.0 IT configuration described in
“Overview: Initial IT configuration” on page 108.

Before starting this task, follow the instructions in “Creating a sample initial IT configuration” on page
113 to set up the sample configuration.

About this task

With a single-stage migration, you can choose either to uninstall the earlier version of IBM MQ before
installing the newer version, or to install the newer version without first uninstalling the older version
(that is, to migrate in place). In both cases, the later release is installed in the same directory as the earlier
release. Option 1 of this scenario shows a single-stage migration where the older version is uninstalled
before installing the newer version. The queue manager data is not removed as part of the uninstallation
process, which means that the sample queue managers used in this scenario are retained and are detected
when you install the newer version of IBM MQ.

Procedure
1. Stop the queue managers running in the earlier version of IBM MQ, and back up the queue manager

data.
2. Uninstall the earlier version of IBM MQ that you are migrating from, without removing the queue

manager data.
3. Install IBM MQ Version 8.0 using the launchpad..
4. Use IBM MQ Explorer to verify the new IBM MQ Version 8.0 installation. Verify that the queue

managers have been successfully migrated from the earlier release and that you can put messages to
and get messages from the migrated queues.

Related information:
UNIX, Linux, and Windows: Single-stage migration from Version 7.0.1, or later, to the latest version

Preparing to migrate:

Before migrating to a later version of IBM MQ, you must first stop the queue manager and back up the
queue manager data.

About this task

If you migrate from a previous version of IBM MQ without first backing up your system, you cannot
revert to the previous version, should you decide not to continue with the migration. Backing up your
system before you install the new version enables you to back out the upgrade if necessary. If you do
back out an upgrade, however, you cannot recover any work, such as changes to messages and objects,
carried out by the later version of IBM MQ.

Before taking the backup, stop the queue manager that you are going to back up, which for this scenario
is sampleQM. If you try to take a backup of a running queue manager, the backup might not be
consistent because of any updates that were in progress when the files were copied.
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Procedure

1. Open IBM MQ Explorer. Click Start > All Applications > IBM MQ > IBM MQ Explorer.
2. Stop queue manager sampleQM.

a. In the Navigator View, right-click the queue manager sampleQM.
b. Click Stop. The End Queue Manager window opens.
c. Select Controlled, then click OK. Selecting the Controlled option stops your queue manager in a

controlled, orderly way. The Immediate option, which forces the queue manager to stop, is
typically used only if a controlled stop fails to complete successfully.

The queue manager stops. In the IBM MQ, the icon next to queue manager sampleQM is changed to
include a red arrow that points downward.

3. Close IBM MQ Explorer.
4. Back up the queue manager data. Take copies of all of the following data, making sure that you

include all backup directories. Some of the directories might be empty, but you need them all if you
need to restore the backup at a later date, so save them too.
v The queue manager data located in C:\ProgramData\IBM\MQ\Qmgrs.
v The log file directories for the queue managers located in C:\ProgramData\IBM\MQ\log, including the

log control file amqhlctl.lfh.
v The configuration files located in the C:\ProgramData\IBM\MQ\Config.
v IBM MQ Version 8.0 .ini file and the registry entries. The queue manager information is stored in

the .ini file and can be used to revert to a previous version of the product.
5. Stop IBM MQ.

a. Stop the IBM MQ Service. Right-click the IBM MQ icon in the system tray, then click Stop IBM
MQ. A dialog box with the following message is displayed:
Shutting down IBM MQ will terminate all running queue managers and
IBM MQ processes. Are you sure you want to continue? (AMQ4102)

b. Click Yes, then wait for IBM MQ to stop.
c. When IBM MQ has stopped, right-click the IBM MQ icon in the system tray, then click Exit.

Results

You have stopped the queue manager that you are going to migrate to the later release of IBM MQ and
have taken a backup of the queue manager data.

What to do next

You are now ready to uninstall IBM MQ as described in “Uninstalling Version 8.0.”
Related information:
Backing up queue manager data

Uninstalling Version 8.0:

Uninstall Version 8.0 using the control panel. For a single-stage migration on Windows, uninstalling the
earlier version of the product before installing the later version is optional.

Before you begin

Before starting this task, you must first stop the queue managers, close IBM MQ Explorer and stop IBM
MQ as described in “Preparing to migrate” on page 122.
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About this task

In this task, you uninstall Version 8.0 using the Windows control panel. The queue manager data is not
removed as part of the uninstallation process, which means that the sample queue managers used in this
scenario are retained and can be detected when you install the newer version of the product.

Whether or not you have to uninstall the earlier version of the product before you install the later version
depends upon your operating system. On Windows systems, uninstalling is optional and you could
alternatively install the newer version without uninstalling the earlier one. Note that in this case, some of
the options and messages that you would see during the installation would be different from those that
appear when you have uninstalled the earlier version first. For more information about the platforms on
which you must uninstall the earlier version before installing the newer version, see UNIX, Linux, and
Windows: Single-stage migration from Version 7.0.1, or later, to the latest version.

Procedure

1. Open the Windows Control Panel by clicking Start > Control Panel > Uninstall a program.
2. In the Programs and Features window, find the entry for the installation that you want to remove, for

example IBM IBM WebSphere MQ (Installation1), and click Uninstall. The uninstallation process
begins and runs to completion. When the process completes, Version 8.0 is removed from your
computer and is no longer displayed in the list of programs.

Results

Version 8.0 has been removed from your computer. However the queue manager data has not been
removed.

What to do next

You are now ready to install IBM MQ Version 9.0 as described in “Installing IBM MQ Version 9.0 using
the launchpad.”
Related information:
Uninstalling IBM MQ on Windows systems

Installing IBM MQ Version 9.0 using the launchpad:

Use the installation launchpad and wizards to install IBM MQ Version 9.0 on the same Windows
computer as the one on which Version 8.0 was installed.

Before you begin

Before starting this task, ensure that you have obtained a copy of the installation media:
v If you are installing using Electronic Software Download, download and unpackage the compressed

file containing the installation image into a temporary directory.
v If you are installing using a DVD, obtain a copy of the IBM MQ for Windows Server DVD.

This task assumes that you have previously uninstalled the earlier version of IBM MQ from which you
are migrating as described in “Uninstalling Version 8.0” on page 123. If you install IBM MQ Version 9.0
without first uninstalling the earlier version, some of the options and messages that you see during the
installation process will be different from those described in this task.

Before starting this task, complete the following checks:
v You must have local administrator authority when you are installing. Define this authority through the

Windows facilities.
v Ensure that the machine name does not contain any spaces.
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v Ensure that you have sufficient disk space, 1005 MB, to fully install IBM MQ for Windows.

For this scenario, it is not necessary to determine whether you need to define Windows domain user ID's
for any IBM MQ users, as this requirement is outside the scope of this scenario. See Creating an Active
Directory and DNS domain for IBM MQ for more information.

Before you install IBM MQ, check that your system meets the hardware and software requirements. For
the latest details of hardware and software requirements, see System Requirements for IBM MQ.

About this task

This task describes the basic steps for installing IBM MQ Version 9.0 on a Windows operating system
when migrating from IBM MQ Version 8.0.

After uninstalling IBM MQ Version 8.0, the Version 9.0 is installed using the same installation name but
using the Version 9.0 default program binary files location C:\Program Files\IBM\MQ. The default
program binary files location in IBM MQ Version 8.0 is C:\Program Files\IBM\WebSphere MQ.

Because the default data files location C:\ProgramData\IBM\MQ is same in IBM MQ Version 8.0 and Version
9.0, any existing data and queue managers are picked up by the new installation.

The installation programs contain links to further information if you require it during the installation
process. The installation process has the following parts:
1. Use the Launchpad to check and install software requirements, specify network information, and start

the IBM MQ installation wizard.
2. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
3. Use the Prepare IBM MQ wizard to start the IBM MQ service.

Procedure

1. You can start the installation process in one of two ways:
v In Windows Explorer, navigate to the temporary folder into which you downloaded the installation

image and double-click setup.exe, or
v Insert the IBM MQ for Windows Server DVD into the DVD drive. If autorun is enabled, the

installation process starts. Otherwise, double-click the Setup icon in the root folder of the DVD to
start the installation process.

The installation launchpad is started.
2. Start the Launchpad, review, and if necessary, modify the software requirements and network

configuration.
a. Navigate to the IBM MQ software directory, and double-click the file Setup.exe to start the

Launchpad.
b. Click the Software Requirements button to display the Software Requirements tab.
c. Check that the software requirements have been met and that the entry for the requirement

displays a green tick with the words OK . Make any indicated corrections.

Note:

For details of any requirement, click the check box to expand an information tab.
d. Click the Network Configuration button to display the Network Configuration tab.
e. Click the No radio button.

Note: This scenario assumes that you do not need to configure a domain user ID for IBM MQ. For
more information regarding configuring IBM MQ for Windows domain users, click the More
information button.
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f. On the IBM MQ Installation tab of the Launchpad, select the installation language, and then click
Launch IBM MQ Installer to start the IBM MQ installation wizard.

You have completed setting up IBM MQ by meeting or specifying your installation requirements, and
have started the IBM MQ installation wizard.

3. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
a. In the Prepare IBM MQ wizard, read the License Agreement and click the I accept the terms in

the license agreement check box, and then click Next.
b. Click Typical, and then click Next.
c. On the Ready to Install IBM MQ page, review the installation information, then click Install. The

installation information includes the following details:
v Installation Name
v Top-level folder for Program Files
v Top level folder for Data Files
The following features are installed:
v IBM MQ Server
v IBM MQ: a graphical interface for administering and monitoring IBM MQ resources
v Java™ and .NET Messaging and Web Services
v IBM MQ Development Toolkit

The installation process begins. Depending on your system the installation process can take several
minutes.
At the end of the installation process, the IBM MQ Setup window displays the message
Installation Wizard Completed Successfully .

d. Click Finish.

You have successfully installed IBM MQ. The Prepare IBM MQ wizard starts automatically, displaying
the Welcome to the Prepare IBM MQ Wizard page.

4. Use the Prepare IBM MQ wizard to start the IBM MQ service.
a. On the Welcome to the Prepare IBM MQ Wizard page, select Next. The Prepare IBM MQ Wizard

displays the message Status: Checking IBM MQ Configuration and a progress bar. When the
process is complete the IBM MQ Network Configuration page is displayed.

b. On the IBM MQ Network Configuration page of the Prepare IBM MQ Wizard, select No.
c. Click Next. The Prepare IBM MQ Wizard displays a message Status: starting the IBM MQ

Service , and a progress bar. When the process is complete the wizard displays the Completing
the Prepare IBM MQ Wizard.

d. Select Launch IBM MQ Explorer and choose whether to start Notepad to view the release notes,
and then click the Finish button. IBM MQ Explorer starts.

Results

You have installed IBM MQ, and you have started IBM MQ Explorer.

What to do next

Now that you have installed IBM MQ Version 9.0, you are ready to check that the sample queue
managers have been successfully migrated and that you are able to put messages to and get messages
from the migrated queues as described in “Verifying your IBM MQ Version 9.0 installation” on page 127.
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Related information:
Program and data directory locations on Windows
Installation using Electronic Software Download
Installing an IBM MQ server on Windows

Verifying your IBM MQ Version 9.0 installation:

After you install IBM MQ Version 9.0, use IBM MQ Explorer to verify that the queue managers and
queues have successfully migrated from the earlier release then verify that you can use the sample
application.

About this task

When you have checked that the migrated queue manager, sampleQM, is visible in the Navigator view of
IBM MQ Explorer, verify that you can put a message to and get a message from the migrated queue, then
check that you can still run the sample application.

Procedure

1. If IBM MQ Explorer is not running, start it now. Click Start > All Programs > IBM MQ > IBM MQ
Explorer.

2. Verify that your queue managers have been successfully migrated to IBM MQ Version 9.0:
a. In the Navigator view, expand the Queue Managers folder.
b. Check that you can see the queue manager sampleQM in the Queue Managers folder.
c. Expand queue manager sampleQM, click the Queues folder, and check that you can see queue Q1

in the Content view.
3. If queue manager sampleQM is not already started, start it now.

a. In the Navigator view, expand the queue managers node.
b. Right-click queue manager sampleQM, then click Start.

4. Verify that you can put a message to queue Q1.
a. In the Navigator view, expand the Queue Managers folder.
b. Expand queue manager sampleQM, then click the Queues folder.
c. In the Content view, right-click queue Q1, then click Put Test Message. The Put test message

dialog opens.
d. In the Message data field, type some text, for example Hello queue!, then click Put message. The

Message data field is cleared and the message is put on the queue.
e. Click Close. In the Content view, notice that the Current queue depth value of the queue is now

1. If the Current queue depth column is not visible, you might need to scroll to the right of the
Content view.

5. Verify that you can get the message from queue Q1.
a. In the Navigator view, expand the Queue Managers folder,
b. Expand queue manager sampleQM then click the Queues folder.
c. In the Content view, right-click queue Q1, then click Browse Messages. The Message browser

opens to show the list of the messages that are currently on the queue.
d. Double-click the last message to open the properties dialog. On the Data page of the properties

dialog, the Message data field displays the content of the message in human-readable form.
6. Verify that you can run the sample application.

a. Double-click the runresponder.cmd file. In the command prompt window, labeled Responder
window, the responder client starts then waits for a message.
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> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

b. Double-click the runrequester.cmd file. In the Requester window, observe the requester messages.
In the Responder window, observe the updated responder messages; the message it received (from
the requester client) and the reply message that it sent.

In the command prompt window, labeled Requester window, the requester client shows the
connection status, the message it sent, then the reply message that it received from the responder
client:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Connection created.

> Sending stock request for ’BakedBeans’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902 for ’B
akedBeans - 15 tins in stock’

> Closing connection to QueueManager.
> Closed Connection.
--------------------------------------------------------
In this window, observe the messages sent through IBM MQ:
- The request message sent
- The reply message received
-----
When ready, press any key to close this window
Press any key to continue . . .

In the Responder window, observe the updated responder messages; the message it received (from the
requester client) and the reply message that it sent:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02 for ’B
akedBeans’

> Sending Reply Message ’BakedBeans - 15 tins in stock’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902

> Closing connection to QueueManager.
> Closed connection.
--------------------------------------------------------
In this window, observe the updated responder messages
- The request message received (from the requester)
- The reply message sent
-----
When ready, press any key to close this window
Press any key to continue . . .

The messages shown in the two command windows verify that the requester and responder clients of
the sample application can communicate with each other through IBM MQ.

Results

You have successfully migrated to IBM MQ Version 9.0.
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Option 2: Side-by-side migration
Option 2 of this scenario shows how to migrate from an earlier to a later release of IBM MQ when using
the side-by-side migration method. With a side-by-side migration, you install the latest version of IBM
MQ alongside the earlier version that you want to migrate from. Queue managers and applications
continue to be associated with the earlier release until you migrate them to the later release.

Before you begin

The starting point for this scenario is the initial IBM MQ Version 8.0 IT configuration described in
“Overview: Initial IT configuration” on page 108.

Before starting this task, follow the instructions in “Creating a sample initial IT configuration” on page
113 to set up the sample configuration.

About this task

When you follow the side-by-side migration method described in this scenario, you install the later
version alongside the earlier version in an alternate location. Since you uninstall the earlier version before
starting any queue managers in the later version, you can assign your installation of the later version of
IBM MQ to be the primary installation. For more information about the primary installation, see Primary
installation.

Procedure
1. Install IBM MQ Version 9.0 using the launchpad and then verify the installation..
2. Stop the queue managers running in the earlier version of IBM MQ.
3. Uninstall the earlier version of IBM MQ.
4. Make IBM MQ Version 9.0 the primary installation.
5. Optional: Associate the queue managers with IBM MQ Version 9.0
6. Use IBM MQ Explorer to verify the IBM MQ Version 9.0 installation. Check that the queue managers

have been successfully migrated from the earlier release and that you can put messages to and get
messages from the migrated queues.

Related information:
UNIX, Linux, and Windows: Side-by-side migration from Version 7.0.1, or later, to the latest version

Installing IBM MQ Version 9.0 using the launchpad:

Use the installation launchpad and wizards to install IBM MQ Version 9.0 alongside Version 8.0 on
Windows.

Before you begin

This scenario was tested using IBM MQ Version 8.0.0.5 on a Windows 7 Professional 64-bit (SP 1)
operating system.

Before completing this task, complete the following checks:
v You must have local administrator authority when you are installing. Define this authority through the

Windows facilities.
v Ensure that the machine name does not contain any spaces.
v Ensure that you have sufficient disk space, up to 1005 MB, to fully install IBM MQ for Windows.
v Determine whether you need to define Windows domain user ID's for any IBM MQ users.
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Before you install IBM MQ, check that your system meets the hardware and software requirements. For
the latest details of hardware and software requirements on all supported platforms, see System
Requirements for IBM MQ.

About this task

This task describes the basic steps for installing IBM MQ on Windows if you do not already have it
installed on your system.

This task assumes that you will be using the default IBM MQ program and data files locations. By
default, the IBM MQ Version 9.0 location of program files on Windows is C:\Program Files\IBM\MQ, and
the data and log file location is C:\ProgramData\IBM\MQ.

Note: If you are installing IBM MQ Version 9.0, and you have any previous installations of IBM MQ on
your machine, the location of the program and data files might be different from the default. For further
information, see Program and data directory locations.

The installation programs contain links to further information if you require it during the installation
process. The installation process has five parts:
1. Use the Launchpad to check and install software requirements, specify network information, and start

the IBM MQ installation wizard.
2. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
3. Use the Prepare IBM MQ wizard to start the IBM MQ service.

Procedure

1. You can start the installation process in one of two ways:
v In Windows Explorer, navigate to the temporary folder into which you downloaded the installation

image and double-click setup.exe, or
v Insert the IBM MQ for Windows Server DVD into the DVD drive. If autorun is enabled, the

installation process starts. Otherwise, double-click the Setup icon in the root folder of the DVD to
start the installation process.

The installation launchpad is started.
2. Using the launchpad, review and, if necessary, modify the software requirements and network

configuration.
a. Click the Software Requirements button to display the Software Requirements tab.
b. Check that the software requirements have been met and that the entry for the requirement

displays a green tick with the words OK . Make any indicated corrections.

Note: To see more details about any requirement, click the plus (+) button.
c. Click the Network Configuration button to display the Network Configuration tab.
d. Click the No radio button.

Note: This scenario assumes that you do not need to configure a domain user ID for IBM MQ. For
more information regarding configuring IBM MQ for Windows domain users, click the More
information button.

e. On the IBM MQ Installation tab of the Launchpad, select the installation language, and then click
the Launch IBM MQ Installer button to start the IBM MQ installation wizard.

You have completed your review IBM MQ of the installation requirements, have made any required
modifications, and have started the IBM MQ installation wizard.

3. Use the IBM MQ installation wizard to install the software, and start the Prepare IBM MQ wizard.
The wizard checks for existing installations and displays the upgrade or installation options that are
available to you. In the case of this scenarios, there are two options:
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v Install leaving the existing installation(s) untouched
v Upgrade 8.0.0.5 installation 'Installation 1'
a. Select Install leaving the existing installation(s) untouched, and then click Next.
b. Read the License Agreement and click the I accept the terms in the license agreement check box,

and then click Next.
c. Click Typical, and then click Next.
d. On the Ready to Install IBM MQ page, review the displayed installation information and click

Install.
The installation information includes the following details:
v Installation Name
v Top-level folder for Program Files
v Top level folder for Data Files

The following features are installed:
v IBM MQ Server
v IBM MQ: a graphical interface for administering and monitoring IBM MQ resources
v Java™ and .NET Messaging and Web Services
v IBM MQ Development Toolkit

The installation process begins. Depending on your system the installation process can take several
minutes.
At the end of the installation process, the IBM MQ Setup window displays the message
Installation Wizard Completed Successfully .

e. Click Finish.

You have successfully installed IBM MQ. The Prepare IBM MQ wizard starts automatically, displaying
the Welcome to the Prepare IBM MQ Wizard page.

4. Use the Prepare MQ wizard to start the IBM MQ service.
a. On the Welcome to the Prepare IBM MQ Wizard, select Next. The Prepare IBM MQ Wizard

displays the message Status: Checking IBM MQ Configuration and a progress bar. When the
process is complete the IBM MQ Network Configuration page is displayed.

b. On the IBM MQ Network Configuration page of the Prepare IBM MQ Wizard, select No.
c. Click Next. The Prepare IBM MQ Wizard displays a message Status: starting the IBM MQ

Service , and a progress bar. When the process is complete the wizard displays the Completing
the Prepare IBM MQ Wizard.

d. Select Launch IBM MQ Explorer and choose whether to start Notepad to view the release notes,
and then click the Finish button. IBM MQ Explorer starts.

What to do next

You have installed IBM MQ Version 9.0 alongside IBM MQ Version 8.0, but in a different installation
directory, and you have started IBM MQ Explorer.

Your are now ready to stop the queue managers running in the earlier version of IBM MQ as described
in “Stopping the queue manager” on page 132.
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Stopping the queue manager:

Before migrating to a later version of IBM MQ, you must first stop the queue manager and back up the
queue manager data.

About this task

Before taking the backup, stop the queue manager that you are going to back up. If you try to take a
backup of a running queue manager, the backup might not be consistent because of any updates that
were in progress when the files were copied.

Procedure

1. Open IBM MQ Explorer. Click Start > All Applications > IBM MQ > IBM MQ Explorer.
2. Stop queue manager sampleQM.

a. In the Navigator View, right-click the queue manager sampleQM.
b. Click Stop. The End Queue Manager window opens.
c. Select Controlled, then click OK. Selecting the Controlled option stops your queue manager in a

controlled, orderly way. The Immediate option, which forces the queue manager to stop, is
typically used only if a controlled stop fails to complete successfully.

The queue manager stops. In the IBM MQ, the icon next to queue manager sampleQM is changed to
include a red arrow that points downward.

3. Close IBM MQ Explorer.
4. Back up the queue manager data. Take copies of all of the following data, making sure that you

include all backup directories. Some of the directories might be empty, but you need them all if you
need to restore the backup at a later date, so save them too.
v The queue manager data located in C:\ProgramData\IBM\MQ\Qmgrs.
v The log file directories for the queue managers located in C:\ProgramData\IBM\MQ\log, including the

log control file amqhlctl.lfh.
v The configuration files located in the C:\ProgramData\IBM\MQ\Config.
v IBM MQ Version 8.0 .ini file and the registry entries. The queue manager information is stored in

the .ini file and can be used to revert to a previous version of the product.
5. Stop IBM MQ.

a. Stop the IBM MQ Service. Right-click the IBM MQ icon in the system tray, then click Stop IBM
MQ. A dialog box with the following message is displayed:
Shutting down IBM MQ will terminate all running queue managers and
IBM MQ processes. Are you sure you want to continue? (AMQ4102)

b. Click Yes, then wait for IBM MQ to stop.
c. When IBM MQ has stopped, right-click the IBM MQ icon in the system tray, then click Exit.

What to do next

After stopping the queue managers, you are ready to associate them with your new IBM MQ Version 9.0
installation as described in “Associating the queue managers with IBM MQ Version 9.0” on page 134.
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Uninstalling Version 8.0:

Uninstall Version 8.0 using the Windows control panel.

Before you begin

Before starting this task, you must first stop the queue managers, close IBM MQ Explorer and stop IBM
MQ as described in “Stopping the queue manager” on page 132.

About this task

In this task, you uninstall Version 8.0 using the Windows control panel. The queue manager data is not
removed as part of the uninstallation process, which means that the sample queue managers used in this
scenario are retained and can be detected when you install the newer version of the product.

Procedure

1. Open the Windows Control Panel by clicking Start > Control Panel > Uninstall a program.
2. In the Programs and Features window, find the entry for the installation that you want to remove, for

example IBM IBM WebSphere MQ (Installation1), and click Uninstall. The uninstallation process
begins and runs to completion. When the process completes, Version 8.0 is removed from your
computer and is no longer displayed in the list of programs.

Results

Version 8.0 has been removed from your computer. However the queue manager data has not been
removed.

What to do next

You are now ready to make IBM MQ Version 9.0 the primary installation as described in “Making IBM
MQ Version 9.0 the primary installation.”
Related information:
Uninstalling IBM MQ on Windows systems

Making IBM MQ Version 9.0 the primary installation:

Before you start any queue managers in the new IBM MQ Version 9.0 installation, you can, optionally,
make IBM MQ Version 9.0 the primary installation.

About this task

On systems that support multiple installations of IBM MQ, the primary installation is the one to which
IBM MQ system-wide locations refer. For IBM WebSphere MQ Version 7.1 or later, having a primary
installation is optional, but convenient. However, if you have an installation of IBM WebSphere MQ
Version 7.0.1 on your system, this installation is automatically the primary installation and you cannot
change the primary installation while Version 7.0.1 is installed.

When you follow the side-by-side migration method described in this scenario, because you uninstall the
earlier version before starting any queue managers in the later release, you can assign your installation of
the later version of the product to be the primary installation.

For more information about the primary installation, see Primary installation.
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Procedure

1. Check the current primary installation by entering the dspmqinst command into the command
prompt. The command prompt displays the details of any current installations. The current primary
installation has the following line Primary: Yes .

2. Use the setmqinst command to change the current primary installation. In the command prompt,
enter:
setmqinst -x -n Installation_Name

where Installation_Name> is the name of the current primary installation. If the command is
successful, the command prompt displays the message 'Installation_Name' (Filepath) has been
unset as the Primary Installation.

3. Use the setmqinst command to set the new IBM MQ Version 9.0 installation as the primary
installation. In the command prompt, enter:
setmqinst -i -n V9_Installation

where V9_Installation is the name of the Version 9.0 installation.
If the command is successful, the command prompt displays the message 'V9_Installation'
(Filepath) has been set as the primary installation. You must restart the operating system
to complete the update.

Note: As directed in the success message, you must restart the operating system to complete the
update.

What to do next

You are ready to associate the migrated queue managers with the new IBM MQ Version 9.0 installation as
described in “Associating the queue managers with IBM MQ Version 9.0.”

Associating the queue managers with IBM MQ Version 9.0:

Use the Transfer queue managers wizard to associate the sampleQM queue manager with your new IBM
MQ Version 9.0 installation.

Before you begin

Before starting this task, make sure that you have stopped the queue manager as described in “Stopping
the queue manager” on page 132, otherwise you will not be able to complete the transfer.

About this task

The Transfer queue managers wizard feature of IBM MQ Explorer enables you to transfer one or more
queue managers from other installations to the current installation. This wizard is equivalent to the
setmqm command, but saves having to type the required paths and parameters. Only stopped queue
managers can be transferred; running queue managers are shown for reference.

Once you have transferred and started a queue manager on an installation for a later version of the
product, it is not possible to migrate back to an earlier version.

Procedure

1. Start IBM MQ Explorer. Click Start > All Applications > IBM MQ > IBM MQ Explorer.
2. In the Navigator view, right-click the queue managers node and select Transfer Queue Managers.
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3. Right-click then select the queue manager sampleQM, then click Transfer. The setmqm command is
invoked with the selected queue managers. If the transfer is successful, the navigator tree updates to
include the transferred queue managers. If there are any problems, a dialog is shown with the error
message from the command.

4. Start the queue manager sampleQM.
a. In the Navigator view, expand the queue managers node.
b. Right-click the name of the queue manager, then click Start.

Results

You have successfully associated the queue manager sampleQM with your new IBM MQ Version 9.0
installation.

What to do next

Verify that the queue manager sampleQM has been successfully migrated by confirming that you can put
a message to and get a message from the queue as described in “Verifying the IBM MQ Version 9.0
installation.”

Verifying the IBM MQ Version 9.0 installation:

After installing IBM MQ Version 9.0, use IBM MQ Explorer to verify that the queue managers and queues
have successfully migrated from the earlier release then verify that you can use the sample application.

About this task

When you have checked that the migrated queue manager, sampleQM, is visible in the Navigator view of
IBM MQ Explorer, verify that you can put a message to and get a message from the migrated queue, then
check that you can still run the sample application.

Procedure

1. If IBM MQ Explorer is not running, start it now. Click Start > All Programs > IBM MQ > IBM MQ
Explorer.

2. Verify that your queue managers have been successfully migrated to IBM MQ Version 9.0:
a. In the Navigator view, expand the Queue Managers folder.
b. Check that you can see the queue manager sampleQM in the Queue Managers folder.
c. Expand queue manager sampleQM, click the Queues folder, and check that you can see queue Q1

in the Content view.
3. If queue manager sampleQM is not already started, start it now.

a. In the Navigator view, expand the queue managers node.
b. Right-click queue manager sampleQM, then click Start.

4. Verify that you can put a message to queue Q1.
a. In the Navigator view, expand the Queue Managers folder.
b. Expand queue manager sampleQM, then click the Queues folder.
c. In the Content view, right-click queue Q1, then click Put Test Message. The Put test message

dialog opens.
d. In the Message data field, type some text, for example Hello queue!, then click Put message. The

Message data field is cleared and the message is put on the queue.
e. Click Close. In the Content view, notice that the Current queue depth value of the queue is now

1. If the Current queue depth column is not visible, you might need to scroll to the right of the
Content view.

5. Verify that you can get the message from queue Q1.
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a. In the Navigator view, expand the Queue Managers folder,
b. Expand queue manager sampleQM then click the Queues folder.
c. In the Content view, right-click queue Q1, then click Browse Messages. The Message browser

opens to show the list of the messages that are currently on the queue.
d. Double-click the last message to open the properties dialog. On the Data page of the properties

dialog, the Message data field displays the content of the message in human-readable form.
6. Verify that you can run the sample application.

a. Double-click the runresponder.cmd file. In the command prompt window, labeled Responder
window, the responder client starts then waits for a message.
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

b. Double-click the runrequester.cmd file. In the Requester window, observe the requester messages.
In the Responder window, observe the updated responder messages; the message it received (from
the requester client) and the reply message that it sent.

In the command prompt window, labeled Requester window, the requester client shows the
connection status, the message it sent, then the reply message that it received from the responder
client:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Connection created.

> Sending stock request for ’BakedBeans’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902 for ’B
akedBeans - 15 tins in stock’

> Closing connection to QueueManager.
> Closed Connection.
--------------------------------------------------------
In this window, observe the messages sent through IBM MQ:
- The request message sent
- The reply message received
-----
When ready, press any key to close this window
Press any key to continue . . .

In the Responder window, observe the updated responder messages; the message it received (from the
requester client) and the reply message that it sent:
> Connection factory located in JNDI.
> Destination located in JNDI.
> Creating connection to QueueManager.
> Created connection.

> Waiting for message.

> Received Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002b02 for ’B
akedBeans’

> Sending Reply Message ’BakedBeans - 15 tins in stock’
> Sent Message ID=ID:414d5120514d5f4c33344c3238482020c3cd094d20002902

> Closing connection to QueueManager.
> Closed connection.
--------------------------------------------------------
In this window, observe the updated responder messages
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- The request message received (from the requester)
- The reply message sent
-----
When ready, press any key to close this window
Press any key to continue . . .

The messages shown in the two command windows verify that the requester and responder clients of
the sample application can communicate with each other through IBM MQ.

Results

You have successfully migrated to IBM MQ Version 9.0.

What to do next

For more information about migrating and upgrading see Maintaining and migrating.

File transfer scenario
A scenario that demonstrates use of the Managed File Transfer capability.

The available file transfer scenario is described in the Managed File Transfer documentation, starting with
Scenario overview.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
Software Interoperability Coordinator, Department 49XA
3605 Highway 52 N
Rochester, MN 55901
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Programming interface information
Programming interface information, if provided, is intended to help you create application software for
use with this program.
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This book contains information on intended programming interfaces that allow the customer to write
programs to obtain the services of WebSphere MQ.

However, this information may also contain diagnosis, modification, and tuning information. Diagnosis,
modification and tuning information is provided to help you debug your application software.

Important: Do not use this diagnosis, modification, and tuning information as a programming interface
because it is subject to change.

Trademarks
IBM, the IBM logo, ibm.com®, are trademarks of IBM Corporation, registered in many jurisdictions
worldwide. A current list of IBM trademarks is available on the Web at “Copyright and trademark
information” www.ibm.com/legal/copytrade.shtml. Other product and service names might be
trademarks of IBM or other companies.

Microsoft and Windows are trademarks of Microsoft Corporation in the United States, other countries, or
both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

This product includes software developed by the Eclipse Project (http://www.eclipse.org/).

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.
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Sending your comments to IBM

We appreciate your input on this publication. Feel free to comment on the clarity, accuracy, and
completeness of the information or give us any other feedback that you might have.

Use one of the following methods to send us your comments:
v Send an email to ibmkc@us.ibm.com
v Use the form on the web here: www.ibm.com/software/data/rcf/

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute your
comments in any way it believes appropriate, without incurring any obligation to you.

Include the following information:
v Your name and address
v Your email address
v Your telephone or fax number
v The publication title and order number
v The topic and page number related to your comment
v The text of your comment

IBM or any other organizations will only use the personal information that you supply to contact you
about the issues that you submit.

Thank you for your participation.
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